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WARNING!

Programmable control devices such as PowerPanel must not be used as stand-alone protection in
any application.   Unless proper safeguards are used, unwanted start-ups could result in equip-
ment damage or personal injury.  The operator must be made aware of this hazard and appropri-
ate precautions must be taken.

In addition, consideration must be given to the use of an emergency stop function that is indepen-
dent of the programmable controller.

The diagrams and examples in this user manual are included for illustrative purposes only.  The
manufacturer cannot assume responsibility or liability for actual use based on the diagrams and
examples.

CAUTION
Do not press the PowerPanel touchscreen with any sharp objects.  This practice may damage the
unit beyond repair.

Trademarks
This publication may contain references to products produced and/or offered by other companies.
The product and company names may be trademarked and are the sole property of their respec-
tive owners.  UTICOR Technology, L.P. disclaims any proprietary interest in the marks and names
of others.

Manual Part No. MAN-UTICW-M

© Copyright 2001,UTICOR Technology, L.P.
All Rights Reserved

No part of this manual shall be copied, reproduced, or transmitted in any way without the prior
written consent of UTICOR Technology, L.P.  UTICOR Technology, L.P. retains the exclusive rights
to all information included in this document.

MANUFACTURED and MARKETED by UTICOR Technology, L.P.
4140 Utica Ridge Rd. • Bettendorf, IA  52722-1327

Phone:  1-563-359-7501  •  Fax:  1-563-359-9094  •  www.uticor.net
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Manual Revisions

Manual Part Number:  MAN-UTICW-M
Manual Title:  PowerPanel Programming Software User Manual

The following table provides you with update information.  If you call technical support with a
question about this manual, please be aware of the revision number.

Revision Date Effective Pages Description of Changes

Original
Release

07/2001 Cover
Warning/Copyright
i–vi
1–160
Appendix A
Appendix B
Index

Original Release of Manual
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EU Information

The PowerPanel is manufactured in compliance with European Union (EU) Directives and car-
ries the CE mark. The PowerPanel has been tested under CE Test Standard #EN55011, and is
listed under UL File #E209355. The following information is provided to comply with EU docu-
mentation requirements.

Please NOTE:  Products with CE marks perform their required functions safely
and adhere to relevant standards as specified by EU Directives provided they
are used according to their intended purpose and that the instructions in this
manual are adhered to.  The protection provided by the equipment may be
impaired if this equipment is not used in accordance with this manual.  Only
replacement parts supplied by UTICOR Technology, L. P. or its agents should
be used.

Technical
Support

Consult PowerPanel Programming Software Help or you may find answers
to your questions at our web site @ www.uticor.net.  If you still need assis-
tance, please call our technical support at 1-800-832-3647 or FAX us at 1-
563-359-9094.

Environmental
Specifications

Operating Temperature
6" Monochrome/6" Color ........................................................ 0 to 45 °C
8" Color ................................................................................... 0 to 40 °C
10" Color ................................................................................. 0 to 50 °C

Storage Temperature
6" Mono ............................................................................ –20 to +60 °C
6" Color ............................................................................ –25 to +60 °C
8" Color ............................................................................ –20 to +60 °C
10" Color .......................................................................... –25 to +60 °C

Operating Humidity .................................. 10–95% R.H., noncondensing

Air Composition ........................................ No corrosive gases permitted

No preventative maintenance is required. The PowerPanel touchscreen
should be cleaned as needed with warm, soapy water. See the PowerPanel
Hardware User Manual (P/N MAN-UTICW-001) for a list of compatible/in-
compatible chemicals and compounds.

Preventative
Maintenance
and Cleaning

SELV Circuits All electrical circuits connected to the communications port receptacle are
rated as Safety Extra Low Voltage (SELV).
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In this chapter....
— Manual Organization
— Introduction
— What you need to get started
— Need HELP?
— Models
— Features
— PLCs Supported by PowerPanel
— PLC Cable Part Numbers
— Programming Cable Part Number
— PowerPanel Programming Software Installation
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ManManManManManual Orual Orual Orual Orual Organizationganizationganizationganizationganization
The PowerPanel Programming Software User Manual is arranged in chapters.  A description of key
information contained in each chapter is provided below.

Introduction
Provides Manual Organization, and lists what you need to get started, hardware and
software. Discusses how to get help with questions or problems you might encoun-
ter through Onscreen Help and Technical Support. Provides you with a table listing
the various models, and their special features. Lists the important features of all
PowerPanels. Lists the PLCs supported by the panels, by brand, model and
protocol. Lists the part numbers for PLC cables and the programming cable. Tells
how to install programming software.

2

1

3

Tutorial
Provides instructions to create an example (or “demo”) project.  Discusses how to
configure a PLC ladder logic program to use with the demo project.  Takes you
through the steps necessary to create a PowerPanel project using the programming
software. Shows you how to  transfer the project to the panel, and testing the
project once transferred.

4

Project Setup
Discusses ON-LINE and OFF-LINE configuration options.  Tells you how to set up a
project by entering project information (Step 1). Discusses screen design (Step 2),
and how to transfer the project to the panel (Step 3).

Objects
Provides step-by-step  instructions for configuring each of the PowerPanel objects.

5

A
Appendix A  Troubleshooting
Aids in diagnosing problems you might encounter when installing or operating your
PowerPanel.  Provides steps to take to isolate and correct problems. Lists panel
error messages, programming software error messages, and  PLC Driver Error
messages.

Chapter Description

Reference
Provides more details on menu commands.  Takes you through the main menu bar
item by item, command by command, with instructions.  Contains information on the
various tool bars and the status bar. Describes right click menus

B
Appendix B Characters
Provides a list of the ASCII Characters supported by the PowerPanel.  This
information may be useful when creating a Text Entry or Dynamic Text object.

C
Appendix C  PLC Communications Setup
Provides instructions on how to set up most PLC Types to communicate with the
PowerPanel.
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There are two manuals that you will need for installation — this manual,
the PowerPanel Software User Manual, and the PowerPanel Hardware
User Manual (P/N MAN-UTICW-001) shipped with your PowerPanel.

Don’t worry — you won’t be bouncing back and forth between them
— and we’ll always let you know exactly where the information is that
you will need for the next step.

These manuals will take you through the steps necessary to get your
PowerPanel  up and running in the shortest possible time.  Although
your familiarity with programmable graphic operator interface devices
will determine how quickly you move through the steps —  it’s as
easy as 1 — 2 — 3.

Hardware

• PowerPanel (6" Monochrome, 6" Color, 8" Color, or 10"
Color)

• 24 Volt DC Power Supply (FA-24PS recommended)
• RS-232C Programming Cable (P/N CBL-UTICW-009)
• RS-232C or RS-422A/485A PLC Interface Cable (see

page 8 for part numbers)
• PC requirements:

— IBM or compatible PC (486 or better) with a
mouse and separate serial port

— VGA display with at least 800 x 600 resolution
(1024 x 768 recommended)

— Standard Windows 95/98/NT4.0/2000®

Requirements
— CD ROM Drive

Software

• PowerPanel Programming Software (P/N MAN-UTICW-
CD)

What yWhat yWhat yWhat yWhat you need to gou need to gou need to gou need to gou need to get staret staret staret staret started....ted....ted....ted....ted....

IntrIntrIntrIntrIntroductionoductionoductionoductionoduction

Install the PowerPanel using
the instructions in the
Hardware Manual.

Program the PowerPanel
using the instructions in this
Software Manual.

PowerPanel

PowerPanel
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Onscreen HELP
One of the most important features of the PowerPanel Programming
Software is the availability of context sensitive onscreen help.  To
access the Help windows, simply press the F1 function key while on
the topic where you need help. For example, if you need help while
working with screens, press  the F1 function key while in that area
and a popup window will be displayed.  You may also click on the
Help button located at the bottom of most dialog boxes to go to the
help topic.

Fly-Over HELP
When the mouse cursor comes to rest over any tool bar or object
button for a short while, a small window will appear containing a brief
description of the function of that particular button. The window will
disappear as soon as the cursor has been moved off the button.

PLC HELP
If you need help with the PLC to PowerPanel Interface, consult the
PowerPanel Programming Software Help.  Each PLC Driver has a
Help Topic that lists the error messages and provides an explanation
for each.  Also provided are PLC to PowerPanel wiring diagrams.

Technical Support
Although most questions can be answered with PowerPanel  HELP
or the manuals, you may find answers to your questions in the operator
interface section of our web site @ www.uticor.net.   If you still need
assistance, please call our technical support at  1-800-832-3647 or
FAX us at 1-563-359-9094.

Need HELP?Need HELP?Need HELP?Need HELP?Need HELP?

PLEASE NOTE:  The Troubleshooting section (Appendix A) should
be able to help you with most problems you might encounter.
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PPPPPooooowerPwerPwerPwerPwerPanel Modelsanel Modelsanel Modelsanel Modelsanel Models
The PowerPanel is an intelligent, programmable, flat panel display. It
has been designed to interchange and display graphical data from a
PLC by merely viewing or touching the screen.

The PowerPanel is available in a variety of models to suit your
application. Refer to the table below for a list of model descriptions
and some important options that are available.

Description
User
Memory

Field
Expandable
User RAM?

Nonvolatile Flash
Backup Card Option
for Program Backup?

PLC Drivers
Supported? *

Option Cards
Available

6" Monochrome
Panel

512K
Yes —

to 1 MEG Yes All

A-B Data
Highway Plus

ModBus Plus

Ethernet

6" STN Color
Panel

8" STN Color
Panel

10" TFT Color
Panel**

 *    A list of PLC Drivers supported is provided on page 7 of this manual.

**   The 10" TFT Color Model is offered in two sizes.  One that has the same footprint as the previous
version of the PowerPanel and the new  PowerPanel standard size (smaller than previous version).
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The following is a list of important features for the PowerPanels:

• Pre-built panel components for easy screen design

• Special parts, such as:  Toggle Switch, Slide Switch, Selector Switch,
Throw Switch, Thumbwheel Object, Meters, PID Faceplates, and Analog
Clock

• Flash based design for easy firmware upgrade

• Field expandable user RAM

• Nonvolatile flash card option for user program backup

• Color models support 128-color palette for components and bitmaps

• 16 shades of gray on monochrome models

• Multiple languages (up to 9)

• Two communications ports — Computer (RS-232C) and PLC (RS-232C,
RS-422A, or RS-485A)

• Up to 999 screens

• Built-in clock and calendar or reference the PLC clock

• Built-in soft keypad for numeric and alphanumeric entry

• Password Protection for every touch object

• Passwords for up to 8 definable user groups

• 16 level undo and redo

• Import bitmaps

• Serial Printer support

• 40-character tag names allow you to use meaningful names for PLC
memory locations instead of cryptic PLC addresses

FeaturesFeaturesFeaturesFeaturesFeatures
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PLCs SupporPLCs SupporPLCs SupporPLCs SupporPLCs Supported bted bted bted bted by Py Py Py Py PooooowerPwerPwerPwerPwerPanelsanelsanelsanelsanels

PLC Brand Model Protocols Supported

Allen-Bradley Micrologix 1000/1200/1500,
SLC500, 5/01,/02,/03

DH485/AIC/AIC+

SLC5/04, PLC5 DH+ (option card) (check for availability)

Micrologix 1000, 1200 and 1500
SLC5/03, /04, /05  (with DF1)

DF1 Half Duplex;  DF1 Full Duplex

PLC5 DF1

General Electric 90/30 and 90/70 SNPX

Mitsubishi FX Series (all) Direct, Multidrop

Modicon 984 CPU, Quantum 113 CPU
AEG Modicon Micro Series 110 CPU:
311-xx, 411-xx, 512-xx, 612-xx

Modbus RTU

984 Series, Quantum Series
Modbus Plus (option card) (check for
availability)

Omron C200, C500 Host Link

DirectLogic
DL05

K-Sequence; DirectNet;
ModBus (Koyo addressing)

DL105 K-Sequence

DL205

D2-230 K-Sequence

D2-240 K-Sequence; DirectNet

D2-250
K-Sequence; DirectNet;
ModBus (Koyo addressing)

D2-240/250 DCM DirectNet

DL305

D3-330/330P DirectNet

D3-340 DirectNet

D3-350
K-Sequence; DirectNet;
ModBus (Koyo addressing)

D3-350 DCM DirectNet

DL405

D4-430 K-Sequence; DirectNet

D4-440 K-Sequence; DirectNet

D4-450
K-Sequence; DirectNet;
ModBus (Koyo addressing)

All with DCM DirectNet

Siemens Siemens 7 MPI  Adapter 3964R

Other H2- WinPLC (Think-N-Do V5.2, check
for version compatibility)

Modbus RTU (serial port)
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PLC CabPLC CabPLC CabPLC CabPLC Cable Ple Ple Ple Ple Pararararart Numbert Numbert Numbert Numbert Numbers — 3m (9.8 ft.)s — 3m (9.8 ft.)s — 3m (9.8 ft.)s — 3m (9.8 ft.)s — 3m (9.8 ft.)

PrPrPrPrProgramming Cabogramming Cabogramming Cabogramming Cabogramming Cable Ple Ple Ple Ple Pararararart Number — 2m (6.56 ft.)t Number — 2m (6.56 ft.)t Number — 2m (6.56 ft.)t Number — 2m (6.56 ft.)t Number — 2m (6.56 ft.)

  CBL-UTICW-009 RS-232 Programming Cable

See the PowerPanel Hardware User Manual (P/N MAN-UTICW-001),
Appendix A for cable pinouts, or use the  PowerPanel  Programming
Software Help Topics.

Part Number Cable Description

CBL-UTICW-001 GE 90/30 and 90/70 15-pin Dsub port (RS-422A)

CBL-UTICW-002 AB SLC 5/03/04/05 DF1 port (RS-232C)

CBL-UTICW-003 AB PLC5 DF1 port (RS-232C)

CBL-UTICW-004 AB SLC DH485 port  (RS-485A)

CBL-UTICW-005 AB MicroLogix 1000, 1200 & 1500 (RS-232C)

CBL-UTICW-006 Mitsubishi FX Series 25-pin port (RS-422A)

CBL-UTICW-007 Mitsubishi FX Series 8-pin MINI-DIN (RS-422A)

CBL-UTICW-008 Omron C200, C500  (RS-232C)

CBL-UTICW-010 ModBus with RJ45 (RS-232C)

CBL-UTICW-011 Modicon ModBus (RS-232C)

CBL-UTICW-012 Siemens S7 MPI Adaptor (RS-232C)

CBL-UTICW-013 Omron 9-pin Programming Port (RS-232C)

CBL-UTICW-014 GE Versmax (RS-232C)
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• Place the CD into your CD ROM drive.

• From Windows click on the Start Button, and then click on
Run from the menu.  The Run dialog box will pop up.

• At the prompt type D:\ (or your CD ROM drive) setup.exe
or click on the Browse Button and find the Setup.exe file
for PowerPanel  Programming Software.

• Click on the OK button to begin the installation. The
PowerPanel  Programming Software Installation Screen will
appear.

• Follow the onscreen prompts to load the software.
(Installation screens are shown, next page.)

Installation ScreensInstallation ScreensInstallation ScreensInstallation ScreensInstallation Screens

PowerPanels are configured with software running on an IBM or
compatible personal computer. This software is available through
Uticor Technology, L. P., part number MAN-UTICW-CD.  The panel
can be configured on-line or off-line.

(See page 3 for requirements.)

Installing the Software

Perform the following steps to install the PowerPanel  Programming
Software onto your PC.

PPPPPooooowerPwerPwerPwerPwerPanel Pranel Pranel Pranel Pranel Programming Softwareogramming Softwareogramming Softwareogramming Softwareogramming Software
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This is the final installation screen.  Here
you select the destination folder where
your software program will be installed.
The default destination location is C:\
Program Files\PowerPanel. If you wish to
select another destination, click on the
Browse button.

To complete the installation, click on Next>
button.  That’s all there is to it!  The
PowerPanel Icon shown above will appear
on your desktop.  Simply click on it to open
the Programming Software!

➥

PPPPPooooowerPwerPwerPwerPwerPanelanelanelanelanel
Programming SoftwareProgramming SoftwareProgramming SoftwareProgramming SoftwareProgramming Software
IconIconIconIconIcon ➥
This icon will
appear on your
desktop after
installation.

➡

➡
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For the purposes of this Tutorial, we  will be using an Allen-Bradley
SLC 500 Programmable Logic Controller (PLC), with Full Duplex Protocol.
To configure the PLC we are using RSLogix® Programming Software.
The purpose of this part of the tutorial is to show you how to configure
your PLC to communicate with a PowerPanel.

Connect the programming PC to the Alllen-Bradley SLC 500 PLC. With
RSLogix Programming Software running on your PC, perform the
following steps.

1. Enter the Ladder Logic as shown in the example (below,
left). These PLC locations will be used by Tags that you will
create in the PowerPanel Programming Software.

2. Configure Channel 0, System, as shown
in the graphic (below, right).

3. Save this program and transfer it to the
PLC.  Place the PLC in Run Mode.

4. Exit RSLogix Programming Software.

For this tutorial, we will be connecting
the panel to DF1 Port of an Allen-Bradley
SLC 500 with Full Duplex Protocol. These
are the settings that will be used when
setting up the panel communications.

You have now configured the PLC to
communicate with a PowerPanel Project
that you will create in the next section of
this tutorial.

TTTTTutorial — Configure PLCutorial — Configure PLCutorial — Configure PLCutorial — Configure PLCutorial — Configure PLC
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The following is a project tutorial. You’ve already configured your PLC
to work with the PowerPanel project you will be creating in this section.
Now we’ll take you through the process of creating a new project,
placing objects on the screen, and transferring a project to the
PowerPanel. This should help familiarize you with the PowerPanel
Programming Software environment.

Let’s assume you have the programming software installed on your PC
(if you don’t, go back to page 9 and install now).  Connect the PowerPanel
to your PC using the P/N CBL-UTICW-009 cable.  Connect the PowerPanel
to your PLC using the appropriate panel to PLC cable.

In Step 1, Project Information,  you will be setting up your project by
entering project information.

1. From the Project Information screen, click on the Edit Program
OFF-LINE (Write to Panel Later) button.

2. Under Project Name, type in Demo Project 1. Press Enter. The
primary PowerPanel Program file has a “.prp” suffix.

3. Under Start Editing Screen, leave the screen number as 1.  Click
in the field next to Name.  Replace New Screen by typing in
Numeric Entry Screen.

TTTTTutorial — Create a Prutorial — Create a Prutorial — Create a Prutorial — Create a Prutorial — Create a Projectojectojectojectoject

Step 1

Click here to begin.

Enter project name here.
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4. Click on the DOWN arrow to the right of the Panel Type field to
view choices.  Select the Panel Type you are using.  In this Demo
Program we are using the 8" Color - 640x480.

5. Click on the DOWN arrow to the right of PLC Type and Protocol
to view the list.  For the purpose of this Demo Program, select
Allen-Bradley SLC 500 DF1 (Full Duplex). (We are using an
Allen-Bradley SLC 500 with Full Duplex Protocol.)

6. Click on the View/Edit PLC Com Setup to edit the PLC Attributes.
Set the attributes to match those in the Allen Bradley SLC 500
(Full Duplex) attributes dialog box shown below. Click OK. (These
settings must match the PLC Com Port settings.  Check
your PLC User Manual for port settings for your particular
PLC.)

Step 1 is complete!

Enter Screen Number.

Type in “Numeric
Entry Screen” here.

Click on DOWN arrow
to view Panel Types and
select the Part Number/
Model Type you are using.

Click on DOWN arrow to
view PLC Type and
Protocol and select the
type you are using.

To set PLC Attributes,
click on this button.  A
dialog box particular to
the type PLC and
Protocol you have
selected will appear.
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You are now ready for Step 2, Design Your Screens.  In Step 2  we
will place 4 objects on the screen.  You have already configured your
PLC ladder logic for this Demo Project in the first part of the tutorial.

The PowerPanel Programming Software working environment is shown
below. Toolbars provide easy access to all major programming functions
and features.  The objects shown below represent the touch buttons
and displays that will be transferred to the panel and communicate with
the PLC when this tutorial is completed.

The Main Programming Screen opens with the toolbars shown below.  If
you want the “3 Easy Steps” Navigation Toolbar to appear on the right
hand side of the screen, click on Edit > Toolbars > 3 Easy Steps.

Step 2

These are the objects you are about
to configure in this tutorial.

Project Screens
Explorer View
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1. Click on Objects>Numeric Entry. The following screen will appear.

2. Click on the box in front of Label Text to activate the object label.

3. In the field next to Label Text, type in Demo Numeric Entry as
shown above.

4. Click in the field next to Tag Name and type in NUMERIC ENTRY.
Press Enter.  The following screen will appear.

5. In the field next to Address String, type in N7:0, as shown above.
Select SIGNED_INT_16 for the Data Type.  Click OK.

6. A crosshair cursor will appear on the programming screen. Position
crosshair where you want the object to appear, and click once.

There are many more
features that you may
program, such as, Position
of Label, Color of Text and
Background, and Language,
but for the purposes of this
tutorial, we will use the
Defaults (except for
Character Size).

PLEASE NOTE: If your
panel is connected to
multiple PLCs, see
Mapping Tags in the
Help file for your type
PLC.
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7. Grab the object by a handle and drag to resize it until the label
displays in its entirety, as shown below.

8. Next, we’ll create a Numeric Display object.  Click on Objects >
Numeric Display.  The following dialog box will appear.

9. Click on the box in front of Label Text to activate the object label.

10. In the field next to Label Text, type in Demo Numeric Display as
shown above.

11. Click in the field next to Tag Name and type in NUMERIC DISPLAY.
Press Enter.  The following screen will appear.

NOTES ON RESIZING
AN OBJECT:

Drag the object to move,
or drag a handle to resize,
the object.  The pointer
changes to a four-way
arrowhead  (for moving),
or a two-way arrow (for
resizing).

Dragging a side handle
changes the width or
height only; dragging a
corner handle changes the
width and height simulta-
neously.

To EDIT TAG DETAILS,
right click the mouse
while the cursor is on the
Tag Name.
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12. In the field next to Address String, type in N7:1, as shown above.
Select SIGNED_INT_16 as the Data Type.  Click OK.

13. A crosshair cursor will appear on the programming screen. Position
crosshair where you want the object to appear, and click once.

14. Grab the object by a handle and drag
to resize it until the label displays in
its entirety, as shown to the right.

15. Next, we’ll create a Button object.  Click on Objects > Buttons.
The following dialog box will appear.

16. Click on the box in front of Label Text to activate the object label.

17. In the field next to Label Text, type in Demo Button.

18. Click in the field next to Tag Name and type in BUTTON OBJECT.
Press Enter.  The following screen will appear.
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19. In the field next to Address String, type in B3:0/0, as shown
above.  The Data Type will remain as DISCRETE.  Click OK.

20. A crosshair cursor will appear on the programming screen. Position
where you want the object to appear (under the Numeric Entry
object), and click once.

21. Grab the object by a handle and drag to resize
it until the label displays in its entirety, as shown
to the right.

22. Next, we’ll create an Indicator Light object.  Click on Objects >
Indicator Lights.  The following dialog box will appear.

23. Click on the box in front of Label Text to activate the object label.

24. In the field next to Label Text, type in Demo Indicator Light as
shown above.

25. Click in the field next to Tag Name and type in INDICATOR LIGHT.
Press Enter.  The following screen will appear.

— continued
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26. In the field next to Address String, type in B3:1/0, as shown
above.  The Data Type will remain as DISCRETE.  Click OK.

27. A crosshair cursor will appear on the programming screen. Position
the crosshair where you want the object to appear (under the
Numeric Display object), and click once.

28. Grab the object by a handle and drag to
resize it until the label displays in its
entirety, as shown to the right.

29. Click on File > Save Project.

You’ve just completed Step 2, Design Your Screens!  Now we will
transfer Demo Project 1 to the PowerPanel.

To select an object on the
screen, move your cursor
over the object and a line
will appear around the
object to highlight it, click
the left mouse button to
select.

The PowerPanel is shipped with a bitmap program
installed.  The image shown above will display on
the PowerPanel screen upon initial power-up.  The
first project you transfer to the panel will replace
this bitmap program!
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Click on 3, Write Your
Program to Panel

This screen will appear

Project Information is provided
here. Make sure the information
is correct before proceeding.

Use PC Port is shown here.  Make
sure the correct COM port is selected
before proceeding.

Click on Start button to write the
program to the PowerPanel

You are now ready for Step 3, Write Your Program to Panel.
Demo Project  1 should look similar to that shown below.

1. Click on the 3 button (Write Your Program to Panel) as shown
in the graphic below.

2. Click on the Start button at the bottom of the Write Program to
Panel dialog box to begin transferring the project to the panel.

Step 3
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The Panel to PLC Link will
display a green dot next to
the “Connected” message to
indicate that a link between the
panel and PLC is established.

Panel Information will
display the Total and Free
Memory in Bytes.  It will also
display the Firmware Revi-
sion number — the revision
of the PowerPanel internal
software.

3. Your user program, Demo Project 1, should now be written to
the PowerPanel, and the screen you have created should be
displayed on the panel.

4. Panel Information will be updated with information it receives
from establishing a link with the panel and the PLC.

5. To test the link, press the Demo Numeric Entry button on your
PowerPanel panel screen. A popup keypad similar to the one shown
below should display.

6. Enter a number on the keypad by pressing the number keys.  Press
Enter.  The keypad will disappear and the number you entered
should appear on the Demo Numeric Display on your panel
screen.

7. Press the Demo Button on your panel screen.   It will change
from Off to On. The Demo Indicator Light should change from
Off to On, also.
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You’ve just completed Step 3, Write Your Program to Panel!

You have now successfully configured a PLC, created a user program,
transferred it to the PowerPanel and established communication between
the PLC and panel.

This simple tutorial has taken you through the major steps to creating a
working link between your application and a PowerPanel.  Of course,
there are almost unlimited capabilities for creating a program unique to
your application!

Changes are easy, too.  Create your own Demo project based on this
one, adding color, password protection, and dynamic graphics, for
instance.

The PowerPanel and PowerPanel Programming Software are practical,
versatile— and best of all — make it easy for you to create a dynamic
interface for your application!
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In this chapter....
— ON-LINE and OFF-LINE Projects
— Project Setup
— Entering Project Information (Step 1)
— Designing Screens (Step 2)
— Write Your Program to Panel (Step 3)

33333
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Decide now if you want to work ON-LINE orDecide now if you want to work ON-LINE orDecide now if you want to work ON-LINE orDecide now if you want to work ON-LINE orDecide now if you want to work ON-LINE or
OFF-LINE....OFF-LINE....OFF-LINE....OFF-LINE....OFF-LINE....

You may create a new project on your PC by working off-line (not
connected to a PowerPanel.) You may also work on-line with the
PowerPanel unit to make changes to an existing project.

Working off-line you may use PowerPanel Programming Software  to
design your PowerPanel in your office or home — or even while traveling.
Your project becomes as portable as your laptop, and your PowerPanel
is not “down” while you are redesigning or making modifications as
your unique application needs grow or change.  Your project may be
transferred to the PowerPanel at any time. The transfer function allows
you to select a project to be transferred to the Panel.

Working on-line is unique to PowerPanels.  Working in this mode allows
you to make quick fixes or design changes to an installed PowerPanel
and its existing program.  You can eliminate a step or two and save time
by transferring these changes directly to the current opened screen.
Now you can see the effect of the screen design changes you have
made immediately, eliminating the traditional “edit-compile-download”
cycle. Simply click on Save Screen or Save Project and all changes
on the current opened screen will immediately be saved in the
PowerPanel.

Most users will employ both methods at one time or another, but whether
working off-line or on-line — you will certainly appreciate the versatility
and accessibility provided by the PowerPanel and its easy-to-use
programming software.

The next section takes you through the steps necessary to create a
project and transfer it to the PowerPanel.  PowerPanel Programming
Software simplifies this process by using Windows-based architecture
and lots of popup and pulldown selections that guide you through the
process to quickly build your screens and get you up and running in no
time at all!

Project SetupProject SetupProject SetupProject SetupProject Setup

WWWWWe recommend ye recommend ye recommend ye recommend ye recommend you go throu go throu go throu go throu go through the tutorial beginning on paough the tutorial beginning on paough the tutorial beginning on paough the tutorial beginning on paough the tutorial beginning on paggggge 11e 11e 11e 11e 11
of this manof this manof this manof this manof this manual.ual.ual.ual.ual.          YYYYYou’ou’ou’ou’ou’ll see holl see holl see holl see holl see how easy it is to gw easy it is to gw easy it is to gw easy it is to gw easy it is to get up and running!et up and running!et up and running!et up and running!et up and running!
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Step Step Step Step Step 11111 Project  InformationProject  InformationProject  InformationProject  InformationProject  Information

Under SELECT ACTION, click on one of the three “working mode
buttons.”  If you want to work offline (not connected to a PowerPanel),
click on the button labeled Edit Program OFF-LINE (Write to Panel
Later). You will use this mode when creating a new project.

1. From Project Information screen, click on the Edit Program
OFF-LINE (Write to Panel Later) button.

2. Click on the Browse button if you want to navigate to another
Directory or Folder where you will store your project. If you
want to accept the default folder (where PowerPanel
Programming Software resides), just enter the name of your
new project in the empty field under Project Name.

3. Under Start Editing Screen, leave the screen number as 1.
Click in the field next to Name to highlight New Screen.
Replace this by typing in the name of  your first screen.  If you
haven’t decided on a name, just leave it as is, you can change
it later.

SELECT ASELECT ASELECT ASELECT ASELECT ACTIONCTIONCTIONCTIONCTION
Edit Program OFF-LINE
(Write to Panel Later)

PLEASE NOTE:

If you change your mind and
click on another SELECT
ACTION button, a “confirm
action” message will appear,
just  to make sure that this is
what you intended to do. Click
on Yes or No.

➥

To have the toolbar, shown above,
appear on the righthand side of the
Main Programming Screen, click on
Edit > Toolbar > 3 Easy Steps on the
Main Menu.  (You can do this after
you’ve opened a project.)
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Read Program from
Panel and Edit OFF-LINE

4. Click on the DOWN arrow to the right of the Panel Type field
to view choices.  Select the Panel Type you are using.

5. Click on the DOWN arrow to the right of PLC Type and
Protocol to view the list.  Select the PLC Type and Protocol
you are using.

6. Click on the View/Edit PLC COM Setup to edit the PLC
Attributes.  A dialog box will appear that is particular to the
type of PLC you have selected in the previous step. Set the
attributes to match your PLC. Click OK.

7. You should now be back to the Project Information screen.
Check to ensure that your PC COM Port (Connects to
Panel) is set to match your PC. Click on the OK button to
accept all settings.

You are now ready to begin configuring your first screen.

If you are connected to a panel and want to transfer a project from the
panel to your PowerPanel Programming Software for editing, click on
the Read Program from Panel and Edit OFF-LINE button.  Any
changes you make to the project will not take effect until you write the
edited project to your PowerPanel.➥
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1. From the Project Information screen, click on the Read
Program from Panel and Edit OFF-LINE.  The following
screen will appear.

2. Click on the Browse button if you want to navigate to another
Directory or Folder where you will store your program. If you
want to accept the default folder (usually where the
PowerPanel Programming Software resides), just enter the
name that you desire for the project  you are about to Read in
the empty field under Project Name.

3. Click on the Start button to start reading the project from the
panel.

4. When the program has been read from panel, click OK.

5. You will be taken back to the Project Information Screen.
Notice that the project name entered now appears under
Project Name in this screen.

If not using the default
directory, click on the
Browse button to go to
directory and folder where
project will be stored.

Select or enter Project Name.

Click on Start button to
Start Reading Project from
Panel or Abort to quit.

The message “Project
downloaded successfully”
will appear when the
program has finished
downloading.

Click on OK to
exit screen.
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6. Under Start Editing Screen, the Name and Number of
Screen number 1 will appear.  If you want to begin editing
another screen, click on the down arrow next to Name or
Number and select.

7. Click on the OK button to begin editing.  You will go to the
PowerPanel Main Programming Screen.  You are now ready
to edit the selected screen.

The third choice available is to make changes to the project online.  Click
on the button labeled, Edit Program ON-LINE. The changes are effective
each time Save Screen or Save Project  is selected, reducing no
downtime.  Click on Save Screen or Save Project and the changes
will appear on the panel screen immediately.  This is recommended
when you need to make changes quickly to an existing user program
without shutting down the system.

1. From the Project Information screen, click on the button
labeled, Edit Program ON-LINE. The Panel Type, PLC
Type, and Firmware Revision of the panel will soon display.

2. Under Start Editing Screen, screen Number 1 will appear
with that screen’s Name.  If you want to begin editing a screen
other than Number 1, click on the down arrow next to the
Number field or the down arrow next to the Name field to
select the screen you want to edit.

3. Click on OK.   The screen you have selected will open on the
main programming screen for you to make changes.

4. Click on Save Screen to download changes to the screen
immediately.  Click on Save Project to transfer all changes,
including project attributes and databases. They will be
immediately downloaded to the PowerPanel.

Edit Program ON-LINE

➥
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A QA QA QA QA QUICK REVIEW fUICK REVIEW fUICK REVIEW fUICK REVIEW fUICK REVIEW for or or or or “ENTER PR“ENTER PR“ENTER PR“ENTER PR“ENTER PROJECT INFORMAOJECT INFORMAOJECT INFORMAOJECT INFORMAOJECT INFORMATION”TION”TION”TION”TION”

Under ENTER PROJECT INFORMATION you will perform all or some of
the following actions (depending upon the working mode you have
selected):

1. Project Location will default to the directory where the
PowerPanel Software program is stored.  If your project resides
in another location, click on the Browse button to navigate to
a different directory and folder.

2. Under Project Name, click on the down arrow to view saved
projects or enter the new project name.

3. Start Editing Screen allows you to select the screen that
you want to begin editing.  To have the project open to the
screen you wish to edit, click on the down arrow to select the
Name or the Number of the screen. If it is a new project, the
screen will default to screen 1 with New Screen in the Name
field. Replace this with whatever name you wish or wait until
later and rename.

4. The next field, Panel Type, allows you to select, or change,
your PowerPanel type.  Choose from the following available
types:

6” Mono - 320 x 240
6” Color - 320 x 240
8” Color - 640 x 480
10” Color - 640 x 480

If you are connected to the panel (editing project on-line), the
Firmware Revision of the PowerPanel’s internal software
will be displayed.

Click on the Help Button atClick on the Help Button atClick on the Help Button atClick on the Help Button atClick on the Help Button at
anytime for help.anytime for help.anytime for help.anytime for help.anytime for help.

Click on Clear to clear yourClick on Clear to clear yourClick on Clear to clear yourClick on Clear to clear yourClick on Clear to clear your
entries and starentries and starentries and starentries and starentries and start ot ot ot ot oververververver.....

Click on Exit to quit with-Click on Exit to quit with-Click on Exit to quit with-Click on Exit to quit with-Click on Exit to quit with-
out saving your selections,out saving your selections,out saving your selections,out saving your selections,out saving your selections,
or click on OK to save andor click on OK to save andor click on OK to save andor click on OK to save andor click on OK to save and
begin editing.begin editing.begin editing.begin editing.begin editing.
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5. PLC Type and Protocol allows you to further define your
project by selecting the PLC used in your application and the
protocol it uses.  Click on the down arrow for a list of the
available PLC types.

6. Click on the View/Edit PLC COM Setup button to display
the PLC Attributes.  The attributes screen particular to the
PLC and Protocol type you have selected will appear.  You
may change attributes from this screen.

7. If you are using a Think-N-Do Map File, click on the Browse
button  to go to the directory or folder where the map file
resides.

The map file is simply a text delimited file that resides in any
Think-N-Do project.  The PowerPanel Programming Software
is set up to pull tag names from your Think-N-Do project. This
frees the user from having to remember these tag names.

The map file will load into the project’s Tag Database. Tag
Database Log View will open if there are problems. You
may correct any problems from within the Think-N-Do map file
or the Tag Database.

Once you click on OK, the project will open to the screen you have
selected and you may begin creating or editing your project!

Please NOTE:
PLC compatibility is always
being updated.  If you don’t
see your type PLC and
protocol, visit our website @
www.UTICOR.net to see if  your
PLC driver is now available to
download.  If the desired PLC
driver is not available, call
technical support at (800) 832-
3647.
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Step Step Step Step Step 22222 Design YDesign YDesign YDesign YDesign Your Scrour Scrour Scrour Scrour Screenseenseenseenseens
Your project information has been entered and you are now ready to
begin designing your screens.  Remember that you can go back to step
one and change project information, if necessary.  Just click on the 1
button on the 3 Easy Steps Navigation Tool Bar, shown to the left. (This
toolbar does not display by default.  To have it display on your main
programming screen as shown below, click on Edit > Toolbars > 3 Easy
Steps.  For more information on the Main Programming Screen,
see page 108.

1. Right click anywhere in the Project Screens Explorer View
window (shown above on the left hand side) and a popup
menu will appear.  Click on New Screen (or you may click on
the 2 button, Design Your Screens, on the right hand side)
and the following screen will appear.

Right click here in the
Project Screens Explorer
View window and this
menu will appear.
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Some of the screen design features available to you are:

• Program labels in up to 9 languages

• Popup Keypad that allows you to enter data

• Vector-based graphics for easy sizing, displayed
in up to 128 colors

• Graphical trending

• PID loop tune face plates

• Recipe download

• Thumbwheel interface

• Radio buttons

• Analog clocks

• Meters, switches and lamps

• Symbol Factory® library of over 3,000 factory objects

4. You are now ready to begin configuring objects.

2. Double click on one of the screens in the Screen List to
open it, or enter a new screen number and name and click on
the Open button.

3. Right click the mouse at any time while designing your screens
to access the following menu.
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Step Step Step Step Step 33333 WWWWWrite Yrite Yrite Yrite Yrite Your Prour Prour Prour Prour Program to Panelogram to Panelogram to Panelogram to Panelogram to Panel

Click on button for Step 3, Write Your Program to Panel.  Check to
ensure that “Use PC Port” matches the port that is connected to your
panel and click on the Start button.  Read the information below to learn
more about the “Write Program to Panel” screen.

Project Information:
Provides information about
the current project you are
about to transfer to the
panel.

DON’T LOSE AN EXISTING PROGRAM!
If you’re not sure of the changes you
have made, save the existing program
to a different project name from the one
you are about to transfer to the panel
before you click on the Start button.

If the panel is connected to a PLC,
the Panel to PLC Link will display a
green dot next to the “Connected”
message to indicate that a link is
established.

Panel Information will display the
Total and Free Memory in Bytes.
(Most models allow you to increase
memory by adding another RAM
card.) It will also display the
Firmware Revision number — the
revision of the PowerPanel internal
firmware.

Press the Start Button, the program
will be transferred to the panel.

Panel to PLC Link will display “Not
Connected” until download is
completed.

Before Panel Write....

Panel Write Completed....
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The PowerPanel is shipped with a bitmap program
installed.  The image shown above will display on
the PowerPanel screen upon initial power-up.  The
first project you transfer to the panel will replace
this bitmap program!



ObjectsObjectsObjectsObjectsObjects

In this chapter you will be shown how to create....
— Buttons
— Indicator Buttons
— Radio Buttons
— Switches
— Step Switch
— Tri-state Switch
— Recipe
— Thumbwheel
— Indicator Lights
— Numeric Display
— Text
— Clock
— Meter
— Bar Graphs
— Line Graph
— PID Face Plate
— Dynamic Bitmap
— Change Screen
— Alarm History
— System Objects

44444
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Objects MenuObjects MenuObjects MenuObjects MenuObjects Menu

In PLC-based control, the PLC performs the following control sequence
continuously:  reads inputs, solves control logic (ladder logic), writes
values, and sets/resets outputs.  The state of inputs and outputs is kept
as bits in a data table.  The data table is typically organized in words,
with each word having 16 bits.  Data values, such as parts count, are
also kept as words in the data table.

The PowerPanel provides direct access to the bits and words of the
PLC data table, without going through I/O modules.  The panel provides
this access through its tags.  The PowerPanel has tags that are mapped
to the PLC data table.  The mapping between panel tags and PLC data
tables is user-defined through a simple dialog box.  PowerPanel objects
allow you to set/reset bits and to read/write from the PLC data table
through the panel tags.

For example, when a panel button object is pressed, it sets a panel tag.
The panel transfers the state of this tag to the mapped bit in the PLC
data table.  Similarly, the PLC may set an output bit that turns on a pilot
light on the panel.

Please Note:  Panel Tags may be internal (not mapped to
the PLC) or external (mapped to the PLC).

Panel Tags may be:

• Discrete

• 16-bit (Signed/Unsigned)

• 32-bit (Signed/Unsigned)

• 16-bit BCD

• 32-bit BCD

• 32-bit Floating Point

• ASCII String

IMPORIMPORIMPORIMPORIMPORTTTTTANT!  ANT!  ANT!  ANT!  ANT!  TTTTTo learn all the steps to configuring ano learn all the steps to configuring ano learn all the steps to configuring ano learn all the steps to configuring ano learn all the steps to configuring an
object,object,object,object,object, read the instructions f read the instructions f read the instructions f read the instructions f read the instructions for the firor the firor the firor the firor the first object,st object,st object,st object,st object, Button Button Button Button Button
Object,Object,Object,Object,Object, in its entirety in its entirety in its entirety in its entirety in its entirety.....  It will take y  It will take y  It will take y  It will take y  It will take you throu throu throu throu through eacough eacough eacough eacough eachhhhh
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The Objects menu allows you to choose from several predefined objects.
Objects provide generic panel functions.  The objects can be accessed
from both the Object Tool Bar and the Objects Menu.

All of the objects in this menu have user-defined frame types, line and fill
colors, and text.  To configure an object, click on the object icon on the
object tool bar or on the object name in the menu drop down list with
your mouse.

• Button

• Indicator Button

• Radio Button

• Switches

• Step Switch

• Tri-State Switch

• Numeric Entry

•  Recipe

• Thumbwheel

• Indicator Light

• Numeric Display

• Static Text

• Triggered Text

• Lookup Text

• Dynamic Text

• Text Entry

• Analog Clock

• Digital Clock

• Meter

• Bar Graph

• Line Graph

• PID Face Plate

• Dynamic Bitmap

• Change Screen

• Alarm History

• Adjust Contrast

• Increment/Decrement
Hour

• Activate Screen Saver

• Select Language

Configure an object by
selecting it from the OBJECT
MENU or OBJECT TOOL
BAR
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Button ObjectButton ObjectButton ObjectButton ObjectButton Object
Pressing a Button object allows you to WRITE to a Tag. It can be
displayed in a variety of colors, sizes and shapes and has a simulation
option (allowing you to see how it will look when pressed).  You may
select from 5 types of button states:  Momentary ON, Momentary
OFF, Set ON, Set OFF and TOGGLE.

To put a Label on a Button, perform the following steps:
1. Click on the box in front of Label Text.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See section on Language, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40 characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

To Choose a Button Style, perform the following steps:
1. Under Select Style, click on the style you prefer for the button

object you are creating.
2. Your choice will appear under Selected Style.

Click on the down arrow next to
the default color block for text
or background to view the color
palette.  Move the cursor over
your choice and simply click to
select.

Choose from 128 Colors!Choose from 128 Colors!Choose from 128 Colors!Choose from 128 Colors!Choose from 128 Colors!
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Enter a Tag Name:
1. Enter a Tag Name or click on the down arrow and select the

Tag Name that you want the button to correspond to.
2. If the Tag Name is new, the Add New Tag Details dialog

box will appear where you will map the tag. The Tag Name
will appear in the first field.  Enter an Address String
appropriate for your type PLC.  Click on the OK button.

NOTE:  To edit the Address String, with your cursor
in the Tag Name field, click on the right mouse button.
The Edit Tag Details screen will appear.

Select from the following Actuator Types:
Actuator Type determines how the tag will be controlled.  NOTE:  If
you have assigned Password Protection for this object and
select Momentary On or Momentary Off, the protection
feature is disabled with this actuator type.

• Momentary On will turn the tag on for as long as you
touch the button.  (Password Protection is disabled.)

• Momentary Off will turn the tag off for as long as you
touch the button.  (Password Protection is disabled.)

• Set On will latch the tag ON.
• Set Off will latch the tag OFF.
• Toggle will change the state of the tag every time the

button is pressed.

Enter On/Off Text:
Here you will enter the Text that will appear within the object, and
control how that text will appear.

1. Select the Language number (1–9) for the On/Off Text.
2. Type in what you want to appear within the button for the On

Text and for the Off Text (i.e., you might want to place the
words STOP and RUN inside the buttons, instead of Off and
On).

3. Select Character Size from the available choices
4. Select the Color of the Text and the Color of the

Background.
5. If you want the Text or the Background to Blink, click on

the box below Blink to place a check mark indicating that the
option is enabled.

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

For more information about Tags, see
Tag Database, page 133.

For each object, you may
program the text to display in up
to 9 Languages! (See Language
section on page 153.)

Hello...Hello...Hello...Hello...Hello...
Hola...Hola...Hola...Hola...Hola...
          Guten           Guten           Guten           Guten           Guten TTTTTaaaaag...g...g...g...g...

PLEASE NOTE: If your panel
is connected to multiple PLCs,
use the Station Number to
address a specific PLC.  For
example: 2–V2002  would
address the PLC Station
Number 2.
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The Password Protect Object feature allows you to prevent
unauthorized users from accessing certain objects and their func-
tions.  With Protection enabled, when the operator presses the object
on the panel screen, a keypad will appear prompting the operator to
enter the password.  This feature is useful when several people will
be using the PowerPanelto perform different tasks, such as,
changing initial values, or monitoring system status.  To enable
password protection for the object, click in the box in front of the
groups you wish to allow access.

Edit Passwords
There are eight groups that you may assign Passwords to.  Pass-
words allow you to implement restrictions on who can use the
password protected objects (e.g., to make system or internal panel
adjustments, enter text or values, or control a machine function in
your application).  Click on the Edit Passwords button to setup or
change the passwords.

The following  touch objects allow you
to enable protection and assign
passwords to allow a group or
individual (user-defined) to  have
access to that object:

Buttons
Indicator Buttons
Switches
Step Switches
Tri-State Switches
Numeric Entry
Recipe
Thumbwheel
Text Entry
Change Screen
Alarm History
Increment/Decrement Hour
Activate Screen Saver
Adjust Contrast
Select Language

Protection Tab

Place Button on the screen and size it.
• To size the button, grab a handle and drag it to the size you

want.
• To move the button, select it, click and hold left mouse

button and drag it to the area of the screen where you want
it to appear.

Simulate Press
To Simulate Press, double click the object to bring up the object dialog
box.  (You may have to drag the dialog box to see the object on the
programming screen.) Click on the Simulate Press button to see how
the button object will display on the screen when pressed.

Grab a handle with
your mouse

Click on the Protection Tab

IMPORTANT!
Password Protection is not
intended to work with objects
when the actuator type selected
is Momentary On and
Momentary Off.
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GROUP
(You may change the Group names to suit your application.)

✔ Managers

✔ Engineers

✔ Supervisors

✔ Maintenance

✔ Shift 1 Operator

✔ Shift 2 Operator

✔ Shift 3 Operator

✔ General

Password/Tag
Select whether or not you want your password to be stored in the
PowerPanel or in the PLC.  If you choose Password, it will be stored in
the panel.  If you choose Tag, it will be stored in the PLC.

PASSWORD
A 1–10 digit number (numeric only) is assigned here that the user must
enter to perform protected functions for a particular Group. You will not
be allowed to enter a password if you select Tag in the second column.
Do not enter leading zeroes in a password.  Leading zeroes
are ignored. In other words, if you enter a password of 00456,
your password will be 456.

TAG
Tag names are assigned to PLC addresses that hold the passwords.
This allows you to store the codes in your PLC.  You will not be allowed
to enter a Tag if you select Password in the second column.

Please NOTE:  If you enter a
password with leading zeroes,
e.g., 00003 or 00533, the
leading zeroes will be ignored!

A keypad similar to the one
shown below will appear on the
panel when a protected objected
is pressed, prompting the
operator to enter the password.
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Visibility/Details Tab

Visibility
1. Check the box in front of Visibility Tag if you want to control

when the object is visible on the screen.  (If it is not checked
the object will always be visible.)

2. Click on the down arrow next to the Tag Name box to view a
list of the tags you have previously programmed or create a
new one.  Select the tag that links the object to the register bit
that you want to control it.

3. Select whether you want the Object Visible when the bit is
ON or OFF.

Details
1. Type in a name for the object in the space provided under

Object Name.  The name can be up to 40 characters long.
2. Type in a description of the object in the space provided under

Object Description.  An Object Description can be up to
400 characters long.

Click on the Visibility/Details
Tab
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An Indicator Button combines a regular button with an indicator
light.  It allows you to perform a WRITE operation to one bit and a
READ operation from a second discrete location. The state of that
READ location determines whether the button is displayed in the ON
or OFF mode.   You may choose to make the READ and WRITE
location the same.

To put a Label on an Indicator Button, perform the following
steps:

1. Click on the box in front of Label Text.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See section on Language, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40 characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

To Choose an Indicator Button Style, perform the following
steps:

1. Under Select Style, click on the style you prefer for the button
object you are creating.

2. Your choice will appear under Selected Style.

Enter a Tag Name:
1. Enter a Tag Name or click on the down arrow and select the

Tag Name that you want the Indicator button and the Indicator
to correspond to.

2. If the Tag Name is new, the Add New Tag Details dialog box
will appear where you will enter tag details. The Tag Name
will appear in the first field.  Enter an Address String
appropriate for your type PLC. Click on the OK button.

Indicator Button ObjectIndicator Button ObjectIndicator Button ObjectIndicator Button ObjectIndicator Button Object

NOTE:  To edit the Address
String, with your cursor in
the Tag Name field, click on
the right mouse button.  The
Edit Tag Details screen will
appear.
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Select from the following Actuator Types:
Actuator Type determines how the tag will be controlled.  If you have
assigned Password Protection for this object and select
Momentary On or Momentary Off, the protection feature will
not be enabled.

• Momentary On will turn the tag on for as long as you touch
the button.  (Password Protection is disabled.)

• Momentary Off will turn the tag off for as long as you
touch the button.  (Password Protection is disabled.)

• Set On will latch the tag ON.
• Set Off will latch the tag OFF.
• Toggle will change the state of the tag every time the button

is pressed.

Enter On/Off Text:
Here you will enter the Text that will appear within the object, and
control how that text will appear.

1. Select the Language number (1–9) for the On/Off Text.
2. Type in what you want to appear within the button for the On

Text and for the Off Text (i.e., you might want to place the
words STOP and RUN inside the buttons, instead of Off and
On).

3. Select Character Size from the available choices
4. Select the Color of the Text and the Color of the Background.
5. If you want the Text or the Background to Blink, click on the

box below Blink to place a check mark indicating that the
option is enabled.

Protection  (See Button Object.)

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the dialog

box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Indicator Button on the screen and size it.
• To size the Indicator button, select it, grab a handle and drag.
• To move the button, select it, click and hold left mouse button

and drag it to where you want it to appear on the screen.

Simulate Press
To Simulate Press, double click the object to bring up the object dialog
box.  (You may have to drag the dialog box to one side to see the
object on the programming screen.) Click on the Simulate Press
button to see how the button object will display on the screen when
pressed.
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The Radio Button object has a maximum of 8 buttons, however, only
one can be ON at any given time.  When a button is pressed it
releases any button that may be ON, and becomes the active button.
Each button controls a bit and is assigned an area of the
touchscreen.  Radio buttons can have from 2 to 8 buttons. (Please
note that no more that 6 vertical buttons can be used for 6-inch
panels.)

To put a Label on a Radio Button, perform the following steps:
1. Click on the box in front of Label Text.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See section on Language, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40 characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

To Choose a Radio Button Style, perform the following steps:
1. Under Select Style, click on the style you prefer for the

button object you are creating.
2. Your choice will appear under Selected Style.

Enter a Tag Name:
1. Enter a Tag Name or click on the down arrow and select the

Tag Name that you want to button to correspond to.
2. If the Tag Name is new, the Add New Tag Details dialog box

will appear where you will enter tag details. The Tag Name
will appear in the first field.  Enter an Address String
appropriate for your type PLC. Click on the OK button.

Radio ButtonsRadio ButtonsRadio ButtonsRadio ButtonsRadio Buttons

NOTE:  To edit the Address
String, with your cursor in
the Tag Name field, click on
the right mouse button.  The
EDIT TAG DETAILS screen
will appear.
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Please Note:  This object can use a signed or unsigned Data
Type.  Button 1 = Bit 0 in assigned tag.  Button 8 = Bit 7 in
assigned tag.  Bit 9 to 15, not used.

Select Number of Buttons:
1. Click on the UP or DOWN arrow to select the number of

radio buttons.  You may choose from 2 to 8 buttons. (You
may only have 6 buttons for 6-inch panels.)

Enter On/Off Text:
Text size and color are programmed under the General Tab.  These
characteristics will be implemented for all of the inside button text.

1. Select the Character Size for the On Text and the Off Text.
2. Choose the Color of the Text by clicking on the arrow button

to view the  color palette.  Move the cursor over the color you
want and click to select.

3. Select whether or not the Text will Blink.
4. Next, select the Background Color of the button and

whether or not it will Blink.
5. Each Radio Button (from 2 to 8) may contain different text

and a different language.  Click on the Button #1 tab.
6. Choose the Language number (1–9) and type in the text as

you want it to appear within that button when ON and when
OFF (i.e., you might want to place the words STOP and RUN
inside the buttons, instead of Off and On).

Remember that the other universal characteristics
for the button text and background have been
chosen under the General Tab (character size, color,
etc.).

Click on the Button #1 Tab
to edit Language and On/
Off Text.
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Protection  (See Button Object.)

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Radio Button on the screen and size it.
• To size the button, select it, grab a handle and drag.
• To move the button, select it, click and hold left mouse

button and drag to where you want it to appear on the
screen.

Simulate Press
To Simulate Press, double click the object to bring up the object dialog
box.  (You may have to drag the dialog box to see the object on the
programming screen.) Select the tab of the button you want to
simulate. Click on the Simulate Press button to see how the button
object will display on the screen when pressed.
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There are several types of Switch objects that you may place on
the PowerPanel screen.  They simulate mechanical switches of the
same type, e.g.; Throw Switch, Selector Switch, Slide Switch, Toggle
Switch, etc.

To put a Label on a Switch, perform the following steps:
1. Click on the box in front of Label Text.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See section on Language, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40 characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

To Choose a Switch Style, perform the following steps:
1. Under Select Style, click on the style you prefer for the switch

object you are creating.
2. Your choice will appear under Selected Style.

Enter a Tag Name:
1. Enter a Tag Name or click on the down arrow and select the

Tag Name that you want the switch to correspond to.
2. If the Tag Name is new, the Add New Tag Details dialog

box will appear where you will enter tag details. The Tag Name
will appear in the first field. Enter an Address String
appropriate for your type PLC. Click on the OK button.

Switch ObjectSwitch ObjectSwitch ObjectSwitch ObjectSwitch Object

NOTE:  To edit the Address
String, with your cursor in
the Tag Name field, click on
the right mouse button.  The
EDIT TAG DETAILS screen
will appear.
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Select the Switch Background color by clicking on the DOWN arrow
and selecting a color from the palette.

Select from the following Actuator Types:
Actuator Type determines how the tag will be controlled.  If you have
assigned Password Protection for this object and select
Momentary On or Momentary Off, the protection feature will
not be enabled with this actuator type.

• Momentary On will turn the tag on for as long as you
touch the switch.  (Password Protection is disabled.)

• Momentary Off will turn the tag off for as long as you
touch the switch.  (Password Protection is disabled.)

• Set On will latch the tag ON.
• Set Off will latch the tag OFF.
• Toggle will change the state of the tag every time the

switch is pressed.

Enter On/Off Text:
Here you will enter the Text that will appear within the object, and
control how that text will appear.

1. Select the Language number (1–9) for the On/Off Text.
2. Type in what you want to appear within the switch for the On

Text and for the Off Text (i.e., you might want to place the
words STOP and RUN inside the switches, instead of Off
and On).

3. Select Character Size from the available choices
4. Select the Color of the On Text and the Color of the Off

Text.
5. If you want the Text to Blink, click on the box below Blink to

place a check mark indicating that the option is enabled.

Protection  (See Button Object.)

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Switch on the screen and size it.
• To size a switch, click on it to select, grab a handle with the

mouse and drag to the size you want.
• To move the switch, select it, click and hold left mouse

button, and drag to where you want it to appear on the
screen.
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The Step Switch object simulates a Mechanical Step Switch on the
PowerPanel.  It allows you to simultaneously monitor and control two,
three, or four different bits and display ON and OFF text for each bit.
Each time the Step Switch is pressed, each bit will be cycled one at a
time from OFF to ON with only one bit ON at a time.

To put a Label on a Switch, perform the following steps:
1. Click on the box in front of Label Text.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See section on Language, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40 characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

To Choose a Step Switch Style, perform the following steps:
1. Under Select Style, click on the style you prefer for the button

object you are creating.
2. Your choice will appear under Selected Style.

Choose the Number of Steps (from 1 to 4) in the process or application
that you want your switch to control. Enter the number of steps or click
on the up/down arrows to select.

Step #1 Tab
1. Click on Step #1 tab.
2. Enter Tag Name for Step #1.

Step Switch ObjectStep Switch ObjectStep Switch ObjectStep Switch ObjectStep Switch Object

NOTE:  To edit the Address
String, with your cursor in the
Tag Name field, click on the
right mouse button.  The
EDIT TAG DETAILS screen
will appear.
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3. Select Language (1 to 9) for On/Off Text and then enter the
On Text and Off Text that you want to appear within Step
Switch #1.

4. Select Character Size, Color of Text and Background
and whether or not, Text and/or Background will Blink.

5. Repeat for Step #2, Step #3 and Step #4, if necessary.

Protection  (See Button Object.)

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Step Switch on the screen and size it.
• To size the switch, grab a handle and drag.
• To move the switch, select it, click and hold left mouse

button and drag.

Simulate Press
To Simulate Press, double click the object to bring up the object dialog
box.  (You may have to drag the dialog box to see the object on the
programming screen.) Select the tab of the Step you want to simulate
(if on General tab, will simulate Step 1 only). Click on the Simulate
Press button to see how the switch object will display on the screen
when pressed.
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The Tri-State Switch object controls two bits at a time from two different
tags. It consists of three buttons. If the first button is pressed, both the
bits are OFF. If the second button is pressed, the first bit is ON and
second bit is OFF. If third button is pressed, the first bit is OFF and
second bit is ON.

To put a Label on a Switch, perform the following steps:
1. Click on the box in front of Label Text.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See section on Language, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40 characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

To Choose a Tri-State Switch Style, perform the following
steps:

1. Under Select Style, click on the style you prefer for the button
object you are creating.

2. Your choice will appear under Selected Style.

Tag Names
Click on the down arrow to select  or enter new Tag Names for the
First Bit and for the Second Bit.  If the Tag Name is new, the Add
New Tag Details dialog box will appear where you will enter tag details.
The Tag Name will appear in the first field.  Enter an Address String
appropriate for your type PLC. Click on the OK button.

TTTTTri-State Switcri-State Switcri-State Switcri-State Switcri-State Switch Objecth Objecth Objecth Objecth Object

NOTE:  To edit the Address
String, with your cursor in the
Tag Name field, click on the
right mouse button.  The EDIT
TAG DETAILS screen will
appear.

PLEASE NOTE:
The Tri-State switch object is
always snapped to a touch cell
to ensure that it operates
properly on the panel screen.
If you select the vertical style,
you will notice that a label is
not available (grayed out).
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Text
Here you will enter the Text that will appear within the object, and
control how that text will appear.

1. Select the Language number for the Off, First (bit) and
Second (bit) Text.

2. Type in what you want to appear within the button for the Off
Text, First Text and for the Second Text.

3. Select Character Size from the available choices.
4. Select the Color of the Text and the Color of the

Background.  If you want the Text or the Background to
Blink, click on the box below Blink to place a check mark
indicating that the option is enabled.

Protection  (see Button Object.)

Visibility/Details  (see Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Tri-State Switch on the screen and size it.
• To size the switch, grab a handle and drag it to size you

want.
• To move the switch, select it, click and hold left mouse

button and drag to where you want it to appear on the
screen.
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The Numeric Entry object allows you to write a value to a PLC register.
A numeric keypad will pop up when the Numeric Entry object is pressed
on the PowerPanel screen. When you select a Tag Name, you will be
selecting the PLC location where you want the keypad accumulator data
to go.  In other words, the value the operator enters on the keypad will
be written to the PLC location.

To put a Label on the Numeric Entry object, perform the
following steps:

1. Click on the box in front of Label Text.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See section on Language, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40 characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

Enter a Tag Name:
1. Enter a Tag Name or click on the down arrow and select the

Tag Name that you want the object to correspond to.
2. If the Tag Name is new, the Tag Entry dialog box will appear

where you will enter tag details. The Tag Name will appear in
the first field.  Enter an Address String appropriate for your
type PLC and select the Data Type (from available choices).
Click on the OK button.

Numeric Entry ObjectNumeric Entry ObjectNumeric Entry ObjectNumeric Entry ObjectNumeric Entry Object

NOTE:  To edit the Address
String, with your cursor in the
Tag Name field, click on the
right mouse button.  The
EDIT TAG DETAILS screen
will appear.
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To Enter Range Check , perform the following steps:

1. Under Range Check, set the minimum and maximum set points.
Click on Minimum, the low end point, and enter a value.  The
operator will not be allowed to enter a value lower than the
value in this field.

2. Click on Maximum, the high end point, and enter a value.
The operator will not be allowed to enter a value higher than
the value in this field. (Valid Range is shown in the next window.)

3. The Valid Range is shown.  Your minimum and maximum
set  points must be within these limits.

To Select the Format of the Numeric Entry Keypad, perform
the following steps:

The Data Type is dependent upon the Tag data type.   In turn, the Tag
data type is dependent upon the type of PLC you are using.  Therefore,
your selections next to Data Type in this object will be limited by your Tag
and PLC data type.  PowerPanel Programming Software will automatically
limit your selections based on the PLC and Tag address format.  The
program will also let you know if you have entered an invalid data type.

SIGNED DATA TAG: SIGNED Keypad only
UNSIGNED DATA TAG: UNSIGNED, OCTAL, HEX Keypad
BCD DATA TAG: BCD Keypad only
FLOATING POINT TAG
(if available for that PLC): FLOATING POINT Keypad only

The Data Types, and their respective ranges, that may be available,
are as follows:

Signed 16 Decimal: -32768 to +32767
Signed 32 Decimal: -2147483648 to +2147483647
Unsigned 16 Decimal: 0 to 65535
Unsigned 32 Decimal: 0 to 4294967295
Octal 16: 0 to 177777
Octal 32: 0 to 37777777777
Hex 16: 0 to FFFF
Hex 32: 0 to FFFFFFFF
BCD 16: 0 to 9999
BCD 32: 0 to 99999999
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1. Click on Data Type and select from the available choices.
2. Click on Justification and select from the following:  Leading

Zeroes, Leading Spaces, or Trailing Spaces.
3. Click on Size and select from the available character sizes.

(Click on down arrow to view list of sizes.)
4. Under Color, click on down arrow to view the color palette for

Text.  Click on any color to select.
5. Click on the box in front of Blink if you want your text characters

to blink.
6. Select color for Background and whether or not you want it

to Blink.
7. Click on Total Digits under # Digits.  The PowerPanel will

display the minimum value and the maximum number inside the
keypad. Here you will select how many digits, from 1 to 10
(depending on the data type and tag value type chosen), that
you want to display.

8. If you want Fractional Digits, enter 1 through 10 here (select
0 for none).  For example, if your maximum value is 999, you
would enter 3 under total digits.  If your maximum value is
99.9, enter 3 under Total Digits and 1 under Fractional
Digits.

This is an example of a SIGNED
DECIMAL Popup Keypad as it will
display on your  PowerPanel
Screen.

If you enter an invalid value,  press
the Clear (CLR) button and reenter.

➥
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Scaling Tab

Under the Numeric Entry object Scaling tab, you can scale the entered
value from the numeric entry object to another value in the PLC.  Enter
the Minimum (Point 1) and Maximum (Point 2) PLC Values. The
Display Value Point 1 MUST match the Range Check Minimum and
Point 2 must match the Range Check Maximum.

(An example of SCALING is provided on the dialog box, above.)

Protection  (see Button Object.)

Visibility/Details  (see Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Object on the screen and size it.
• To size the Numeric Entry object, grab a handle and drag.
• To move the object, select it, click and hold left mouse button

and drag to where you want it to appear on the screen.

Click on the Scaling tab if you
want the Display Value to be
different than the PLC Value.
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The Recipe object allows you to write preset values of up to 20 Tags to
the PLC to change the process.  Thus, this feature can be used to
download "recipes" to the PLC.

To put a Label on the Recipe object button, perform the following
steps:

1. Click on the box in front of Label Text.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See section on Language, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40 characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

Enter Text:
Here you will enter the Text that will appear within the object, and
control how that text will appear.

1. Select the Language number (1–9) for the  Text.
2. Type in what you want to appear within the button.
3. Select Character Size from the available choices
4. Select the Color of the Text and the Color of the

Background.
5. If you want the Text or the Background to Blink, click on

the box below Blink to place a check mark indicating that the
option is enabled.

Recipe ObjectRecipe ObjectRecipe ObjectRecipe ObjectRecipe Object
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Enter Tag Name and Register Values:

Pressing the Recipe button allows you to write values to several
locations at once.  The screen shown above is where you will enter the
values to be written to the PLC location.

1. Click on the Recipe Tab.
2. Under Tag Name, click on the down arrow to view list of

available tags (or enter a new name).  Select the tag you wish
to use.

3. Select the Data Type that the panel will use to write the values
under Display Format.  Select from the available choices
(i.e., Unsigned Decimal, Signed Decimal, Octal or Hex.)

4. Type in the Value you want written to the register.
5. Repeat for the second entry with the value you want written to

in the next register.  You may continue writing values for up to
20 Tags (locations). Note:  If a Discrete tag is chosen, enter a
0 for OFF or a 1 for ON.

Protection  (see Button Object.)

Visibility/Details  (see Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Recipe object button on the screen and size it.
• To size the object, grab a handle and drag.
• To move the object, select it, click and hold left mouse

button while dragging the object to where you want it placed
on the screen.
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The function of this object is similar to Numeric Entry Button.  The
Thumbwheel object allows you to display a Thumbwheel keypad on
the panel. This button can be 1 to 5 digits. Using the popup thumbwheel,
the operator can change each digit separately. The operator presses the
UP or DOWN arrow to increment or decrement the value of each digit.
Press the enter button to write that value to the defined tag. This allows
the operator to assign a value to a specific PLC register.

To put a Label on the Thumbwheel object button, perform the
following steps:

1. Click on the box in front of Label Text.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See section on Language, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40 characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

Enter a Tag Name:
1. Enter a Tag Name or click on the down arrow and select the

Tag Name that you want the object to correspond to.
2. If the Tag Name is new, the Add New Tag Details dialog box

will appear where you will enter tag details. The Tag Name
will appear in the first field.  Enter an Address String
appropriate for your type PLC and select the Data Type (from
available choices). Click on the OK button.

Note:  UNSIGNED_INT_16 and BCD_INT_16 are the only available
choices.

Thumbwheel ObjectThumbwheel ObjectThumbwheel ObjectThumbwheel ObjectThumbwheel Object
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Select Thumbwheel Format:

1. Select the Number of Wheels (from 1 to 5) for the object.
You will only be able to use 4 digits (wheels) when using
BCD or Hex data formats.

2. Choose the size of the numbers (Character Size) that will
appear within the thumbwheels.

3. Select the Data Type of the numbers from the available
selections.

Protection  (see Button Object.)

Visibility/Details  (see Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Thumbwheel object button on the screen and size it.
• To size object, grab a handle and drag the object to the size

that you want.
• To move the object, select it, click and hold left mouse while

dragging to where you want it to appear on the screen.
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An Indicator Light object allows you to monitor and display the state of
a bit. The Indicator Light reads the bit information and produces the
appropriate display.  For example, the Indictor Light could display the
status of a bit linked to a push button.

Indicator Light ObjectIndicator Light ObjectIndicator Light ObjectIndicator Light ObjectIndicator Light Object

To put a Label on the Indicator Light object, perform the following
steps:

1. Click on the box in front of Label Text.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See section on Language, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40 characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

To Choose an Indicator Light Style, perform the following steps:
1. Under Select Style, click on the style you prefer for the

indicator light object you are creating.
2. Your choice will appear under Selected Style.

Enter a Tag Name:
1. Enter a Tag Name or click on the down arrow and select the

Tag Name that you want the Indicator Light to monitor.
2. If the Tag Name is new, the Add New Tag Details dialog box

will appear where you will enter tag details. The Tag Name will
appear in the first field.  Enter an Address String appropriate
for your type PLC.  Click on the OK button.
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Enter On/Off Text:
Here you will enter the Text that will appear within the object, and
control how that text will appear.

1. Select the Language number (1–9) for the On/Off Text.
2. Type in what you want to appear within the Indicator Light  object

for the On Text and for the Off Text (i.e., you might want to
place the words STOPPED and RUNNING inside the
Indicator light, instead of Off and On).

3. Select Character Size from the available choices.
4. Select the Color of the Text and the Color of the

Background.
5. If you want the Text or the Background to Blink, click on

the box below Blink to place a check mark indicating that the
option is enabled.

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Indicator Light object on the screen and size it.
• To size it grab a handle and drag it to the size that you want.
• To move the button, select it, click and hold left mouse

button and drag to where you want it to appear on the
screen.

Simulate Press
To Simulate Press, double click the object to bring up the object dialog
box.  (You may have to drag the dialog box to see the object on the
programming screen.) Click on the Simulate Press button to see
how the Indicator Light object will display on the screen when
pressed.
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The Numeric Display object allows you to display a Tag value within a
frame on the screen.

To put a Label on the Numeric Display object, perform the
following steps:

1. Click on the box in front of Label Text.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See section on Language, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40 characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

Enter a Tag Name:
1. Enter a Tag Name or click on the down arrow and select the

Tag Name that you want the Numeric Display object to monitor.
2. If the Tag Name is new, the Tag Entry dialog box will appear

where you will enter tag details. The Tag Name will appear in
the first field.  Enter an Address String appropriate for your
type PLC and select the Data Type (from available choices).
Click on the OK button.

Numeric Display ObjectNumeric Display ObjectNumeric Display ObjectNumeric Display ObjectNumeric Display Object

NOTE:  To edit the Address
String, with your cursor in the
Tag Name field, click on the
right mouse button.  The EDIT
TAG DETAILS screen will
appear.
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Enter the Format of the Numeric Display:

The Data Type is dependent upon the Tag type.  In turn, the Tag data
type is dependent upon the type of PLC you are using.  Therefore, your
selections next to Data Type in this object will be limited by your Tag and
PLC data type.  PowerPanel Programming Software will automatically
limit your selections based on the PLC and Tag address format.

The Data Types, and their respective ranges, that may be available,
are as follows:

Signed 16 Decimal: -32768 to +32767
Signed 32 Decimal: -2147483648 to +2147483647
Unsigned 16 Decimal: 0 to 65535
Unsigned 32 Decimal: 0 to 4294967295
Octal 16: 0 to 177777
Octal 32: 0 to 37777777777
Hex 16: 0 to FFFF
Hex 32: 0 to FFFFFFFF
BCD 16: 0 to 9999
BCD 32: 0 to 99999999

1. Click on Data Type and select from the available choices.
2. Click on Justification and select from the following:  Left

Justify, Right Justify, or Leading Zeroes.
3. Click on Size and select from the available character sizes.

(Click on down arrow to view list of sizes.)
4. Under Color, click on down arrow to view the color palette for

Text.  Click on any color to select.
5. Click on the box in front of Blink if you want your text characters

to blink.
6. Select color for Background and whether or not you want it

to Blink.
7. Click on Total Digits under # Digits.  Here you will select

how many digits, from 1 to 10 (depending on the Data Type
and Tag Type), that you want to display.

8. If you want Fractional Digits, enter 1 through 10 here (select
0 for none).  For example, if your maximum value is 999, you
would enter 3 under total digits.  If your maximum value is
99.9, enter 3 under Total Digits and 1 under Fractional Digits.
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Scaling Tab

Under the Scaling tab, you can scale the value in the PLC to another
value on the Numeric Display.  Enter Point 1 (Minimum Value) and
Point 2 (Maximum) PLC Values.  Scale these values by entering the
Display Value Minimum and Maximum.

For example, say the PLC values are an analog value of 0–4095, and
represent a range of 0–500 PSI.

Enter a PLC Value Minimum (Point 1) = 0 and a Display Value
Minimum = 0 (PSI)
Enter a PLC Value Maximum (Point 2) = 4095 and a Display
Value Maximum = 500 (PSI)
If the PLC Value is then = 1024, the Display Value will be 125.

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Object on the screen and size it.
• To size the object, grab a handle and drag it to the size you

want.
• To move the button, select it, click and hold left mouse

button and drag to the area on the screen that you want it to
appear.

Click on the Scaling tab if you
want the Display Value to be
different than the PLC Value.
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TTTTTeeeeext Objectxt Objectxt Objectxt Objectxt Object Static Text
This object allows you to place text anywhere on the screen to provide
information, screen description, etc. You can choose whether or not to
display a frame around the text and whether or not you want it to be
transparent.

Under the General tab you will make the following selections:
1. Select a Language (1–9) that you want the text to display in.
2. Select a Character Size from those available (e.g., 6 x 8, 8 x

16,  8 x 32).
3. Type in the Text as you want it to display on the PowerPanel

Panel screen.  The text can be up to 500 characters and wraps
within the frame.

4. Select Horizontal (Left, Center, or Right) and Vertical (Top,
Center, or Bottom) Justification for the text. Default for both
is "Center".

5. If you want the text to appear within a frame, click on the box in
front of Display Frame to enable.  If you want to see through
the text and/or frame to what lies underneath, click on the box
in front of Transparent.

6. Select the Text and Background Color from the available
choices. Default Text color is black and the default Background
color is gray.

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Text Object on the screen and size it.
• To size the object, grab a handle and drag.
• To move the button, select it, click and hold left mouse

button, and drag to where you want it to appear on the
screen.
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Triggered Text

The Triggered Text object monitors a bit to display different text strings
for “ON” and “OFF” conditions.  This would be used in applications where
you want to provide a message or a description of the process or condition.

To put a Label on the Triggered Text object, perform the
following steps:

1. Click on the box in front of Label Text.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See section on Language, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40 characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

Enter the Text you want to appear on the display when ON
and when OFF:

1. Select the Language number for the On Text and the Off
Text.

2. Type in what you want to appear within the frame for the On
Text and for the Off Text (up to 500 characters).

Enter a Tag Name:
1. Enter a Tag Name or click on the down arrow and select the

Tag Name that you want the Trigger Text object to monitor.
2. If the Tag Name is new, the Add New Tag Details dialog

box will appear where you will enter tag details. The Tag Name
will appear in the first field.  Enter an Address String
appropriate for your type PLC. Click on the OK button.

NOTE:  To edit the Address
String, with your cursor in the
Tag Name field, click on the
right mouse button.  The
EDIT TAG DETAILS screen
will appear.
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Make selections for On Text and Off Text Format:

Under On Text Format:
1. Select Size from the available choices.
2. Select the Color of the Text and the Color of the

Background.
3. If you want the Text or the Background to Blink, click on the

box below Blink to place a check mark indicating that the
option is enabled.

4. Choose the Horizontal and Vertical Justification for the On
Text.  For Horizontal justification, click in front of one of the
following:  Left, Center, or Right.  For Vertical Justification,
click in front of Top, Center, or Bottom.

Under Off Text Format, repeat the steps above.

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Text Object on the screen and size it.
• To size the object, select it, grab a handle and drag.
• To move the object, select it, click and hold left mouse button

and drag it to where you want it to appear on the screen.

Simulate Press
To Simulate Press, double click the object to bring up the object dialog
box.  (You may have to drag the dialog box to one side to see the
object on the programming screen.) Click on the Simulate Press
button to see how the object will display on the screen when
pressed.
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Lookup Text
Lookup Text is an object that is created to display preprogrammed
messages within a frame on the PowerPanel screen. These
preprogrammed messages are stored in the "Message Database."  It
displays one message at a time.  (Click on the Message Database button
at the bottom of the dialog box to program messages in the database.)

A Value corresponding to the Tag Name is the Message Number that will
be displayed inside the frame of the Lookup Text. Each message
designed in the Message Database is numbered from 1 to 999. So, if the
Value corresponding to the Tag Name is 10, Message Number 10 will be
displayed within the Lookup Text Frame.

To put a Label on the Lookup Text object, perform the following
steps:

1. Click on the box in front of Label Text.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See section on Language, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40 characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

Enter a Tag Name:
1. Enter a Tag Name, or click on the down arrow and select the

Tag Name from the available choices.
2. If the Tag Name is new, the Add New Tag Details dialog box

will appear where you will enter tag details. The Tag Name

NOTE:  To edit the Address
String, with your cursor in the
Tag Name field, click on the
right mouse button.  The EDIT
TAG DETAILS screen will
appear.
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will appear in the first field.  Enter an Address String
appropriate for your type PLC and select the Data Type (from
available choices). Click on the OK button.

Messages are created using the Message Database. (See page 143 for
Message Database setup.)

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Lookup Text object on the screen and size it.
• To size it grab a handle and drag.
• To move the object, select it, click and hold left mouse button

and drag.

Message Database
Here you may create up to 999 messages (limited by available memory).
Each message may be up to 200 characters and you can choose various
message attributes such as, Character Size, Text Color, Background
Color, Blink (for text and/or background), and Language. The Message
Database is used by the Lookup Text object to display a message on
the panel.  Go to page 143 for instructions on how to create a Message.

Please Note:  The value
corresponding to the Tag
Name tells which message
number from the message
database is to be displayed.
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Dynamic Text

The Dynamic Text object will allow you to display the characters from
ASCII values stored in a Tag.  The tag will read a block of registers in the
PLC. Each 16-bit register in the PLC can contain 2 ASCII characters.
The maximum number of PLC registers in the block is 20 (a maximum of
40 ASCII characters).  This object allows you to place text anywhere on
the screen to provide information. It is typically used for displaying part
numbers, VIN numbers, or production numbers. Dynamic Text is triggered
by a bit Tag in the PLC.  You choose whether the Text is triggered by the
bit when it is in the ON state or the OFF state.  The Dynamic Text
object will then display a text string that is programmed in the PLC.

To put a Label on the Dynamic Text object, perform the following
steps:

1. Click on the box in front of Label Text.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See section on Language, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40 characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

NOTE:  To edit the Address
String, with your cursor in the
Tag Name field, click on the
right mouse button.  The EDIT
TAG DETAILS screen will
appear.
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Choose the Trigger Tag Name:
This Tag allows the PowerPanel to monitor a bit in the PLC and display
text based on the ASCII values in a block of PLC registers.

1. Select the Trigger Tag Name by clicking on the down arrow
to display the list or enter a Tag Name in the entry field.  If the
Tag Name is new, the ADD NEW TAG DETAILS dialog box
will appear. The Tag Name will appear in the first field.  Enter
an Address String appropriate for your type PLC. Click on
the OK button.

2. Choose to Activate when ON or Activate when OFF.  If
you choose ON, the Text will display when the bit is ON.  When
the bit is OFF, the Text will disappear.

Choose the String Tag Name:
The String Tag is the PLC register location where the values are read
and displayed in a character string.  The string may be up to 40 characters
long. The Address String is the beginning register for the text.

Choose the Tag Name by clicking on the down arrow to display the list of
Tags or type in the Tag Name in the entry field. If the Tag Name is new,
the ADD NEW TAG DETAILS dialog box will appear where you will
enter tag details. The Tag Name will appear in the first field.  Enter an
Address String appropriate for your type PLC (ASCII STRING is the
only choice). Click on the OK button.

Select the Dynamic Text Characteristics:
1. Select the Character Size from the available choices.
2. Select the Color of the Text and Background and whether

or not they will Blink.
3. Choose the Justification of the Text that is displayed within

the frame.  Choose both Horizontal (Left, Center, or Right)
and Vertical (Top, Center, or Bottom)  justification for the Text
within the frame.

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place object on the screen and size it.
• To size the object, grab a handle and drag it to the size you

want.
• To move the object, select it, click and hold left mouse

button and drag to where you want it to appear on the
screen.

Please Note:  For a list of
ASCII Characters that the
PowerPanelSupports, see
Appendix B.
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Text Entry
The Text Entry object, when pressed on the panel, brings up a character
entry (alphanumeric) keypad.  This allows the operator to enter text up
to 40 characters to send to a Tag assigned to an address in a PLC.  It
has many uses, some of which may be: to send part numbers or
production numbers to a PLC, or to send a message to a PLC that will,
in turn, route it to one or more plant floor message display(s).

To put a Label on the Text Entry object, perform the following
steps:

1. Click on the box in front of Label Text if you want a label for
your object.

2. Use the UP/DOWN arrows after the Language box to select
a language number. (See section on Language, page 153.)

3. Select Character Size from the available choices.
4. Enter Label Text up to 40  characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

Choose the String Tag Name:
The String Tag represents the PLC locations where the values are
sent.   The string may be up to 40 characters long.

1. Choose the Tag Name by clicking on the down arrow to display
the list of Tags or type in the Tag Name in the entry field. If the
Tag Name is new, the Add New Tag Details dialog box will
appear where you will enter tag details. The Tag Name will

NOTE:  To edit the Address
String, with your cursor in the
Tag Name field, click on the
right mouse button.  The
EDIT TAG DETAILS screen
will appear.
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appear in the first field.  Enter an Address String appropriate
for your type PLC. (ASCII STRING is only choice available.)
Select the Number of Characters. Click on the OK button.

Select the String Characteristics:
1. Select the Character Size from the available choices.
2. Select the Color of the Text and Background and whether

or not they will Blink.
3. Choose the Justification of the Text that is displayed within

the frame.  Choose both Horizontal (Left, Center, or Right)
and Vertical (Top, Center, or Bottom)  justification for the Text
within the frame.

Protection (See Button Object.)

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Text object on the screen and size it.
• To size the Text Entry object, select it, grab a handle, and

drag until it is the size you want.
• To move the object, select it, click and hold left mouse

button, and drag to where you want it to appear on the
screen.

This is the Popup (alphanumeric)
Keypad that displays on the
PowerPanel touchscreen when
the Text Entry object is pressed.

PLEASE NOTE:  For a list of
ASCII Characters that the
PowerPanelSupports, see
Appendix B.

PLEASE NOTE:  Each ASCII
character uses 1 byte of data.
There are 2 characters per
register. 40 character
maximum uses 20
consecutive registers.  The
Address String is the first
register of the consecutive
register block.
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Clock ObjectClock ObjectClock ObjectClock ObjectClock Object
The Clock object allows you to display a real time clock, showing the
current date, time, or both (analog clock displays time only.)  It can
display as either an Analog or Digital Clock.

Analog Clock

To put a Label on the Clock object, perform the following steps:
1. Click on the box in front of Label Text if you want a label for

your object.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See Language section, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40  characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

To Choose how the Analog Clock will appear, perform the
following steps:

1. Under Color, choose the color of the Background (face of
the clock), Digits, and Hour/Minute Hand.

2. Select whether or not you want the Second Hand to Display
and the Color, if enabled.

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Clock with label

Clock without label

See page 139  to set up the
Clock Attributes.
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Digital Clock

To put a Label on the Clock object, perform the following steps:
1. Click on the box in front of Label Text if you want a label for

your object.
2. Use the UP/DOWN arrows after the Language box to select

a language number. (See Language section, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40  characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

To choose how the Digital Clock will appear, perform the
following steps:

1. Under Options, choose to display just the Date, just the
Time, or both Time and Date.

2. Select whether or not you want the Time to be displayed in 24-
Hour Mode and whether or not  to Show Seconds.

3. Choose the Date Format from the available choices and the
Character Size.

4. Under Color, click on the down arrow next to Text and
Background to view the color palette.  Click on a color swatch
to select.

5. Click on the box under Blink if you want the Background or
Text to Blink.

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Clock with frame

Clock without frame
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Meter ObjectMeter ObjectMeter ObjectMeter ObjectMeter Object
A Meter object is used to display an analog gauge, such as a
speedometer. The meter consists of a data tag, a data type, data value
range, location of the meter on the screen, the sweep direction for the
needle, the needle color, and the number of ticks to display.

In simulating an analog gauge, the Meter object displays a needle that
sweeps through an arc as the tag value changes.  Tick marks are
displayed along the arc.

To put a Label on the Meter object, perform the following steps:
1. Click on the box in front of Label Text if you want a label for

your object.
2. Use the UP/DOWN arrows after the Language box to select

a language number.  (See Language section, page 153.)
3. Select Character Size from the available choices.
4. Enter Label Text up to 40  characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.
7. Click on a Style under Select Style.

Enter a Tag Name:
1. Enter a Tag Name or click on the down arrow and select the

Tag Name from the available choices.
2. If the Tag Name is new, the Tag Entry dialog box will appear

where you will enter tag details. The Tag Name will appear in
the first field.  Enter an Address String appropriate for your
type PLC and select the Data Type (from available choices).
Click on the OK button.

NOTE:  To edit the Address
String, with your cursor in the
Tag Name field, click on the
right mouse button.  The
EDIT TAG DETAILS screen
will appear.
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Make the following selections to Format your meter:

1. If you want to show tick marks on your meter, click on box in
front of Show Ticks to enable.

2. Next select the Number of Major Divisions and the
Number of Minor (Sub) Divisions to display (maximum
for each is 20).

3. Click on the down arrow next to Color to view the color palette
for the Tick marks.  Place the cursor over a color, and click to
select.

4. If you want to show numbers indicating the value of a particular
Tick mark, click on the box behind Show Tick Numbers.

5. Select the Minimum and Maximum Range of the values
represented in the meter display. Ranges should be entered in
decimal only

6. Select the Color of the Background and the Color of the
Needle from the available choices.

Click on the Alarms Tab to set the Visual Alarm parameters:

The Visual Alarm Settings, provide a color band on the arc
representing various limit parameters set by the programmer. They
provide the operator with a visual indication of current readings (as needle
sweeps over area) that may or may not exceed/fall below important values
for the process or function the meter is monitoring.

Maximum Number for the
Major Divisions and Sub
Divisions is 20!

NOTE:  These visual alarm
settings are only for display on
the meter, and are not related
to actual alarms in the alarm
database.

NOTE: When entering limits,
the ranges cannot overlap!
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1. Click on the box in front of Low Low Limit, Low Limit, High
Limit, and/or High High Limit, to display a visual alarm for
that parameter.

2. Click on the down arrow under Color to view the color palette.
Move your cursor over the color you want and click to select.

3. Enter the Set Limit  for each of the parameters.  They must
fall within the Range Minimum and Maximum set under
the General tab.

4. Choose the Needle Direction,  Clockwise or
Counterclockwise.

Click on the Digital Display Tab to Format the numbers  and
how they will be displayed on the Meter:

1. Click on the box in front of Digital Display if you want the
current register values to display on the meter.

2. Click on Justification and select from the following:  Leading
Zeroes, Leading Spaces, or Trailing Spaces.

3. Click on Total under # Digits. Here you will select how many
digits, from 1 to 10 (depending on the Data Type of the Tag),
that you want to display.

4. If you want Fractional Digits, enter 1 through 10 here (select
0 for none).  For example, if your maximum value is 999, you
would enter 3 under total digits.  If your maximum value is
99.9, enter 3 under Total Digits and 1 under Fractional Digits.

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Meter on the screen and size it.
• To size the Meter, select it, grab a handle and drag to the

size you want.
• To move the Meter, select it, click and hold left mouse button

and drag to where you want it to appear on the screen.
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Bar Graph ObjectBar Graph ObjectBar Graph ObjectBar Graph ObjectBar Graph Object
The Bar Graph object allows you to monitor and display a tag value in
a bar graph form on the screen.  The Bar Graph can be displayed in
various formats and can be programmed to read from top to bottom, left
to right, right to left, etc.

To put a Label  on the Bar Graph object, perform the following
steps:

1. Click on the box in front of Label Text if you want a label for
your object.

2. Use the UP/DOWN arrows after the Language box to select
a language number.  (See Language section, page 153.)

3. Select Character Size from the available choices.
4. Enter Label Text up to 40  characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

Enter a Tag Name:
1. Enter a Tag Name or click on the down arrow and select the

Tag Name from the available choices.
2. If the Tag Name is new, the Add New Tag Details dialog box

will appear where you will enter tag details. The Tag Name
will appear in the first field.  Enter an Address String
appropriate for your type PLC and select the Data Type (from
available choices). Click on the OK button.

NOTE:  To edit the Address
String, with your cursor in the
Tag Name field, click on the
right mouse button.  The EDIT
TAG DETAILS screen will
appear.
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Make the following selections to Format the Bar Graph:

1. If you want to show tick marks on your bar graph, click on box
in front of Show Ticks to enable.

2. Select where you want the tick marks to be on the graph; Left/
Top, or Right/Bottom. Select the Color of the tick marks.

3. Next select whether or not you want to show numeric values
for the tick marks, and the Number of Major Divisions
and the Number of Minor (Sub) Divisions to display. The
maximum ticks allowed for Major or Minor Divisions
is 20.

4. Select the Minimum and Maximum Range of the values
represented in the bar graph display. Ranges must be entered
in Decimal.

5. If you want a Bipolar bar graph, click on the box in front of
Bipolar and enter a Midpoint value.

6. Under Color, click on the down arrows next to Background,
Bar Foreground (fill) and Bar Background to view the
color palettes and make your selections.  Click on the box
below Blink to enable that feature.

Click on the Digital Display Tab to Format the numbers  and
how they will be displayed on the Bar Graph:

1. Click on the box in front of Digital Display if you want the
current register values to display on the bar graph.

2. Click on Justification and select from the following:  Leading
Zeroes, Leading Spaces, or Trailing Spaces.

3. Click on Total under # Digits. Here you will select how many
digits, from 1 to 10 (depending on the Data Type of the Tag),
that you want to display.

4. If you want Fractional Digits, enter 1 through 10 here (select
0 for none).  For example, if your maximum value is 999, you

Maximum Number for the
Major Divisions and Sub
Divisions is 20!
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would enter 3 under total digits.  If your maximum value is
99.9, enter 3 under Total Digits and 1 under Fractional Digits.

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Bar Graph on the screen and size it.
• To size the Bar Graph, grab a handle and drag to size you

want.
• To move the Line Graph, select it, click and hold left mouse

button, and drag to where you want it to appear on the
screen.
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Line Graph ObjectLine Graph ObjectLine Graph ObjectLine Graph ObjectLine Graph Object
The Line Graph object will continuously monitor specific Tags in the
PowerPanel Panel and display the value of these data tags as they
change over time.  This allows the panel to display the graph as soon as
the screen containing the graph is selected.  Up to 6 tags can be
monitored per line graph and up to 100 line graphs can be programmed.
Line graphs are unique in that most of the work is done for you.  The line
graph plots the tag values on a line as they change over a period of time.

To put a Label on the Line Graph object, perform the following
steps:

1. Click on the box in front of Label Text if you want a label for
your object.

2. Use the UP/DOWN arrows after the Language box to select
a language number. (See Language section, page 153.)

3. Select Character Size from the available choices.
4. Enter Label Text up to 40  characters.
5. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

Select the Background Color and the Axis/Tick Color from those
offered on the color palette.  To select a Color, click on the down arrow to
see the palette, and then simply click on the color swatch you want.

The Sample Rate for the Line Graph can be timed or triggered by an
event.

• Timed — how often, in Seconds, Minutes, or Hours the
line graph will update.  Enter this parameter next to Sample
Rate and select (per) Hour, Minutes or Seconds.
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• Triggered —- triggered by a bit that will be monitored to up
date the line graph. The trigger state conveys whether the line
graph will be updated when the monitor bit is on or off.  Select
the Tag Name for the monitor bit.  Select On State or Off
State.

Total # of Samples is the number of readings stored in the line graph
at one time. The maximum number of readings is 999. Sample per
Chart is the maximum number of readings that will be visible on the
chart. Use the arrow buttons on the object to view more of the chart.

Number of readings to average per sample:  You may choose to
have the graph average a number of readings in a sample and display
that sample average on a the chart. For instance, if you want to take
several temperature readings in an hour’s time and then have the graph
display this average as one sample on the chart.  Select a number between
1 and 255.

Click on the Pen tab to program the individual readings/lines:

1. Click on the down arrow to select the Tag Name for the
register you want Pen 1 (or 2, 3, 4, 5) to monitor and illustrate.

2. Select the Color and Line Type from the available choices.
3. Select the Language Number (1–9).
4. Click in the “Legend” field and type in the text you would like

to display in the legend for Pens 1 through 5. (The legend will
display the Color and Line type and what you enter in the Legend
field.) Limit the legend names to 16 characters (maximum).

5. Click on the box in front of Display Legend if you want the
legend to appear on the line graph object.

NOTE: The minimum
number of readings is two!

NOTE:  To edit the Address
String, with your cursor in the
Tag Name field, click on the
right mouse button.  The
EDIT TAG DETAILS screen
will appear.
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Click on the XY Axis tab to continue formatting your Line Graph:

The Line Graph is set up with the vertical axis (Y) representing the Tag
value (Value), and the horizontal axis (X) represents time (Readings)
.

Under X-Axis make the following selections:
1. Choose whether or not to Show Ticks for the X-Axis

(Reading). Click on the box in front of Show Ticks if you
want  them display on the object.

2. Enter the number of Major Divisions and the number of
Minor Divisions you want to display on the graph. 20 tick
marks are the maximum allowable for major and minor
divisions.

3. Choose whether or not to Show X-Axis Grid and Show
Tick Numbers.

4. Click in the box in front of Label if you want if you want a label
for the X-Axis.  Here you will enter the label Text and make
selections for the text Language number, and Color.

Under Y-Axis make the following selections:
1. Choose whether or not to Show Ticks for the Y-Axis (Value).

Click on the box in front of Show Ticks if you want them to
display on the object.

2. Enter the number of Major Divisions and the number of
Minor Divisions you want to display on the graph. 20 tick
marks are the maximum allowable for major and minor
divisions.

3. Choose whether or not to Show Vertical Grid and Show
Tick Numbers.

4. Click in the box in front of Label if you want if you want a label
for the X-Axis.  Here you will enter the label Text and make
selections for the text Language number, and Color.
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5. Under Range, click on Signed or Unsigned (they must
match Pen tag type — signed or unsigned.) Valid Ranges
will display for your selection.

6. Enter a Minimum and Maximum Range within the Valid
Range displayed.

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Line Graph on the screen and size it.
• To size the Line Graph, select it, grab a handle and drag to

the size you want.
• To move the Line Graph, select it, click and hold left mouse

button and drag to where you want it to appear on the
screen.

Not all of the line graph may be shown on the panel.  Use the ARROW
keys to scroll forwards and backwards along the graph.  Press the CLR
button to clear the readings displayed on the line graph.  Press the
STOP button to stop the line graph from displaying the current readings.
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PID Faceplate ObjectPID Faceplate ObjectPID Faceplate ObjectPID Faceplate ObjectPID Faceplate Object
In addition to a ladder logic program, some PLCs have process control
loop capability.  These PLCs use a Proportional Integral Derivative (PID)
algorithm to generate the control output value.  The PID Faceplate,
below, is an object that reads three controlled values of the PID loop and
displays them in the form of a bar graph.  This graph provides valuable
and timely process information, that allows the operator to take suitable
action at the appropriate time.

The PID Faceplate also monitors two discrete bits: Mode Bit and
Alarm Bit.  Mode Bit tells the operator whether the process is in Auto
Mode or Manual Mode. Alarm Bit tells the operator if any alarm for
the process is active or not.

Process Variable (PV) is the controlled variable in the process.  It is
the actual value measured.

Set Point (SP) is the theoretical perfect value of the Process Variable.
Output Variable controls the Process Variable.  Using PID algorithm, the
PLC calculates this value and uses it to keep the Process Variable as
close the to Set Point value as possible.

To put a Label on the PID Faceplate object, perform the following
steps:

1. Click on the box in front of Label Text if you want a label for
your object.

2. Use the UP/DOWN arrows after the Language box to select
a language number. (See Language section, page 153.)
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3. Select Character Size from the available choices.
4. Enter Label Text up to 40  characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

Under Process Variable/Set Point you will make the following
selections:

1. Select the Tag Name for Process Variable that will monitor
the process.

2. Select the Bar Color and Background Color for the Process
Variable as displayed on the PID Faceplate object.

3. Select the Tag Name for the Set Point.
4. Select the Bar Color and the Background Color for the Set

Point as displayed on the PID Faceplate object.
5. Select the Minimum and Maximum Range for the bar graph.

Under Output you will make the selections for the output as
displayed on the PID Faceplate object:

1. Click on the down arrow to reveal Tag Names and make your
selection.

2. Enter the Minimum and Maximum ranges for the Output
bar graph display.

3. Choose the Color for the Bar and Background.
4. The PID Faceplate monitors two discrete bits:

• Mode Bit tells the operator whether the process is in Auto
Mode or Manual Mode.  Enter the tag name for the discrete bit
to be monitored for Mode. ON= Manual, OFF = Auto

• Alarm Bit tells the operator if any alarm for the process is
active or not.  Enter the tag name for the discrete bit to be
monitored for active alarms. ON = Alarm, OFF = no display

NOTE:  To edit the Address
String, with your cursor in the
Tag Name field, click on the
right mouse button.  The
EDIT TAG DETAILS screen
will appear.
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Click on the Legend tab to make your selections for the Legend
that will display on the object:

1. Under Output , select the Language number for the Legend
text you want to enter.  You may program up to 9 different
languages to display on the legend.

2. Type in the text for the Legend.
3. Under Alarm, select the Text and Background Color.
4. Select the Language number, and type in the text you want

to appear for the Legend.
5. Under Mode, select the Text and Background Color.
6. Select the Language number for Auto and Manual.
7. Type in the Legend text for Auto and for Manual that you

want to appear on the object

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place PID Faceplate object on the screen and size it.
• To size the object, select it, grab a handle and drag to the

size you want.
• To move the object, select it, click and hold left mouse button

and drag to where you want it to appear on the screen.
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The Dynamic Bitmap object allows you to create simple to complex
objects.  You can use the extensive built-in Symbol Factory library to
copy and paste hundreds of graphic objects directly to the project
screen.  They can be arranged and positioned in just about any manner
you prefer.  And it’s not just bitmaps —you can import a Bitmap (.BMP)
file, a Windows Metafile (.WMF), or a Enhanced Windows Metafile (.EMF).

A Dynamic Bitmap can show a visual representation of a process.
There are two bitmaps per object, one that is shown when a bit is ON
and another that is displayed when the bit is OFF.  For example, you
could create a green blower and a red blower to display.  If the process
is running, the green blower would be shown.  If the process is not
running, the red blower would be displayed.

To put a Label on the Dynamic Bitmap object, perform the
following steps:

1. Click on the box in front of Label Text if you want a label for
your object.

2. Use the UP/DOWN arrows after the Language box to select
a language number.  (See Language section, page 153.)

3. Select Character Size from the available choices.
4. Enter Label Text up to 40  characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

Dynamic Bitmap ObjectDynamic Bitmap ObjectDynamic Bitmap ObjectDynamic Bitmap ObjectDynamic Bitmap Object

NOTE: To size a bitmap when
it is placed on the screen,
grab a handle with your
mouse cursor and pull across
the screen until it is the size
you want.



9494949494

O
b

je
c

ts

MAN-UTICW-M

Programming Software User ManualProgramming Software User ManualProgramming Software User ManualProgramming Software User ManualProgramming Software User Manual

To create On Bitmap and Off Bitmap:

1. Enter a Tag Name or click on the down arrow and select the
Tag Name from the available choices.

2. If the Tag Name is new, the Tag Entry dialog box will appear
where you will enter tag details. The Tag Name will appear in
the first field.  Enter an Address String appropriate for your
type PLC. Click on the OK button.

3. Select Background color for Bitmaps. Click on the down
arrow to view the color palette.  Select the color for the
background of the Bitmap object.

4. Select whether or not you want to Display Frame around the
bitmap and whether or not you want the Background to be
Transparent.

5. Under On Bitmap or Off Bitmap (the On Bitmap is the one
that is triggered to display when the bit is ON, the Off Bitmap is
triggered to display when the bit is OFF)  you have three
choices. Click on Stretch to Fit if you want the ON bitmap
and/or OFF bitmap to automatically stretch to fit the object
when you have increased or decreased the object’s size on
the screen.

a.  Click on the Import Bitmap button and a window will
appear allowing you  to navigate to the directory/folder where
the graphic file resides. Click on it to highlight and click on the
Open button. The File Name and Size of the Bitmap will be
displayed.  If the Bitmap is too large, you will be warned by a
message and prompted to select another bitmap.

NOTE:  To edit the Address
String, with your cursor in the
Tag Name field, click on the
right mouse button.  The
EDIT TAG DETAILS screen
will appear.

PLEASE NOTE:
You can import  three
different graphic file formats:
a Bitmap file (.BMP), a
Windows Metafile (.WMF), or
an Windows Enhanced
Metafile (.EMF.)

PLEASE NOTE:
(IMPORT BITMAP option)
To size a Bitmap once it has
been placed on the screen,
click on it to select, grab
one of the handles and
drag to the size you want.

PLEASE NOTE:
(SYMBOL FACTORY option)
To SIZE a symbol in Symbol
Factory, go to Options in the
Symbol Factory when
selecting the symbol. (See
instructions on page 129.)
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b.  You may also click on Symbol Factory® to gain access to a
library of over 3,000 symbols for industrial automation,
including pumps, pipes, valves, tanks, mixers, motors, ducts,
electrical symbols,  flow meters, material handling, sensors,
PLCs, transmitters, and ISA symbols.  Once in Symbol Factory,
navigate to the symbol you want to import, click on Copy and
the symbol is automatically imported into the object.

c.  The third option is to click on Copy from Clipboard.  This
will copy a bitmap you have saved to the clipboard onto the
current screen.  You can copy a bitmap saved or created in
another program onto the system clipboard, and then import it
inot the current screen.

Visibility/Details  (See Button Object.)

Simulate Press
Press the Simulate Press button to see how the Dynamic Bitmap
object will be displayed on the screen when pressed.

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Dynamic Bitmap on screen.

For more information about the Symbol Factory®, see page 160, in this
manual — or better yet, click on Symbols on the main menu bar within
the PowerPanel Programming Software and browse through the over
3,000 symbols to see for yourself what is available (and how easy it is)
to use in building dynamic PowerPanel screens!
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Change Screen ObjectChange Screen ObjectChange Screen ObjectChange Screen ObjectChange Screen Object
This object will allow the PowerPanel to change to (display) another
Screen.

To put a Label on the Change Screen object, perform the
following steps:

1. Click on the box in front of Label Text if you want a label for
your object.

2. Use the UP/DOWN arrows after the Language box to select
a language number. (See Language section, page 153.)

3. Select Character Size from the available choices.
4. Enter Label Text up to 40  characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

To Create the Change Screen Button object:
1. Select the Style of the button from the available choices.
2. Click in the empty field next to Go To Screen and type in the

name of the screen or click on the down arrow for a list of
screens in the project and select.

3. Select the Language Number (1–9) for the Text that will
appear within the button.

4. Type in the Text that you wish to appear within the button.
5. Select Character Size from the available choices.
6. Select the Color of the Text and the Background (inside

the button) from the available choices.
7. Click in the box under Blink if you want the Text or

Background to blink.
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Protection  (See Button Object.)

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Change Screen Button on the screen and size it.
• To size the button, select it, grab a handle and drag to the

size you want.
• To move the button, select it, click and hold left mouse

button and drag to where you want it to appear on the
screen.
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Alarm History ObjectAlarm History ObjectAlarm History ObjectAlarm History ObjectAlarm History Object
The Alarm History Object allows  you to configure a button, that
when pressed, will provide the Alarm Count or Alarm History.  Alarm
Details are accessed through the Alarm History object. Alarms are set
up in the Alarm Database (see page 140 for setup instructions.)

The Alarm Count lists all alarms and shows the total count for each
alarm.

The Alarm History will show each alarm that has occurred with the
most recent at the top.  When you press the Alarm Detail button, you
will get the Entry Number (No.) of the Alarm, when it was activated (time
and date), when it was cleared, actual value, high/low limits, and which
limit is tripped (HIGH/LOW/DIS).

To put a Label on the Alarm History object, perform the
following steps:

1. Click on the box in front of Label Text  if you want a label for
your object.

2. Use the UP/DOWN arrows after the Language box to select
a language number. (See Language section, page 153.)

3. Select Character Size from the available sizes.
4. Enter Label Text up to 40 characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

Under Display Screen, you will choose which alarm screen you want
to display when the Alarm History button object is pressed — Alarm
History or Alarm Count.  It should be noted that you can switch from one
to the other from either screen.

PLEASE NOTE: The steps
necessary to program your
PowerPanel to monitor the
PLC for errors and trigger an
alarm are provided in
Appendix A, Troubleshooting,
“How do I Log and Display a
PLC Error Message?”

NOTE:  An active alarm will
be displayed across the bottom
of the panel screen.  To see a
history, use the Alarm History
object.
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Under Text, choose the Language, Character Size, Color of Text
and Background, and whether or not you want to enable the Blink
feature for the text that will appear within the Alarm History button.
Enter the Text  that you want to appear.

Protection  (See Button Object.)

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Alarm History Button on the screen and size it.
• To size the button, select it, grab a handle and drag to the

size you want.
• To move the button, select it, click and hold left mouse

button and drag to where you want it to appear on the
screen.
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System ObjectsSystem ObjectsSystem ObjectsSystem ObjectsSystem Objects
Increment/Decrement Hour
The Increment/Decrement Hour object allows you to place a button on
the screen that allows you to adjust the hour (up or down) of the internal
Real-Time clock.

 To Create Label Text, perform the following steps:
1. Click on the box in front of Label Text if you want a label for

your object.
2. Use the UP/DOWN arrows after the Language box to select

a language number.
3. Select Character Size from the available choices.
4. Enter Label Text up to 40  characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

Choose the function of the button:
Select Increment or Decrement for the button function.  If increment
is selected, when pressed it will increase the time on a clock object by
one hour.  If decrement is selected, when pressed it will decrease the
time on a clock object by one hour.

Enter Text for the button object:
Choose the Language, Character Size, Color of Text and
Background, and whether or not you want to enable the Blink feature
for the text that will appear within the button and/or the background.
Enter the Text that you want to appear.

IMPORTANT NOTE:
This object is to be used with
the Internal clock, only. Do
not use the Increment/
Decrement object if you have
chosen External clock under
Project Attributes > Clock.
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Protection  (See Button Object.)

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Increment/Decrement Clock Button on the screen and
size it.

• To size the button,  select it, grab a handle and drag to the
size you want.

• To move the button, select it, click and hold left mouse
button and drag to where you want it to appear on the
screen.

Activate Screen Saver
The Activate Screen Saver object allows you to place a button on the
screen that enables you to activate the panel screen saver. (Screen Saver
time-out is programmed under Setup > Project Attributes > General Tab
> Display Saver.)

To put a Label on the object, perform the following steps:
1. Click on the box in front of Label Text if you want a label for

your object.
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2. Use the UP/DOWN arrows after the Language box to select
a language number. (See Language section, page 153.)

3. Select Character Size from the available choices.
4. Enter Label Text up to 40  characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

Enter Text for the button object:
Choose the Language, Character Size, Color of Text and Background,
and whether or not you want to enable the Blink feature for the text that
will appear within the button.  Enter the Text that you want to appear.

Protection  (See Button Object.)

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Screen Saver Button on the screen and size it.
• To size the button,  select it, grab a handle and drag to the

size you want.
• To move the button, select it, click and hold left mouse

button and drag to where you want it to appear on the
screen.
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Adjust Contrast
Use the Adjust Contrast object to place a button on the PowerPanel
screen that gives you access to the panel's adjust contrast feature.
Use the UP and DOWN arrows that appear on the button to adjust the
screen contrast.  The current setting will appear on the button above the
arrows and will change as you press the arrow keys.

To put a Label on the Adjust Contrast object, perform the
following steps:

1. Click on the box in front of Label Text if you want a label for
your object.

2. Use the UP/DOWN arrows after the Language box to select
a language number. (See Language section, page 153.)

3. Select Character Size from the available choices.
4. Enter Label Text up to 40  characters.
5. Select the Position of the label, whether you want it to appear

at the Top or the Bottom of the object frame.
6. Select the Text and Background Color.  Click on the down

arrow to view the color palette.

Select Digit Format:
This allows you to program characteristics of the current contrast setting
that will display on the button.  The current setting will appear on the
button above the UP and DOWN arrows.  Use the arrows to increment
or decrement the setting.  Select the Size and Color of the characters
(Text) and whether or not they will Blink, and set the color of the button
Background and whether or not it will Blink.

Protection  (See Button Object.)

Visibility/Details  (See Button Object.)

NOTE:  Contrast cannot
be adjusted on 10-inch
PowerPanels.
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OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Adjust Contrast Button on the screen and size it.
• To size the button, select it, grab a handle and drag to the

size you want.
• To move the button, select it, click and hold left mouse

button and drag to where you want it to appear on the
screen.

Select Language
The Select Language object allows the operator to change the
Language by pressing a button on the PowerPanel.  Text that has been
programmed for that language will convert to the language that the
operator selects.  If an object's text has not been programmed for the
language selected, it will default to Language 1.

To put a Label on the Select Language object, perform the
following steps:

1. Click on the box in front of Label Text if you want a label for
your object.

2. Use the UP/DOWN arrows after the Language box to select
a language number.  (See Language section, page 153.)

3. Select Character Size from the available choices.
4. Enter Label Text up to 40  characters.
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5. Select the Position of the label, whether you want it to appear
at the Top or the Bottom of the object frame.

6. Select the Text and Background Color.  Click on the down
arrow to view the color palette.

Select Language that you want to switch to.

Languages are named under Setup > Project Attributes > Language tab.

Enter Text for the button object:
Choose the Language, Character Size, Color of Text and Background,
and whether or not you want to enable the Blink feature for the text that
will appear within the button.  Enter the Text that you want to appear.

Protection  (See Button Object.)

Visibility/Details  (See Button Object.)

OK/Cancel/Help Buttons
• Click on OK button to save your selections and exit the

dialog box.
• Click on Cancel button to exit the dialog box without saving

your selections.
• Click on Help button to go to the Help Topic for that dialog

box.

Place Select Language Button on the screen and size it.
• To size the button, select it, grab a handle and drag to the

size you want.
• To move the button, select it, click and hold left mouse

button and drag to where you want it to appear on the
screen.
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In this chapter....
— Title Bar
— Main Menu Bar
— Standard Tool Bar
— Object Tool Bar
— Draw Tool Bar
— Panel Tool Bar
— Status Bar
— 3 Easy Steps
— Programming Screen
— Project Screens Explorer View

55555



108108108108108

M
ai

n
 P

ro
g

ra
m

m
in

g
 S

cr
ee

n

Programming Software User ManualProgramming Software User ManualProgramming Software User ManualProgramming Software User ManualProgramming Software User Manual

The Main Programming Screen is shown above.  It is here that you will
design your PowerPanel operator interface screens. In this section,
we’ll briefly identify and describe the main features of this screen and
familiarize you with the PowerPanel Programming Software work area.

Title BarTitle BarTitle BarTitle BarTitle Bar
The Title Bar tells you the name of the project and name and number
of the screen that you currently have open.

Main Programming ScreenMain Programming ScreenMain Programming ScreenMain Programming ScreenMain Programming Screen

Title Bar Main Menu Bar Standard Tool Bar Object Tool Bar

Draw Tool Bar

Panel Tool Bar

Status Bar

3 Easy Steps
Tool Bar

Project Screens
Explorer View
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Main Menu BarMain Menu BarMain Menu BarMain Menu BarMain Menu Bar
This is the Main Menu Bar.  PowerPanel Programming Software menus
are represented by the names listed across the top of the Main
Programming Screen and directly under the Title Bar.   Each menu item is
discussed in detail in Chapter 6, Reference, beginning on page 115.

StandarStandarStandarStandarStandard d d d d TTTTTool Barool Barool Barool Barool Bar
The Standard Tool Bar consists of icons for frequently used
commands.  These commands are also found in, and accessible from,
the Main Menu Bar.

From left to right as placed on the tool bar, the icons and their functions
are shown below.

• Open Project

• Open Screen

• Save Screen

• Cut the selection and put it on the clipboard

• Copy the selection and put it on the clipboard

• Paste clipboard contents

•  Undo the last action or Redo the previously undone

action

• Project Screens Explorer View

• Print the active document

• Display program  information, version number, and copyright

• Display help for clicked on buttons, menus and windows

• Zoom to a predefined screen magnification

• Displays Grid on the Screen

• Snaps to Grid

• Show or Hide Touch Cells

• Show 320 x 240 Rectangle (size of 6-inch panel screen)
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• Aligns left sides of all the selected objects to that of left

most object

• Aligns all the selected objects to the vertical center of

screen

• Aligns right sides of all the selected objects to that of right

most object

• Aligns top sides of all the selected objects to that of top

most object

• Aligns all the selected objects to the horizontal center of

screen

• Aligns bottom sides of all the selected objects to that of

bottom most object

• Make all selected objects the same size

• Make all selected objects the same height

• Make all selected objects the same width

• Arrange windows so they overlap

• Arrange windows as non-overlapping tiles

• Shows Tag Database

Object Object Object Object Object TTTTTool Barool Barool Barool Barool Bar
The Object Tool bar consists of icons that provide a shortcut to the
predefined programming objects.  These objects provide generic panel
replacement functions.  Click on the icon to place the object on the screen
and set the object parameters.  These objects are also found in, and
accessible from the Main Menu Bar.

From left to right as placed on the tool bar, the icons and the object they
represent are shown below.

• Push Button

• Indicator Button

• Radio Button

• Switches

• Step Switch
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• Tri-State Switch

• Numeric Entry

•  Recipe

• Thumbwheel

• Indicator Light

• Numeric Display

• Static Text

• Triggered Text

• Lookup Text

• Dynamic Text

• Text Entry

• Analog Clock

• Digital Clock

• Meter

• Bar Graph

• Line Graph

• PID Face Plate

• Dynamic Bitmap

• Change Screen

• Alarm History

• Adjust Contrast

• Increment/Decrement Hour

• Activate Screen Saver

• Select Language
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DraDraDraDraDraw w w w w TTTTTool Barool Barool Barool Barool Bar
Any of the following draw functions can be accessed by choosing the
selection from the Draw Menu or by clicking on the specific Draw Tool
Bar icons shown below.

• Pointer

• Line

• Rectangle

• Circle

• Static Bitmap

PPPPPanel anel anel anel anel TTTTTool Barool Barool Barool Barool Bar
The Panel Tool bar consists of icons for frequently used commands.
These commands are also found in, and accessible from the Main Menu
Bar.  From left to right, they are as follows:

• Transfer to Panel

• Panel Information

• Display Screen

• Reboot Panel

• Panel Time and Date

• Diagnostics

Status BarStatus BarStatus BarStatus BarStatus Bar
The Status Bar is located at the bottom of the Programming Screen and
shows the status of the current screen.  It provides information about a
tool bar or menu item on the main programming screen that the pointer
passes over, displays the number of selected objects, the XY location
(coordinates) of the cursor, and the current programming mode (ONLINE
or OFFLINE).

NOTE:  The Panel Tool
Bar is for on-line editing.
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3 Easy Steps 3 Easy Steps 3 Easy Steps 3 Easy Steps 3 Easy Steps TTTTTool Barool Barool Barool Barool Bar
This tool bar appears on the right hand side of the main programming
screen.  It allows you to easily navigate to one of the three main steps
in creating a program for your PowerPanel using the PowerPanel
Programming Software. To open, click on Edit > Toolbar > 3 Easy
Steps.

Click on button number 1 to Exit Project to Information Screen.
You will exit your current project and return to the Step 1, Project
Information Screen.

Click on button number 2 to Design Your Screens.  The Open New
Screen dialog box will appear.  You can select from one of the current
project’s screens, or enter a new number and name to create a new
screen.  Click on this button to quickly go to another screen in your
project for editing, or create a new screen.

Click on button number 3 to Write Your Program to Panel. When
you are finished with the project, or want to test it on the PowerPanel,
select this button.  The Write Program to Panel Screen will appear
allowing you to transfer the current project to the panel memory.  Click
on this button to transfer your project to the PowerPanel.
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Programming ScreenProgramming ScreenProgramming ScreenProgramming ScreenProgramming Screen
This is the programming screen where you will build project screens
that will in turn be displayed on the PowerPanel.  You may program from
1 to 999 screens in a project.

These screens are used primarily to incorporate objects, messages,
and graphics.  Placing these items onto the programming screen allows
you to have input and control over what is being displayed on the panel.

Objects

Main Programming
Screen

(with “Show Touch
Cells” enabled)

PrPrPrPrProject Screens Explorer oject Screens Explorer oject Screens Explorer oject Screens Explorer oject Screens Explorer VieVieVieVieViewwwww
This view opens to show you the project screens that you have created
and to allow you to easily navigate between the screens.  If you click on
the “+” in front of Project Screens, the screens you have designed will
cascade in the window. (A “-” will display in front of Project Screens
indicating you have opened the Project Screens Explorer View.) To
open or switch to another screen in your project, double click on the
book icon in front of the screen.  Your programming window will display
the selected screen and the book icon will change to an “open” book to
show you that the screen is open in your project.

Right click your mouse anywhere
in the project screens window and
a popup menu will appear
allowing you to Open, Rename,
Delete, or add a New Screen.
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In this chapter....
— File Menu
— Edit Menu
— Screen Menu
— Draw Menu
— Panel Menu
— Setup Menu
—  Window Menu
— Help Menu
— Right Click Menus
— Symbol Factory
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File MenuFile MenuFile MenuFile MenuFile Menu

Open Project
To open an existing project or to create a new project while in a
programming window, click on File > Open Project.  The Step 1, Project
Information dialog box will appear.  Click on one of the SELECT ACTION
buttons. Choose from the available project files or enter a new Project
Name.  Click on OK to open the project, or Exit to quit without opening.

Close Project
Click on File>Close Project to quit the current project.

Save Screen
Click on File > Save Screen to save the current, active screen.

Save Project
Click on File > Save Project to save the current project.  Screens,
Project Attributes and databases will all be saved.

The Reference Section provides more details on Menu commands. It
takes you through the Main Menu Bar item by item, command by command,
with instructions.  It also contains information about the various tool
bars and the status bar.

ReferenceReferenceReferenceReferenceReference
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Copy Project As...
Click on File > Copy Project As...
to save your project under another
name. The dialog box shown to the
right  will appear allowing you to
enter a name for the copied project.

Save Project As Protected
If you click on Save Project As
Protected, you will only be able
to transfer the project, to and from
the panel, as is. The project will
not open in PowerPanel
Programming Software to allow
editing. This protects   the project
from unauthorized changes after
distribution.  Make sure you have
another copy saved if it will require
changes or updates.

Transfer to Panel...
Transfer to Panel... allows you to transfer the current (open) project
to the PowerPanel.

Click on Transfer to Panel and the following dialog box will open.  This
dialog box provides information about the current project and the
PowerPanel memory available.

Under Project Information, the screen provides you with the Project
Title you are about to transfer, the Panel Type you are transferring the
project to, and the PLC Type and Protocol that you have selected as
used by your application. Press Start to begin the transfer or Cancel to
abort.

DON’T LOSE AN EXISTING
PROGRAM!    When you write
the program to the panel, it will
write over any program already
loaded into panel.   Save the
existing program before you
click on the Start button to
transfer your new program. To
do this, exit project and Read
Program from Panel, then save
it to your PC.
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If you receive an error message, check to ensure your panel to PC
connections are correct.  Under Use PC Port, click on the down arrow
to select the correct PC Port (COM1, COM2, COM3, or COM4)

The Progress Bar will let you know where you are in the transfer
process and when the process is complete.

After the transfer is
complete, Panel
I n f o r m a t i o n
gathered during
t r a n s f e r
communication is
displayed. It will tell
you the Total Memory installed in your panel (in bytes) and the Free
Memory available after the project upload.  The panel Firmware
Revision (internal software) number is displayed and whether or not
a Panel to PLC Link is established.

Print

When you click on the Print menu item, the screen, above, will appear.
Select Items for Printing —  Choose Print Alarm Database, Print
Tag Database (select Sort by Tag Name or Sort by Tag Address),
or Print Message Database.  If you want to Print Screens, select
All Screens to print all of the screens from the project, or Selected
Screens to print selected screens from the list.  Click on a screen in
the list to highlight it.  Press and hold the Ctrl key and click to select
more than one.  Click on OK when you have made your selections.

Print Setup
Choose or change your print settings here.

Exit
Click on Exit to quit the program.

Be sure to select screens
(click on them to
select) here — if you
choose Selected
Screens here!
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Edit MenuEdit MenuEdit MenuEdit MenuEdit Menu

Undo
The Undo command is used to reverse the previous action.  This function
must be performed next in order for the action to be undone.  The undo
command goes back sixteen levels of undo.  Redo will "redo" the
previously undone action.

Cut
This allows you to Cut (remove) a selected item(s) to the clipboard.

Copy
This allows you to Copy (without removing) a selected item(s) to the
clipboard.

Paste
This allows you to Paste a selected item from the clipboard onto the
displayed screen.

Select All
Click on Select All to select all items on the displayed screen.

Align
This allows you to Align selected items on the screen.  You may also
execute these commands by clicking on their respective icons on the
standard tool bar. You must have at least two objects selected in order
to execute the Left, Right, Top, or Bottom Align commands.

Left— Aligns left sides of all the selected objects to that of left
most object
Vertical Center— Aligns all the selected objects to the vertical
center of screen
Right — Aligns right sides of all the selected objects to that
of right most object
Top — Aligns top sides of all the selected objects to that of
top most object
Horizontal Center — Aligns all the selected objects to the
horizontal center of screen
Bottom — Aligns bottom sides of all the selected objects to
that of bottom most object
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Delete
Click on Delete to remove a selected item without placing it on the
clipboard.

Edit
Select an object and then click on the Edit command to make changes
to an object's characteristics.

Tool bar
Click on Tool bar to see menu.  Click on Standard, Object, Draw,
Panel, 3 Easy Steps (Navigation Tool bar), or Project Screens
(Explorer View) to place a check mark enabling that tool bar, or click on
a selected tool bar to remove check mark and thereby remove it from
view. All tool bars, except 3 Easy Steps, are displayed by default.

Current Editing Language

Allows you to select  the
Current Editing Language.
Click on down arrow to view
list of languages.

Default Tag Data Type

Click on this menu item to
set the Default Tag Data
Type.  Click on the down
arrow to view the list of
data types.
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Screen MenuScreen MenuScreen MenuScreen MenuScreen Menu

New Screen
Enter a screen Number and a Title for the New Screen.  Click on
Open to display the new screen or Cancel to exit without saving the
new screen.

Open Screen
The Open Screen command brings up the dialog box shown below.
Click on the screen in the Screen List that you want to open and then
click on the Open button.
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Rename Screen
This dialog box allows you to Rename an existing screen in your project.

1. Select the screen you wish to change from the Screen List.
2. Click in the Title box and change the title to the new name.
3. Click on the Rename button.  Your screen will be renamed

to the Title you have entered.

Delete Screen
Click on the screen(s) you want to delete from the project, and then
press the Delete button.
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Grid Size

When you click on Grid Size on the Screen Menu, the dialog box shown
above will appear, allowing you to adjust the spacing between the grid
points.  You may want to adjust to a character size, touch cell size or
specific values.  The size range is 3 to 100 (you will not be allowed to
enter a value outside these parameters.) From here you may enable the
Show Grid and the Snap to Grid features.

To adjust the grid size:

1. Type in a value in the box after Horizontal and Vertical Grid
Size, or click on the Set to TouchPad Size to set the grid to 40
by 40.  40 pixels by 40 pixels is the size of a single touch cell
on the PowerPanel and is the minimum size for any touch
object.

2. Click OK to exit and save settings, or Cancel to exit without
making any changes.

Display Grid
The Display Grid function is the display equivalent of graph paper.
Represented by a series of dots, the grid helps you align your drawings
and objects and make them more precise.

There are three ways to enable this function:

1. Click on the  icon in the Standard Tool bar.

2. Right click on an empty area of the screen window.  The menu
shown to the left will appear. Click on Display Grid.

3. From the Main Menu Bar, click on Screen>Display Grid.
(You can also activate this feature from the Grid Size dialog
box, described above.) A check mark will appear to show you
that it is enabled.  Click on it again to hide the Grid.

Snap to Grid
Snap to Grid attaches lines, rectangles, circles and other drawn objects
to grid points as they are drawn.  Objects placed on the screen will align
with the grid also.

Click here to Display Grid
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There are three ways to enable this function:

1. Click on the  icon in the Standard Tool bar.

2. Right click on an empty area of the screen window. The menu
shown to the left will appear.  Click on Snap to Grid.

3. From the Main Menu Bar, click on Screen > Grid Size.  A
dialog box will appear.  Click on the box in front of Snap to
Grid. (You can also activate this feature from the Grid Size
dialog box, described on the previous page.) A check mark
will appear to show you that it is enabled.  Click on it again to
disable snap feature.

Description (Screen)
Click on this menu item to view, enter, or edit a description of the current
screen  You may enter up to 400 characters.  When you print this screen,
the description you have entered here will appear on the printed page
beneath the picture of the screen.

Screen Background
Color
This feature allows you to
change the color of your
Screen Background.  Click
on  the down arrow to view
the color palette. Move the
pointer over the color
swatches to view the color of
the background on your
current screen. Click on the
color you want to select.

Click here to Snap to Grid
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Show Touch Cells
Click on Show Touch Cells and a grid will appear on the screen
representing the touch cells on your size screen.  This makes it easier to
place your objects directly over touch cells.  Click on this menu item
again to disable.

Show 320x240 Rectangle

Click on this menu item or the   icon to show a 320 x 240 area on
your 8-inch or 10-inch programming screen.  The 320 x 240 area depicts
the size of the 6-inch PowerPanel screen.  This is useful when designing
screens for more than one panel size.

Objects MenuObjects MenuObjects MenuObjects MenuObjects Menu

Because objects are the main screen creation tool inBecause objects are the main screen creation tool inBecause objects are the main screen creation tool inBecause objects are the main screen creation tool inBecause objects are the main screen creation tool in
the project, a section of this manual is dedicated tothe project, a section of this manual is dedicated tothe project, a section of this manual is dedicated tothe project, a section of this manual is dedicated tothe project, a section of this manual is dedicated to
explaining each object in detail.  For information aboutexplaining each object in detail.  For information aboutexplaining each object in detail.  For information aboutexplaining each object in detail.  For information aboutexplaining each object in detail.  For information about
an object seen on the menu to your left, see thean object seen on the menu to your left, see thean object seen on the menu to your left, see thean object seen on the menu to your left, see thean object seen on the menu to your left, see the
OBJECTS chapter of this manual on page 37.OBJECTS chapter of this manual on page 37.OBJECTS chapter of this manual on page 37.OBJECTS chapter of this manual on page 37.OBJECTS chapter of this manual on page 37.

with Show Touch Cells selected

Zoom

Click on Zoom
 

 to
view your screens at
preset magnifications.
Select from the available
magnifications.  Use the
scroll bars to the right and
bottom of the screen to
view another area of the
screen.
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Draw MenuDraw MenuDraw MenuDraw MenuDraw Menu

Line
The Line draw tools allows you to draw a line.

To draw a Line:

1. Click on the Line icon   on the tool bar or select Line from
the Draw Menu.

2. A dialog box will appear allowing you to select the color and
type of line to draw.

3. Click on the box following Draw Horizontal/Vertical to limit
the line draw to horizontal and vertical lines.All lines will
automatically be drawn either up and down (vertically), or
across the screen (horizontally).

4. Select a point on the screen with the pointer and click the left
mouse button.  Move the mouse to draw the line.  When
you've completed the line, click the button again to terminate
the segment.

Rectangle
This Draw tool allows you to draw a Rectangle

To draw a Rectangle:

1. Click on the Rectangle icon   on the tool bar or select
Rectangle from the Draw Menu.

2. A dialog box will appear allowing you to select the outline and
the fill color.

3. Select a point on the screen with the pointer and click the left
mouse button to locate the first corner of the rectangle. Pull
the box with the mouse to the size you want and release the
mouse button to set the box size.

Circle
The Circle Draw tool allows you to draw a circle.

To draw a Circle:

1. Click on the Circle icon  or select Circle from the Draw
Menu.

2. A dialog box will appear allowing you to select the outline and
fill color of the circle.

Note: To toggle between
horizontal/vertical lines and
diagonal lines, you may press
F8 on your keyboard.
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3. Select a point on the screen with the pointer and click the left
mouse button to locate the starting point of the circle.  Pull the
circle with the mouse to the size you want and release the
mouse button to set the perimeter size.

Static Bitmap
This object allows you to import a bitmap and place it on the screen.

To place a Bitmap on the screen:

1. Click on the Static Bitmap icon  or select Static Bitmap from
the Draw Menu. The following dialog box will appear.

2. There are 3 options for importing a bitmap:

a.  Click on the Import Bitmap button and a window will
appear (shown below) allowing you  to navigate to the
directory/folder where a Bitmap (.BMP), Windows Metafile
(.WMF), Windows Enhanced Metafile (.EMF) file resides. Click
on it to highlight and click on the Open button. The File Name
and Size of the graphic file will be displayed.  If the graphic file
is too large, you will be warned by a message and prompted to
select another file.

IMPORTANT NOTE:
(IMPORT BITMAP option) To
size a Bitmap once it has been
placed on the screen, click on
it to select, grab one of the
handles and drag to the size
you want.

IMPORTANT NOTE:
(SYMBOL FACTORY option)
To SIZE a symbol in Symbol
Factory, go to Options in the
Symbol Factory when selecting
the symbol. (See instructions
on page 129.)
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b.  You may also click on Symbol Factory® to gain access to
a library of over 3,000 symbols for industrial automation,
including pumps, pipes, valves, tanks, mixers, motors, ducts,
electrical symbols,  flow meters, material handling, sensors,
PLC's, transmitters, and ISA symbols.  Once in Symbol Factory
navigate to the symbol you want to import, click on Copy and
the symbol is automatically imported into the object. (See next
page, 129, for sizing a bitmap in Symbol Factory.)

c.  The third option is to click on Copy from Clipboard.  This
will copy a bitmap you have saved to the clipboard onto the
current screen.  You can copy a bitmap saved or created in
another program onto the system clipboard, and then import it
into the current screen.

3. Click OK to import the bitmap, or Cancel to quit.
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Sizing a Bitmap in Symbol Factory

Double click on the Static Bitmap symbol already
placed on the screen to change the size (resize
object).  The screen to the right will appear.  Click
on Symbol Factory button.

The Symbol Factory screen to the
right will appear.

Click on the Options... button.

When picture symbols are exported
as bitmaps, they are exported at the
size of the Preview window. If you
need a larger bitmap, you can
increase the Export Scale Factor
from 1X to 10X  from the Symbol
Options screen. Fine adjustment of
the exported bitmap size can be done
by resizing the Preview window.  To
resize the Preview window, drag its
right or bottom edge.

From the Symbol Options screen,
click on the DOWN Arrow next to
Export Scale Factor under
Export Options.  Select the Scale
Factor (in this case 3X).  Click on OK.

You will be taken back to the Symbol
Factory screen shown to the right.  Click
on the Copy button.

This Symbol when
changed to a Scale
Factor of  3X will be
replaced with this
size symbol.

Sizing a Dynamic Bitmap
object in Symbol Factory
works the same way!

You will be taken back to the Static
Bitmap Screen (first screen capture
shown above, right), click on OK.

You will return to the PowerPanel
Programming Screen you were
configuring.  Your object will be scaled to
the size you have selected. If the
Scale Factor you have selected
is too large for the screen, you
will receive a warning message
and will not be allowed to import
the bitmap.  If this happens, select
a smaller Scale Factor.
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Panel Menu  (ONLINE editing only)Panel Menu  (ONLINE editing only)Panel Menu  (ONLINE editing only)Panel Menu  (ONLINE editing only)Panel Menu  (ONLINE editing only)

The Panel Menu is available for online editing only.

Display Screen

This selection allows you to select a screen to display on the PowerPanel.
To display a screen, enter the number or click on the name in the Screen
List to highlight it, and then click  on the Display button.

Information

Click for important information about the PowerPanel you are using and
your PLC.  Information includes:
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Revisions:
Hardware:  This is the revision of the PowerPanel unit.
Boot Software:  This is internal panel firmware used to
power-up the panel.
Exec Software:  This is also internal firmware, used to display
panel information and allow panel adjustments to the  internal
clock, Contrast adjustment, and testing of the Touch cells and
Display.

Memory (bytes):
Exec Flash:  This will let you know if the PowerPanel has a
Flash Memory card installed.  (It will say 0 if not installed.)
This feature allows you to back up your program from the
panel itself. There are two available memory sizes — 512K
and 1 MEG.  Once the program is backed up onto the card,
you can use it to load the program into different units — no
programming computer is necessary.
User Memory Flash:  This will let you know how much
FLASH memory you have available.
System Memory:  This tells you how much RAM memory
you have installed in your panel.
Driver Memory:  This is the PLC Driver memory that is
available.
User Program:  This is the size of the program that you
currently have loaded into your PowerPanel.
Free Memory: This is the RAM memory that you have left to
use in the PowerPanel.
User Memory:  This is the total RAM Memory available for
use in the PowerPanel.

PLC Driver:
PLC Manufacturer, PLC Model, PLC Driver Code
Revision:  This provides information about the type of PLC
you are using.

Panel Name:  A description of the panel model is provided.

Option Board:
Option Board Type: This tells you if you have an option
board installed and the type.
Hardware Revision: Current hardware (board revision)
Software Revision:  Current software.

Reboot
Click here to reboot the PowerPanel.

Clear Program
Click here to Clear the current user program from the panel.
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Flash

Click on RAM to Flash to copy RAM memory to Flash card.  This will
transfer the user program loaded on your panel to the Flash Card.
Flash card may then be removed and installed into another panel to
transfer to the RAM.  You may also backup your user program to save
it before shutting off power to the panel.  You may then reinstall the
program later.

Click on Flash to RAM to copy the contents of the Flash card to the
panel RAM memory.  This is used to copy the user program from one
panel to another or to reinstall a program to the panel.

Update PLC Driver
Click on this to update your PLC Driver.  This will send the current PLC
Driver code to your panel (other project information is not sent.)

Time/Date
Here you may view and set the
Panel Time and Date and then
send it to the PowerPanel.  The
current Panel Time and Date will
display in the window.  Under
Set Panel Time and Date, your
PC time will display.  To change
the Time, click on the hour,
minutes or seconds and type in
the appropriate numbers or use
the UP/DOWN arrows to change
the time.

PLC DRIVER CODE onlyPLC DRIVER CODE onlyPLC DRIVER CODE onlyPLC DRIVER CODE onlyPLC DRIVER CODE only
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To change the Date, click the DOWN arrow next to the date field.  A
calendar, shown below, will appear.  Use the arrows to search for date.
(The current PC date will be circled.)  Click on the Send to Panel button
to send your changes to the PowerPanel clock.

Diagnostics
To run a diagnostic program on the panel, click here.  The following
screen will appear, letting you choose from Test RAM and Test Flash.
Click OK to begin diagnostic.

When you click on OK, you will receive the following “warning”
message.  Save program to disk before testing the panel memory!
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Setup MenuSetup MenuSetup MenuSetup MenuSetup Menu

Tag Database

The Tag Database is where you define the Tags for your project.  A
Tag can be a discrete (single bit) location or word location within the
PowerPanel.  Tags may be either Internal (no address) or External
(PLC Address).  In other words, a Tag is an alias for a PLC address or
an Internal panel location that an object is communicating with.

PLC Model/Manufacturer
The model and manufacturer of the PLC used in the project is listed at
the top of this dialog box.

Number of PLC tags, Number of internal tags, and Total Tags
The number of PLC and internal tags that are currently programmed in
the project are provided.  Also provided is the combined total of both
kinds of  tags.

Highlight Internal Tags
This is enabled by default. Click on the box with the check mark to
deselect this option.  When it is selected the internal tags in the list will
be displayed in blue.

Highlight Unused Tags
Click in the box in front of Highlight Unused Tags to enable this option.
The tags that are not currently linked to an object or attribute are
highlighted in the list. The unused tags are highlighted in yellow.
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Tag #
This is the number of the Tag in the list.

Tag Name
You may enter a descriptive Tag Name of up to 40 characters.

Data Type
This is the format of the data.  Select the Data Type that is appropriate
for your type PLC. Choose from DISCRETE, SIGNED_INT_16,
SIGNED_INT_32, UNSIGNED_INT_16, UNSIGNED_INT_32, BCD_INT_16,
BCD_INT_32, FLOATING_PT_32, and ASCII_STRING.

PLC Address
The syntax for entering PLC addresses depends on the type of PLC.  A
message (similar to the one shown to the left) will display letting you
know if the PLC Address type and Tag Data Type don’t match or if the
Address is invalid.

Number of Characters
If the Tag will read a character (ASCII) string from the PLC or write a
character string to the PLC, you will need to enter the number of
characters here.  Each PLC register can contain 2 characters.  You may
enter up to 40 characters.  The PLC will assign the correct number of
sequential registers needed for the string.  The address you have entered
for the tag is the starting address. See Appendix B for a list of ASCII
characters supported by the PowerPanel.

Add/Edit Button
Click on this button to Add a new tag, or Edit an existing tag.

To Add a New Tag:

1. Click on Add/Edit button.   (If you have existing tags, ensure
that none are highlighted or you will go to the edit tag window.)
The following screen will appear.

PLEASE NOTE: If your panel
is connected to multiple PLCs,
see Mapping Tags in the Help
file for your PLC Type.
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2. Click in the field next to Tag Name and enter a name for the
tag.

3. Click on the DOWN arrow next to the Tag Data Type field and
select the data type from the list.

4. Enter a PLC Address, or leave blank if it is an Internal Tag.

5. If you have selected ASCII String as your Data Type, the #
of Characters field will become available.  Enter or select the
number of characters (up to 40) for the ASCII String.

6. Click on the Add New Tag button.  The new tag will appear in
the Tag Database list.

To edit an existing tag:

1. Highlight the tag in the list that you wish to edit.

2. Click on the Add/Edit button.  The following screen will appear.

3. Make any changes and then click on the Apply Tag Changes
button.  The changes will be made to the tag and are reflected
in the Tag Database list.

To sort the Tag Database list:

1. Right click your mouse while your cursor
resides anywhere in the Tag Database
list.  The popup menu to the right will
appear.

2. From here you may Add, Edit, or Delete
a tag.  You may also choose to sort the
list by Address, Tag Name, or Data
Type.

The message shown above will
appear after you have clicked on
the Add New Tag button.  Click on
Yes if you have another tag to add
to the database or click on No if
you are finished adding tags.

When adding a new tag and you
click on the close buttons dialog
box, BEFORE you click on the Add
New Tag button, the message
shown above will appear, allowing
you to return to the tag or exit the
dialog box without saving the tag
to the database.
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If you click on Sort by Address, the list will be sorted alpha-numerically
by the PLC address.

If you click on Sort by Tag Name, the list list will be sorted alphabetically
(A to Z) by the name of the tag.

If you click on Sort by Data Type, the tag list will be sorted by Data
Type.  For tags with same data type, it will perform a second sort by the
address.

Tag Cross Reference

The Tag Cross Reference screen provides you with a list of the
programmed tags and a cross reference to the objects that use them.
Information is provided on the PLC Name (type and protocol) at the top
of the screen.  Tag Names are listed alphabetically.  Click on the arrow
to scroll to a particular tag name. Information on the Address, Data
Type, I/O Type and Number of Alarms programmed to the tag is
given.

In the Object List you are provided with the objects or Project Attributes
that use the selected Tag. The Object Type,Tag Type in Object, and
the Screen Name of where the Object appears is listed in the window.
To view specifics for each Tag, go to the Tag Name field, click on the
DOWN arrow, and select one from the drop down list.

NOTE:  The Tag Cross
Reference screen is for
information purposes only.
You cannot change or edit
the tag parameters from this
window.
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Export Tags
Click on the Export Tags menu item to write the tags from your current
(open) project to an Excel file or a CSV file.

Comma delimited...
The CSV (Comma delimited or Comma-separated values) file format
saves only the text and values as they are displayed in cells of the Tag
Database. All rows and all characters in each cell are saved. Columns
of data are separated by commas, and each row of data ends in a
carriage return. If a cell contains a comma, the cell contents are enclosed
in double quotation marks.

Example of what a CSV file looks like opened in Notepad:

NUMERIC ENTRY,BCD_INT_16,V02002,
NUMERIC DISPLAY,BCD_INT_16,V02003,
BUTTON OBJECT,DISCRETE,C0000,
INDICATOR LIGHT,DISCRETE,C0001,

Click on Comma delimited... if you want to save the tag database as
a .CSV file. The following window will appear allowing you to name the
file and navigate to the directory and folder where you want to save it.

To Excel...
Click on the To Excel... menu item to write the tags from your current
(open) project to a Microsoft Excel® file.  The PowerPanel Programming
Software will open Microsoft Excel and write the tags to an Excel book
as shown on the next page. Click on File >Save As in the Excel program
and enter a name for the file. Click on the Save button to save the file
under the name you have entered. Close Excel to return to PowerPanel
Programming Software.

A status window will appear
letting you know the progress of
the Exporting Tags process.
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Microsoft Excel opens
with exported tags
written to the book.

Click on File > Save As,
navigate to directory/
folder where you want to
save the Tag Database
as an Excel file.

The first line is a header
line.   Tag Name, Tag
Data Type, Tag Address,
and # of Characters (if
applicable) are listed for
each tag in the project
database.

A message will appear
letting you know whether
or not the export was
successful and how
many tags were
exported.
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Alarm Database
To program the panel to monitor the PLC for errors and trigger an alarm,
see page 151, Project Attributes, Panel to PLC tab, PLC Error
and PLC Error Code Value.

To program an alarm in the Alarm Database, perform the following
steps: (Alarms are numbered from 1 to 999.)

1. Click on the Add/Edit button to add a new alarm.  To edit an
existing alarm, click on it in the list to highlight and then click
on the Add/Edit button.The following screen will appear.

PLEASE NOTE:
The steps necessary to program
your PowerPanel to monitor the
PLC for errors and trigger an
alarm are provided in
Appendix A, Troubleshooting,
“How do I Log and Display a
PLC Error Message?”

NOTE:  Alarms will be
displayed across the bottom of
the PowerPanel Screen.

Add New Alarm Dialog Box
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2. Use the UP/DOWN arrows next to the Alarm Number field to
scroll to the alarm number you wish to add.  Click on the
DOWN arrow next to the Tag Name field and select the tag
that will trigger the alarm.

3. If your Data Type is DISCRETE, you will be able to select
whether the alarm will be displayed when the bit is On or
when the bit is Off.  (If the data type of the tag is another data
type, the Alarm State selections are not available.)  The
default is “On.”

4. Enter the Limits (tag set points) — Low Limit and High
Limit.  The alarm will activate when the tag value goes outside
the set point limits. The available ranges for the Low and High
Limits will be displayed in these fields and are particular to the
data type.  The limits you place here must be within these
ranges. (If the data type of tag is Discrete then data boxes for
Low Limit and High Limit will not be available.)

5. Click on the box next to Log if you want the alarm to be logged
in Alarm History when it is triggered.  The Alarm History object
will store up to 64 alarms and, when the 65th alarm comes in,
it will dump the oldest alarm.

6. Click on the box next to Print if you want the alarm message
to print out the Serial Port of the panel every time it is triggered.

7. Click on the box next to Display if you want the alarm to be
displayed on the panel when triggered.

8. Select the Language number and type in the Alarm Text
(message) you want to display on the PowerPanel when the
alarm is triggered.  The message can be up to 34 characters
in up to 9 different languages.

9. Click on Add New Alarm # or Apply Changes Alarm #
button to save and exit the dialog box.

Edit Alarm Details Dialog Box

Please Note:  The Add New
Alarm and Edit Alarm Details
dialog boxes default to Log
and Display enabled (check
mark in box preceding
feature).
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Export Alarms
Click on the Export Alarms menu item to write the alarms from your
current (open) project to an Excel file or a CSV file.

Comma delimited...
The CSV (Comma delimited or Comma-separated values) file format saves
only the text and values as they are displayed in cells of the Alarm
Database. All rows and all characters in each cell are saved. Columns
of data are separated by commas, and each row of data ends in a
carriage return. If a cell contains a comma, the cell contents are enclosed
in double quotation marks.

Example of what a CSV file looks like opened in Notepad:

1,NUMERIC ENTRY,,-32768,32767,YES,NO,NO,1,
2,INDICATOR LIGHT,OFF,,,YES,NO,NO,1,

Click on Comma delimited... if you want to save the alarm database
as a .CSV file. The following window will appear allowing you to name
the file and navigate to the directory and folder where you want it to be
saved.

To Excel...
Click on the To Excel... menu item to write the alarms from your current
(open) project to a Microsoft Excel® file.  The PowerPanel Programming
Software will open Microsoft Excel and write the alarms to an Excel
book as shown below. Click on File >Save As in the Excel program and
enter a name for the file. Click on the Save button to save the file under
the name you have entered. Close Excel to return to PowerPanel
Programming Software.
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Message Database
Here you may create up to 999 messages (limited by available memory).
Each message may be up to 200 characters and you can choose various
message attributes such as, Character Size, Text Color, Background
Color, Blink (for text and/or background), and Language. The Message
Database is used by the Lookup Text object to display a message on
the panel. The value for the message is assigned in the Tag associated
with a Lookup Text object.

To create a new message:
1. Click on the Add button.  The following Add New Message

dialog box will appear.

2. Select the Message Number using the UP/DOWN arrows.
3. Select the Text Color by clicking on the DOWN arrow to view

the color palette.  Click on the box in front of Blink if you want
the text in the message to blink on and off.

4. Select the Background Color and whether or not you want
the background of the message to Blink.

Add New Message Dialog Box
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5. Select the Character Size of the Message Text by clicking on
the down arrow next to the Char. Size field to choose from
the available choices.

6. Click on the box in front of Print if you want the message to
print to a printer anytime it is displayed on the Panel.

7. Under Message Text, select the Language for the message
(up to 9) and then enter the text for the message.  When
finished, click on the Add New Message # button.

To edit an existing message:

1. Click on the message in the Message Database list to highlight
it and then double click or click on the Add button. The following
dialog box will appear.

2. Make changes and then click on the Apply Changes
Message # button.  The changes will be saved to the
Message Database.

Edit Message Details Dialog Box

Colors you have
selected for the
message text and
background display
right in the message
database window!

The message shown above will
appear after you have clicked on
the Add New Message button.  Click
on Yes if you have another message
to add to the database or click on
No if you are finished adding
messages.
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Export Messages
Click on the Export Messages menu item to write the messages from
your current (open) project to an Excel file or a CSV file.

Comma delimited...
The CSV (Comma delimited or Comma-separated values) file format
saves only the text and values as they are displayed in cells of the
Message Database. All rows and all characters in each cell are saved.
Columns of data are separated by commas, and each row of data ends
in a carriage return. If a cell contains a comma, the cell contents are
enclosed in double quotation marks.

Example of what a CSV file looks like opened in Notepad:

1,YES,6x8,144,NO,3195072,NO,1,This is message number 1.
2,NO,6x8,49152,NO,15765504,NO,1,This is message number 2.
3,NO,8x16,0,NO,12632256,NO,1,This is message number 3.
4,NO,6x8,15728640,YES,12632304,YES,1,This is message number 4.

Click on Comma delimited... if you want to save the Message
Database as a .CSV file. The following window will appear allowing
you to name the file and navigate to the directory and folder where you
want to save it.

To Excel...
Click on the To Excel... menu item to write the messages from your
current (open) project to a Microsoft Excel® file.  The PowerPanel
Programming Software will open Microsoft Excel and write the messages
to an Excel book as shown below. Click on File >Save As in the Excel
program and enter a name for the file. Click on the Save button to save
the file under the name you have entered. Close Excel to return to
PowerPanel Programming Software.
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Project Attributes

Project Attributes represent the attributes that contribute to the
configuration of the PowerPanel. Attributes listed under the General,
Printer, Passwords, Clock, Panel to PLC, PLC to Panel, and Language
tabs are provided below.

Under the General tab, you will enter the following attributes:

Power-Up Screen
This is the screen that will be displayed after the unit completes its
power-up sequence.  If the initial value of the "Switch to Screen Number"
(from PLC) is anything but zero, this entry will be ignored.  Range is 1–
999.

Alarm Display Time (sec.)
Specifies the length of time in seconds (1 to 60) that each alarm will
remain displayed before the next alarm, in the circular queue, is
displayed.

Alarm List Size
If two or more alarms are active, they are placed in a circular queue and
displayed one after another.  This parameter specifies the length of the
queue.  Range is 1-99.  In other words, this is the maximum number of
alarms that will be on at one time.  This is not the number of alarm inputs
that are monitored.  See the section on alarms for more information.
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Display Saver (30-1500 minutes) 0 = Disabled
The length of time in minutes that passes before the screen saver is
activated.  The timer is reset when a new screen is displayed, or when
the screen is touched or an alarm is activated.

Default Language
This value is the language that the panel will use when it powers up.
Choose from Languages 1 to 9.  Languages are programmed when
creating the object text or in the Message Database.   Languages are
named under the Language Tab.

To change the active language when in the PowerPanel Programming
Software, click on Edit > Current Editing Language.

Enable Beeper
When the buzzer is enabled, the buzzer will sound when the screen is
touched on an active area.  If the buzzer is disabled, the buzzer never
sounds.  Select Yes or No.

Under the Printer tab, you will make selections for the following
attributes:

Baud Rate
Select baud rate to match Printer.  Select from 1200, 2400, 4800, 9600,
19200, or 38400.  Default is 9600.

Parity, Stop Bits, Data Bits
Select the corresponding attributes of the printer.
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Select RS485
This allows you to select RS-485 as the communication protocol.  If you
are connecting RS-232 or RS-422, do NOT select this feature. Click on
the box to place a check mark, if you want to enable RS-485.

Require CTS
Select this to match the printer.

Control RTS
Select this to match the printer.

Under the Passwords tab, you can make the following
selections:

There are eight groups to which you may assign Passwords.
Passwords restrict a user from using objects, such as push Buttons,
Numerical Entry, etc.  Passwords can also be used with Change Screen
buttons to restrict access to other screens.  Select from the following
Group headings, or enter your own.

GROUP
• Managers • Shift 1 Operator
• Engineers • Shift 2 Operator
• Supervisors • Shift 3 Operator
• Maintenance • General
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All “touch” objects allow you to select the security or Protection level of
those that have access to that screen.   A numerical keypad will pop up
when the touch object is pressed, prompting  the user to enter a
password. Select Password or Tag under the Password/Tag heading.
If you select Tag, the password value will be stored in the PLC.  If you
select Password,  you will enter the password here.   Passwords are
entered by the operator with a popup keypad.

PASSWORD
A 1-10 digit number is assigned here that the user must enter to perform
protected functions for a particular Group level.   A password is an
internal value stored in the panel.

TAG
Tag names are assigned to PLC registers that hold the passwords.  This
allows you to change the codes by writing new code values in the
assigned PLC registers.  It also gives you the ability to design a screen
that allows a Supervisor to change security codes from the touch screen.
Only use positive values when assigning tag values.

Under the Clock tab, you will select the following attributes:

Date Tags:
Year (word): Tag for the location that the panel sets with the
year (0–99).

PLEASE NOTE:
Leading Zeroes are ignored
in passwords.  In other words,
if you enter a password of
000455, the password will be
455.
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Month (word): Tag for the location that the panel sets with
the month (1–12).
Day (word): Tag for location that the panel sets with the day
(1–31).

Time Tags
Hour (word): Tag for internal location that the panel sets
with the hour (1–12).
Minute (word): Tag for internal location that the panel sets
with the minute (00–59).
Second (word): Tag for internal location that the panel sets
with the second (00–59).

Clock Source
If you select Internal, the panel maintains clock using onboard Real-
Time Clock chip.  The panel will write data and time values to the PLC, if
the tags are mapped to the PLC. (SEE NOTE TO THE LEFT.)

If you select External, the panel uses values from  the tags in place of
internal Real-Time Clock.  The panel will read these values from the PLC
if the tags are mapped to the PLC. (SEE NOTE TO THE LEFT.)

Under the Panel to PLC  tab, you will enter the following
attributes:

NOTE:  If using Internal, the
tag address string must use  a
READ/WRITE register in the
PLC.  The PLCs use READ
ONLY registers for their internal
clock/calendars and cannot be
written to. If using External, be
sure to use the correct PLC
addresses!
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Current Screen (word)
Tag for the register that the panel writes to, indicating the screen
number that is currently displayed on the panel.

Good Communication Toggle (Discrete)
Watchdog — this bit is toggled every 5 seconds allowing the PLC to
determine if the panel is communicating.

Low Battery (Discrete)
Indicates battery for system RAM needs to be replaced.  Cleared on
power-up, set when low battery is detected.

Screen Buffer Overflow (Discrete)
Indicates that the current screen and its objects and graphics contain
more data than the screen buffer can hold.  Set/cleared when switching
screens.

Popup Keypad (Discrete)
Indicates that the Popup Keypad is active on the panel screen.

Current Language Number (word)
Shows the value (1–9) of the current language being used on the
screen.

PLC Error (discrete) and PLC Error Code Value (word)

Error Code Value (word)
Tag for internal location that the panel writes values to indicating which
PLC errors have occurred in the unit.  The values are in decimal only.
Convert them to Hex to find the PLC Error Code Value.  PLC Error
messages are listed in the Appendix A, PLC Error Messages, and in the
programming software help under the PLC Help topic, Driver Errors.

PLC Error (Discrete)
Tag for internal location where the panel sets a bit  to indicate that a
PLC error has occurred.

NOTE: Map to internal tag
only — DO NOT assign PLC
addresses or other objects to
these tags:

Leave the Address String
Field EMPTY when
programming PLC Error
Tags!

NOTE: The steps necessary
to program your PowerPanel
to monitor the PLC for errors
and trigger an alarm are
provided in the
Troubleshooting Appendix A
(see “How do I Log and
Display PLC Error
Messages?”).
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Under the PLC to Panel tab, you will enter the following attributes:

Under this Project Attributes tab, you will enter a tag to an internal panel
location.  These locations can be written to by the PLC.

Switch to Screen Number (word)
This tag can be written to by the PLC to display a screen on the
PowerPanel. This will allow the PLC to change screens at anytime.  A
zero (0) placed in the tag will return the customer to the previous
screen.

Beeper On/Off (Discrete)
This tag can by written to by the PLC to turn on the panel beeper. This
will allow the PLC to turn on the panel beeper at anytime. (Beeper is
activated by PLC and not by a press to a touch cell.)

Increase Clock by 1 hour (Discrete)
This allows the PLC to increment the panel system clock by 1 hour.

Decrease Clock by 1 hour (Discrete)
This allows the PLC to decrement the system clock by 1 hour.

Clear Alarm History (Discrete)
This allows the PLC to clear the panel alarm history.

Clear Alarm Count (Discrete)
This allows the PLC to clear the panel alarm count.
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Trigger Screen Saver (Discrete)
This allows the PLC to trigger the panel screen saver.

Select Current Language (word)
This allows the PLC to select the current language (1–9).

Under the Language tab, you will assign the following
attributes:

The PowerPanel supports Multiple Languages.  Language Preference
allows you to select and view different versions of text strings while
you are working in the programming software.   Each version can be
created for a different language (up to 9) for each Object where text is
displayed.

The Default Language is the language to be used by the PowerPanel on
power-up.

A brief tutorial is provided here to show you how the Multi-Language
Support Feature works.  If, for instance, you are creating a Push Button
Object, and you want the text within the button to say "Hello" in Language
Number 1,  "HOLA" (Spanish equivalent) in Language Number 2, and
"GUTEN TAG" (German equivalent) in Language Number 3, do the
following:

1. Click on the Button Object,  and then click on the General tab,
if necessary.

NOTE:  For an operator to
change the language on a
configured panel, see System
Objects, Select Language.
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2. In the Language Number box type in "1" (or click on arrows
to scroll up or down),  then type "HELLO" in the text box.  Go
back to Language Number box and type in "2", then type
"HOLA" in the text box, and repeat for "3" and "GUTEN TAG."

3. Click on OK.

4. The next time you type in Language Number 1, 2 or 3, the
corresponding text string will come up in the text box.

5. To view the different languages for the Button object text,
click on Edit on the Main Menu Bar and select Current
Editing Language..., and then enter the "Working" language
number that you want to view in PowerPanel Programming
Software.  The text in your Button Object will change
accordingly.  Keep in mind that this is for viewing only while
working in the PowerPanel Programming Software. To set the
language preference that will be displayed on the PowerPanel,
you must select the preferred Language Number as the
Default Language while programming your Project
Attributes.

Project Description
Enter text here to describe your project. You may enter up to 400
characters.  Click on the OK button when you are finished.

Select PLC
Click on the down arrow to view the available PLCs.  Select the type/
protocol you are using.  If you want to View or Edit the PLC Attributes,
click on the View/Edit Attributes button.  Click on OK to save selection.
The dialog box shown below appears when you click on the View/Edit
Attributes button.  It is specific to the type PLC and protocol you have
selected in the previous dialog box (in this case, DirectLogic K-Sequence).

Hello...Hello...Hello...Hello...Hello...
Hola...Hola...Hola...Hola...Hola...
          Guten           Guten           Guten           Guten           Guten TTTTTaaaaag...g...g...g...g...



Programming Software User ManualProgramming Software User ManualProgramming Software User ManualProgramming Software User ManualProgramming Software User Manual

155155155155155

R
eferen

ce

MAN-UTICW-M

You may change the attributes from this dialog box. Click on OK to save
your changes or Help to view the help topics available for that particular
PLC.

Upgrade Firmware (SEE CAUTION, BELOW)
There may be occasional upgrades to the PowerPanel internal software,
also referred to as the Exec or Firmware.  (Check the www.uticor.net
website periodically for information about software and
firmware upgrades.)

CAUTION:   Existing programs that are saved to Flash memory
must be resaved to Flash after upgrade.  When upgrading
firmware, YOU MUST write the program to the panel and save
the program to FLASH using  Panel > Flash > RAM  to Flash.

NOTE:  These settings must
match the PLC
Communications Port that you
are connecting the PowerPanel
to.

CAUTION
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To Upgrade Firmware:

1. Back up the user program currently stored in the PowerPanel
and save to disk or Flash option card.

2. Click on Upgrade Firmware and navigate (click on Browse
button) to the new firmware file (.hex file).

3. Select the appropriate COM port under Use PC Port and click
on the OK button to begin the upgrade.  A status bar will let
you know when the upgrade is complete.

The dialog box will show the File Revision number of the firmware and
the Panel Revision of the Firmware. Check these revision numbers.  If
they are the same (no upgrade is needed) you may click on the Abort
button to exit. If the file you have selected is not the right one, click on
the Select a different file... button.

Check File Revision number
against Panel Revision number.
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Window MenuWindow MenuWindow MenuWindow MenuWindow Menu

Cascade
Click here to view open screen files in the window.  Screens will
cascade down window, overlapping each other, but with their title bars
in view.  This is helpful when you are making changes to two or more
screens at the same time. Click on the title bar of one of the screens to
bring it to the front. The title bar is grayed out in screens that are not
currently active.

Tile
Click here to view open screen files in the window.  Screens will be
arranged within the window.  This is helpful if you want to copy or cut
and paste objects or drawings between screens. The title bar is grayed
out in screens that are not currently active

1 Demo Project 1.prp - #1 Numeric Entry Screen
2 Demo Project 1.prp - #2 Time and Date

This is a list of the project screens that are currently open.  Click on a
screen in this list to bring it into view.  A check mark will appear in front
of the active screen in this list.
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Help MenuHelp MenuHelp MenuHelp MenuHelp Menu

Help Topics
Click on Help Topics to view the help topics for PowerPanel Programming
Software.  The help window is in Windows 2000 format.  Use the
Contents tab to view help topics by category.  Click on the Index tab
to view an alphabetical list of all help topics.  Click on the Search tab
and enter a word or words to search the help topics for.

About PowerPanel
Click on About PowerPanel for copyright, manufacturer, and version
number of the PowerPanel Programming Software.
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Right Click MenusRight Click MenusRight Click MenusRight Click MenusRight Click Menus

Some functions are accessible with a click on the right mouse button.
With your cursor anywhere on the programming window, click the right
mouse button.  The menu to your left will appear.  Some items may be
grayed out (not available), depending upon the objects you have selected.

From this menu you can:

♦ Cut, Copy, or Paste selected Objects (you must select more than
one object)

♦ Select All objects on screen
♦ Create New, Open an existing, or Rename a Screen
♦ Change the screen magnification with the Zoom control
♦ Display Grid, activate Snap to Grid, or change Grid Size
♦ Show Touch Cell grid
♦ Enter or Change the current Screen Description
♦ Change Background Color of the screen

The functions on the menu to the left are accessible when you have
one or more objects selected on a screen and click the right mouse
button. Some items may be grayed out (not available), depending upon
the objects you have selected.

From this menu you can:

♦ Edit an object
♦ Cut, Copy, or Paste an object
♦ Select All objects on current screen
♦ Bring selected object(s) to Front of screen
♦ Send selected object(s) to Back of screen
♦ Make selected objects the Same Size, Height, or Width (you must

select more than one object)

The functions on the menu to the left are accessible when you right
click the mouse button while in the Project Screens Explorer View
window.

♦ Add a New Screen to your project
♦ Open an existing Screen
♦ Rename a Screen from your project
♦ Delete a Screen

Right click while cursor is on
programming screen

Right click while cursor is on an
object

Right click while cursor is in the
Project Screens Explorer View
window
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Symbol Factory®Symbol Factory®Symbol Factory®Symbol Factory®Symbol Factory®

Over 3000 Symbols toOver 3000 Symbols toOver 3000 Symbols toOver 3000 Symbols toOver 3000 Symbols to
choose from — customizechoose from — customizechoose from — customizechoose from — customizechoose from — customize
your panel screens!your panel screens!your panel screens!your panel screens!your panel screens!

Symbol Factory® is a product we have included in our software for your
use in creating screen graphics.  The Symbol Factory is a library of over
3,000 symbols for industrial automation, including pumps, pipes, valves,
tanks, mixers, motors, ducts, electrical symbols, flow meters, material
handling, sensors, PLCs, transmitters, and ISA symbols.  It is accessible
from the Draw > Static Bitmap and Objects > Dynamic Bitmap
menus. Once opened, click on Symbol Factory Help menu item for Help.

NOTE: Go back to page 129
for instructions on how to size a
symbol bitmap before or after
importing onto a screen, or see
Symbol Factory Help.
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In this Appendix....

— Frequently Asked Questions (FAQs)
—Troubleshooting
— PowerPanel  Error Messages
— PowerPanel  Programming Software Error Messages
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FrequentlFrequentlFrequentlFrequentlFrequently Asked Questions (Fy Asked Questions (Fy Asked Questions (Fy Asked Questions (Fy Asked Questions (FAAAAAQs)Qs)Qs)Qs)Qs)

1.  How do I format an address string when  connecting to multiple PLCs?
Simply add the PLC Station Number  to the beginning of the address string. (For example, if the
PLC Station number is 3 and the address is V2003,  enter  3-V2003 for the address string.)

2. Can I change the Data Type of a Tag Name’s assigned Address String (PLC
Address)?
Yes, but only if the Tag is used on no more than one object. If it is currently used by more than
one object, you must:

a. assign the other objects to a new or different tag(s)—or delete those objects
b. change the data type of the PLC Address under Setup > Tag Database
c. reassign the other objects to the original tag as necessary

3. Can the Tag Database be exported to other applications?
Yes, the Tag Database can be exported.  You can export your Tag Database from the PowerPanel
to Microsoft Excel® or you can export it as a Comma Separated Value (.CSV) file (also referred to
as a Comma delimited file format).

4. How do I convert a project from one panel size to another?
Converting a project created on a 6” panel to an 8” or 10” panel requires nothing more than
opening the project with the new size selected. Converting from 8” or 10” to 6” size is best done
by the following procedure:

a. Select Screen > Show 320x240 Rectangle.
b. Move all the objects onto the new small 6” grid shown.
c. Save the project.
d. Open the project again, selecting the new panel size on the Project Information box.

5. Can I use the Power Up Screen selection (under the Project Attributes > General
menu) and also use the Switch to Screen Number (under Project Attributes >
PLC to Panel)?

Not exactly, because before the panel can actually display the Power Up Screen, it reads from
the PLC and displays the Switch to Screen Number.

6. Can I place objects anywhere on the screen?
There are two types of objects in PowerPanel  Editor.  One is Touch Objects (pushbutton,
switches, numeric entry, etc.) and the other is Display Objects (meter, bar graph, numeric display,
line, circle, etc.)  Touch Objects will always snap to the touchcell grid by the upper left corner.
You can then click on the object to highlight and then resize by clicking on one of the other side or
corner handles and dragging it to the size you want. Ensure that the Snap to Grid feature is
turned off if you want the Touch Object to be positioned to within a touchcell area. Display
Objects may be placed anywhere on the screen.

7. What is a touchcell?
 A touchcell is the physical area on the panel that defines user selection by touching. A Touch
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Object can contain more than one touchcell, but cannot contain less than one touchcell. On all
PowerPanels, the size of a touchcell is 40 x 40 pixels. However, since the screen size differs,
the physical size of 40 pixels does as well. On the 6-inch panels, 40 pixels = 0.57". On the 8-inch
panel 40 pixels = 0.52". On the 10-inch panel 40 pixels = 0.41".

8. Can I use the floating point data type with all objects?
No, only numeric entry, numeric display and recipe objects support floating point tags.  All other
objects do not support floating point tags.

9. Why do I not see all the discrete tags in a pushbutton object on the Tag Name
pulldown?
You may have defined tags as discrete but if the PLC addresses assigned to these tags are read
only addresses, then you will not see these tags.  The reason is because a pushbutton writes
discrete data to the PLC address and if a tag is mapped to a Read Only PLC address, the
pushbutton is not allowed to write the data.

10. Can I use a label on a vertical Radio button?
 No, a label is not available for either vertical style Radio button or vertical style Tri-State Switch.

11. How does a Radio button work?
A Radio button is assigned to a word (16 bit register) in the PLC.  Each bit in the word (of this
associated tag) corresponds to an individual button of the Radio button object.  Only one button
can be ON at a time. So, turning one button ON automatically turns all other buttons OFF.

12. What is the initial state of objects when the project is written to the panel?
If the object reads from the PLC, it will show the current PLC value.  If it writes to the PLC, it will
default to zero (for OFF).

13. What will be the state of objects if they are mapped to internal tags?
Internal tags are initialized to OFF.

14. When I select a group of objects and try to move, all the objects do not move.  Why?
If you have selected a mix of touch and display objects and try to move this group, you will be
able to move only display objects.  Remember, touch objects are always snapped to a touchcell,
whereas display objects are not necessarily snapped to touchcells. Try moving the touch objects
first, then move the display objects.

15. When I have objects at the boundary of the screen, I am not able to move the
objects freely (vertically up/down or Horizontally left/right near the boundary).  What
can I do to correct this?
You can use the PC’s keyboard arrow keys to move objects up or down along the boundary line.
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16. What is the maximum number of screens that a project can have?
The maximum possible is 999. However, the panel’s memory may limit the achievable maximum to
a lower number of screens, depending on the complexity of bitmaps and objects.

17. What is the maximum number of alarms that a project can have?
The maximum is 999, but there is no limit to how many times each alarm can be used in the panel.

18. What is the maximum number of messages that a project can have?
You can define a maximum of 999 messages in a project.

19. Can I insert a 640 x 480 bitmap on a screen?
The maximum size of a bitmap that can ever be placed on a screen is 640 x 480 on a 8” or 10”
panel.  But, the compressed size of bitmap is also a limitation.  The PowerPanel uses an RLE
(RunLength Encoding) algorithm to compress bitmaps for storage.  If this compressed bitmap size
exceeds 64K bytes, you cannot place the bitmap on the screen.

20. Is it possible to find out whether the compressed bitmap size is less than 64K
before trying to insert the bitmap?
No, the only sure way to know is to try. An error message will alert you immediately if the 64K
size is exceeded. Using fewer colors (like 256 vs. 24 bit) will help prevent this problem.

21. Is there a limit to the number of objects that can be placed on a single screen?
 No, not exactly, but the maximum memory size of a screen is 128K bytes.
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Problem:  Panel won’t power up.

Action:
1. Connect power to the PowerPanel (24 VDC).
2. Apply power while observing the LED in the back of the panel.

a. LED does not light means: NO POWER to unit or
power supply failed.  Check power supply or replace.
b. LED turns RED and stays RED means: Unit failure,

return for service.
c. LED flashes RED and turns GREEN means: normal

operation.
(1) the display does not light after 10 seconds, see
Display Blank, below.
(2) the display lights, normal operation.

Refer to the PowerPanel Programming Software Help topic, or the
PowerPanel  Hardware Manual chapter on "Connections and Wiring"
for more information.

Problem: Cannot communicate with PowerPanel
from Programming Computer.

Action:
1. Check cable, ensure that it is the correct cable and that it is

properly connected at both ends.
2. Check panel for power.
3. Check to ensure the correct PC COM port is selected in the

PowerPanel  Programming Software and that it is available in
the PC.

4. Check the COM1 setting in Setup Mode on the panel.

Refer to the PowerPanel Programming Software Help topic, or the
PowerPanel Hardware Manual chapter on "Connections and Wiring"
for more information.

Problem:  Panel does not communicate with PLC.

Action:
1. Check communications cable:

a. Is it the right cable?
b. Is it connected?
c. Is the cable terminated properly?

2. Check PLC settings:
a. Is PLC system powered?
b. Is PLC COM  Port properly configured?
c. If there is a RUN switch on PLC, is it in the term/remote

mode?

TTTTTrrrrroubouboubouboubleshootingleshootingleshootingleshootingleshooting
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Refer to the PowerPanel Programming Software Help topic, or the
PowerPanel Hardware Manual chapter on "Connections and Wiring"
for more information.

Problem:  Memory unavailable.

Action:
1. Make sure that the Flash Card is in top slot, and the RAM Card

is in the bottom slot.

Refer to the PowerPanel Programming Software Help topic, or the
PowerPanel Hardware Manual chapter on "Connections and Wiring"
for more information.

Problem:  Display is Blank.

Action:
1. Display indicates NO SCREEN for 3 seconds after power up.

There is no user program installed into the panel.
2. Display is blank. Push extreme upper left and extreme lower

left touch cells on front of panel (top and bottom of column 1
on panel.)  At this point, one of the following will occur:
a. There is no change, and the display remains blank.

This indicates UNIT FAILURE: return for service.
b. Unit SETUP screen appears, screen is hard to read.

Adjust screen contrast control for 6- or 8-inch units
(10-inch units have no contrast adjustment).

c. Unit SETUP screen appears normal.  Unit has no
user program — transfer user program to panel.

Refer to the PowerPanel Programming Software Help topic, or the
PowerPanel Hardware Manual chapter on "Connections and Wiring"
for more information.

Problem:  Display hangs when unit is powered up,
“Initializing...” message remains on screen (unit
has invalid RAM memory)

Action:
1. Remove power. While pressing extreme upper and lower left

touch cells on the panel, reapply power.
2. You will now be in setup mode, press exit to enter run mode.

Screen will be blank.
3. Run PowerPanel Programming Software.  Select Panel > Clear

Memory from main menu bar, or transfer a new user program
to the panel.
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Problem:  “How do I log and display PLC Error
Messages?”

Action: Following is a description of how  to set up the
panel to monitor communications between the PLC and
panel.  This will  allow the panel to detect a PLC error and
log the PLC ERROR CODE VALUE in the Alarm Database.
Open your PowerPanel Project in the PowerPanel Program-
ming Software.  For the purposes of this demo, we are
using DirectLogic K-Sequence Protocol.

1. From the Main Menu Bar, click on Setup > Project Attributes
and then click on the Panel to PLC tab.

2. Click in the field next to Error Code Value (word).  Type in ERROR
CODE VALUE for the tag name as shown below.

3. Press Enter.  The following ADD NEW TAG DETAILS dialog box
will appear.
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4. LEAVE THE Address String FIELD EMPTY and select
UNSIGNED_INT_16 as the Data Type. Click OK.

5. Click in the field next to PLC Error (Discrete) and type in PLC
ERROR as shown below.

6. Press Enter.  The following ADD NEW TAG DETAILS dialog box
will appear.

7. LEAVE THE Address String FIELD EMPTY and select DISCRETE
as the Data Type. Click OK.

8. From the Main Menu Bar, click on Setup > Alarm Database.
The following dialog box will appear.
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9. On the Alarm Database dialog box, click on the Add/Edit button.
The following Add New Alarm dialog box will appear.

10. For Alarm No. 1, click on the down arrow next toTag Name
and select ERROR CODE VALUE from the list.

11. Set both the Low Limit and the High Limit to 0. Leave Log and
Display selected.

12.  Under Alarm Text, type in the alarm message as ERROR CODE
VALUE.

13. Click on the Add New Alarm Button.  The message shown
below will appear.  Click on the Yes button.
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14.  For Alarm No. 2, click on the down arrow next to Tag Name
and select PLC ERROR from the list.

15. For Alarm State, leave the selection to On.  Leave Log and
Display selected, also.

16. Under Alarm Text, type in the alarm message as PLC ERROR.

17.  Click on the Add New Alarm button.  The following message
will appear. Click on the No button.

18. The Alarm Database should now show the two new alarms
that you have just added, as shown below.
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To be able to view the Alarm History and the PLC ERROR CODE VALUE,
perform the steps below.

1. First we’ll program a screen with an Alarm History button
that will allow you to view alarm history. Open the screen in
your PowerPanel  Programming Software where you want to
place the Alarm History Button.

2. Click on Objects > Alarm History.  The following screen will
appear.

3. Type in View in the Text field.  Click on OK.

4. A crosshair cursor will appear on the programming screen.
Position the crosshair where you want the object to appear
(center at the bottom of the screen), and click once.

5. Grab the object by a handle and drag to resize it until the label
displays in its entirety, as shown below.

6. Click on File > Save Project.

7. Transfer the saved Project to the panel.
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8.   To test the Alarms, perform the following steps.

a. Disconnect the PLC and then reconnect it as soon as you can
after the first error message flashes on the panel screen.

(While disconnected the “PLC COMMUNICATION TIMEOUT”
error message will flash across the top of the PowerPanel
Screen, and the “01/02 ERROR CODE VALUE” error message
will flash across the bottom of the screen.)

b. Press the ALARM HISTORY button on the panel screen.  The
Alarm History screen will appear.  It will look similar to the one
shown below.  (Each time the error message flashes on the
panel screen it is counted as an entry.)

c. Press the ALARM COUNT button.  The following screen will
appear, showing you the number of times the messages was
sent.

Please Note:  Alarm History
and Alarm Counts are
retentive — they are cleared
from the Alarm History/
Count screen or from Project
Attributes (PLC to Panel).
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d. Press the ALARM HISTORY button.  From this screen press
the DETAILS button.  The following screen will appear,
showing the details of the alarm.
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e. Press on the NEXT button to view details of the second
alarm. Remember or write down the ACTUAL VALUE.  (In
this case, the actual decimal value is 256.)

f. Press the EXIT button to return to ALARM HISTORY screen,
and then press the EXIT button on this screen to return to
the project screen.

g. Convert the Actual Value of the error that you wrote down
from the Alarm History Details screen.  All PLC ERROR
CODE VALUEs are in decimal.  Convert them to HEX.  From
the Actual Value of 256, you will get a Hex value of 100.
Look for this value under Driver Errors (0x0100).

See the PowerPanel Programming
Software Help for PLC Driver Error
Messages —
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PPPPPooooowerPwerPwerPwerPwerPanel  Erranel  Erranel  Erranel  Erranel  Error Messaor Messaor Messaor Messaor Messagggggeseseseses
WRITE QUEUE OVERFLOW
This message indicates that the panel was unable to write all of the
tags to the PLC. The panel can queue up to 20 tags to write to the PLC.
After the tag is written to the PLC it is removed from the queue. If a write
is attempted while the queue is full then this error message is displayed
and the write is ignored.

EXTERNAL CLOCK - OBJECT IGNORED
This message indicates that the increment/decrement hour system object
was pressed while the external clock has been selected in the project
attributes. The object can not change the external clock.

RAM TEST FAILED
This message indicates that the RAM test performed at reset failed. The
RAM in the unit may be unreliable.

VIDEO CHIP TEST FAILED
This message indicates that the video controller chip did not program
correctly.

VIDEO RAM TEST FAILED
This message indicates that the video RAM test performed at reset
failed. The video RAM in the unit may be unreliable.

KEYPAD ENTRY TOO HIGH
This message indicates that the user attempted to enter a value that
was greater than the maximum value for the numeric keypad. The value
is ignored.

KEYPAD ENTRY TOO LOW
This message indicates that the user attempted to enter a value that
was less than the minimum value for the numeric keypad. The value is
ignored.

TAG TYPE VALUE MISMATCH
This message indicates that the object contains a value that is of a
different type than the object's tag. For example, the value may be a
signed value but the tag may be an unsigned value. The object should
be edited to contain the correct value type.

INVALID CODE
This message indicates that the user entered an invalid password for a
protected object. The user must enter a valid password. The passwords
are defined in the project attributes.

SCREEN BUFFER OVERFLOW
This message indicates that there are more objects on the screen than
the panel can display. When a screen is displayed, the panel copies the
objects to a buffer. If the buffer is filled then this message is displayed
and any remaining objects are ignored. The amount of memory used by
an object is dependent on the type of object, visibility, the label, and
strings used by the object. Some objects should be removed from the
screen.
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PPPPPooooowerPwerPwerPwerPwerPanel  Pranel  Pranel  Pranel  Pranel  Programming Software Errogramming Software Errogramming Software Errogramming Software Errogramming Software Error Messaor Messaor Messaor Messaor Messagggggeseseseses

Error Codes

Error Codes are divided into categories and are numbered with prefixes and 3 digits as
follows:

Value Range Errors Vxx_x
PLC Conversion Errors Pxx_x
Tag Errors Txx_x
Project Information (Step 1) Errors Ixx_x
Saving Errors Sxx_x
Object Errors Jxx_x
Communication Errors Cxx_x
Miscellaneous Errors Mxx_x
Bitmap Errors BMP_xx

Value Range Errors (Vxx_x)

Value Errors common to all objects:
Error V01_1:  Minimum value is not within range.
Error V01_2:  Maximum value is not within range.
Error V01_3:  Minimum value is greater than maximum value.
Error V01_4:  Maximum value is less than minimum value.

Value Errors related to Meter object:
Error V02_1:  LowLow limit is not within range.
Error V02_2:  Low limit is not within range.
Error V02_3:  High limit is not within range.
Error V02_4:  HighHigh limit is not within range.

Value Errors related to Numeric Entry/Numeric Display.
Error V03_1:  PLC Value 1 is not within range.
Error V03_2:  PLC Value 2 is  not within range.
Error V03_3:  Display Value 1 is not within range.
Error V03_4: Display Value 2 is not within range.

Value Error related to Bar Graph:
Error V04_1:  Mid value is not within range.

Value Errors related to PID Faceplate:
Error V05_1:  Process value (Minimum) is not within range.
Error V05_2:  Process value (Maximum) is not within range.
Error V05_3:  Output value (Minimum) is not within range.
Error V05_4:  Output value (Maximum) is not within range.
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Value Error related to Recipe object:
Error V06_1:  Value is not within range.

Reason: These errors occur when a value is not within selected tag's data range.
Solution:  Enter a value that is within the appropriate range.

Valid ranges for various tag data types are:

TAG DATA TYPE MINIMUM MAXIMUM
Signed 16 bit -32768 32767
Signed 32 bit -2147483648 2147483647
Unsigned 16 bit 0 65535
Unsigned 32 bit 0 4294967295
BCD 16 bit 0 9999
BCD 32 bit 0 99999999
Floating point -9999999999 9999999999

PLC Conversion Errors (Pxx_x)

Error P01_1:  The selected panel type does not support the PLC chosen for the project.
Do you want to continue?

Reason: Some PowerPanel s support all of the available PLC drivers and some support only
DirectLOGIC drivers.
Solution:  Select an appropriate panel.

Error P02_1:  <PLCFrom> is not compatible with <PLCTo>.  If you continue, the PLC
address from each tag will be lost and all the tags will become internal tags.  Do you
want to continue?
Error P02_2:  Change in selected PLC would result in possible loss of tag data. Do you
want to continue?
Error P02_3:  Unable to convert to <PLCTo>.
Error P02_4:  Unable to convert PLC Address.

Reason:  This error occurs if, after creating a project with addressed tags, an attempt is made
to change to a PLC with a different address format.
Solution:  When changing PLCs, check the addressing in the  PLC  manuals to see if they are
compatible.  If they are not compatible, then the tag database is no longer valid and the
addresses will have to be reentered.

Error P02_5:  Unable to build PLC details structure while converting to < >.
Reason:  If you try to change PLCs in a previously created project and select "Cancel" in the
first message window, a second window will appear.
Solution:  This message window appears to inform the user that no tag addresses were
changed.
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Tag Related Errors (Txx_x)

Error T01_1:  Define a valid tag for  <control name>.
Reason:  This error occurs when you have not defined all  tags in an object requiring multiple
tags.
Solution:  Define all the required tags for the selected object.

Error T01_2:  Tag name already exists.
Reason:  The tag name that was entered is a name that already has a data  type and/or PLC
address assigned to it in the tag database.
Solution:  Change the tag name entered to a name that is unique when compared to all the other
tags in the Tag Database.

Error T01_3:  Tag category does not match.
Reason:  This error occurs when a Tag Name of an incorrect data type is typed into the Tag
Name field of an object.
Solution:  Select a valid Tag Name from the pulldown list, or create a new valid Tag Name.

Error T02_1:  Invalid Unit Number.
Error T02_2:  Invalid Address Type.
Error T02_3:  Invalid Address.
Error T02_4:  Invalid Bit Number.
Error T02_5:  Address in not Word Aligned (Even address is required).
Error T02_6:  Address is not Word Aligned (Odd address is required).

Reason:  Address entered for the tag is not correct.
Solution:  Specify a valid PLC address.

Error T02_7:  Address type does not match Tag data type, or the address is invalid.
Error T02_8:  Tag IO Type does not match Object type.

Reason:  If you specify a discrete address to an object requiring a word address or vice versa,
you will receive this error message.
Solution: Specify a valid PLC address, with appropriate I/O Type.

Error T02_9:  This object requires a Read/Write PLC address. Entered address is Read
Only location.

Reason:  This error occurs if a Read Only PLC address was entered for a Touch Object.
Solution:  Enter a Read/Write location for touch objects.

Object Type Type of Address
Touch Objects Read/Write
Display Objects Read/Write or Read Only
Alarms Read/Write or Read Only
Project Attributes (Internal Clock) Read/Write
Project Attributes (External Clock) Read/Write or Read Only
Project Attributes (Passwords) Read/Write or Read Only
Project Attributes (Panel to PLC) Read/Write
Project Attributes (PLC to Panel) Read/Write or Read Only

Error T02_10:  Number of Characters must be even and valid range is from 2 to 40.
Reason:  In the process of making an ASCII tag, the number of characters must remain between
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2 and 40.  If the user enters a number outside of this range, this error occurs.
Solution:  The user can either reenter a number within the specified range or use the wheel to
the right edge of that field.

Error T02_11:  IO Type is not valid for <ControlName>.  Unable to convert.
Reason:  If you specify a discrete address to an object requiring a word address or vice versa,
you will receive this error message.
Solution: Specify a valid PLC address.

Error T03_1:  Unable to get the data type.
Reason: The Tag Database has become corrupted.
Solution:  Try the following:

1) Go to  Tag Database (Setup > Tag Database) and select a tag not associated with any
object.
2) Delete the tag by pressing Delete button or by  using delete key on keyboard.
3) Save the project.
4) Close and then restart PowerPanel  software.
5) Open the project and check for the error again.

Error T03_2:  Tag index not found. Creating internal tags .
Solution:  Try the following:

1) Accept defaults
2) Open Tag Database and check to see if all  tags are there.
3) Some Tags will be UNKNOWN, modify to your requirements.

Error T03_3:  Unable to open tag database file (*.map).
Reason:  This error occurs if the project map file gets deleted or is missing when an attempt to
load the program is made.
Solution:  Recovering or finding original map file will recover project; if this cannot be done,
creating a new project with a new map file is the only solution.

Error T03_4:  Tag index limit reached; unable to create a new tag.
Reason:  You’ve reached the tag maximum.  Maximum number of tags that can be entered is
32,000.

Error T03_5:  Incorrect number of PLC tags and Internal tags.
Reason:  Tag database is corrupted.
Solution:  Rebuild the project.

Error T03_6:  Tag expected but not found.  Creating it as an internal tag.
Solution:  Try the following:
1) Accept defaults
2) Open Tag Database and check to see if all  tags are there.
3) Some  Tags will be UNKNOWN, modify to your requirements.

Error T04_1:    Cannot delete  <Tag>.  Tag associated with an object.
Reason:  The selected tag is associated with an object/alarm/project attribute.
Solution:  Use Setup> Tag Cross Reference to see what objects/alarms/project attributes
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are linked to the tag.
Error T04_2:  No map data found in tag database file named.

Reason:  Tag database is corrupted.
Solution:  Rebuild the project.

Project Information Dialog box (STEP 1) Errors (Ixx_x)

Error I01_1:   Attributes file associated with this project not found; creating one with
default attributes.

Reason:  There are six different files that make up the project.  If the saved attributes file (.atr) is
moved, deleted, or is altered outside of PowerPanel , the file may not load or will not be found.
Solution:  The program loader will reset the attributes to default.  Go to Setup > Select PLC and
redefine the communication parameters required.

Error I02_1:  Invalid file name or path
Reason:  You have specified an invalid file name.
Solution:  You have to specify a valid file name.
Do not include any special characters (\, /,.,*,?,<,>,|,etc.) while naming your files.  First character
should be alphanumeric.

Error I02_2:  Invalid file name. Do not use symbols.
Reason:  You have specified an invalid file name.
Solution:  To avoid getting both these messages, when creating a project do not use character
symbols (/,{,},[,],<,>,…etc.) in the project name.  Only use letters A-Z and/or numbers 0-9 for a
unique project name.

Error I02_3:  Invalid Think and Do map file.
Reason:  When working with Think and Do PLC type, this program will map the PowerPanel
project to an existing Think and Do map file.  If you try to map the PowerPanel  project to a map
file generated by any program other than Think and Do, this message will appear and prevent you
from continuing with the project.
Solution:  Select a valid Think and Do map file.

Error I03_1:  Unable to find the Dll Path.  Unable to build the Tag Database
Solution:  If you have moved the Dlls to some other directory move them back.  If you have
deleted them, you must reinstall the software.

Error I03_2:  Cannot edit Online unless the panel has a program. Edit Offline first and
write a program to the panel.

Reason:  Having no project loaded into the touch panel, the program loader will not allow one to
go into On-Line Edit mode, or  if the map file has been altered, and this message will come up.
Solution:  Get into Off-Line Edit mode and upload a project, exit out to the "Step: Project
Information", click on the On-Line edit mode, and select "OK".  If that don't work, make new
project with new map file.

Error I03_3:  Screen Number must be in the 1..999 range.
Reason:  You have entered an invalid Screen number
Solution:  Enter a valid Screen number.
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Saving Errors (Sxx_x)

Error S01_1:  The PowerPanel  Editor has detected that one or more static objects (line,
arc, circle, pie, static bitmap and static text) are on top of dynamic objects.  Static objects
cannot be on top of dynamic objects.  These static objects will be placed below the
dynamic objects.

Reason:  If you have any static and dynamic objects on the same screen, you need to make
sure the dynamic objects are always on top or away from the static objects.  Panel refreshes
only the dynamic objects once all the objects are drawn.  If for any reason a static object gets
on top of a dynamic (or brought to front with the right-click menu option with dynamic object on
top), this message will appear.
Solution:

1) The Editor will take care of this automatically.  It would sequence the objects in such a
way that static objects are drawn below the dynamic objects.

2) Other option is you can select the objects, right-click on the mouse and select Bring
Forward/Send Backward to rearrange them manually.

Error S01_2:  PowerPanel Editor detected that one or more objects on screen number x
are outside the 320x240 resolution.  Please move objects on this and all other screens
within 320x240 limits BEFORE changing the panel.  You may use “Show 320x240
Rectangle” icon to show a 320x240 rectangle.  Please ensure on all screens that the
objects are within this rectangle before trying to change to a lower resolution panel.

Solution:  Move the objects to within the 320x240 rectangle on all screens.

Error S01_3:  Unable to save this screen.  Screen size exceeds the maximum: 128K.
Please delete a few objects and try to save again.

Solution:  Either delete a few of the objects or move the objects to a different screen.

Error S02_1:  Unable to save the project to the panel.
Reason:  When working ONLINE, the panel loses power or the communication link between the
panel and PC is interrupted or disconnected.  When you select Save Screen or Save Project,
you will receive this error message.
Solution:  Check to see if power is getting to the panel, then check the COM line between the
panel and PC for a good connection.

Object Errors (Jxx_x)

Radio Buttons
Error J01_1:  Object cannot be accommodated in the new position.

Reason:  The radio buttons object cannot have any buttons over hanging on the screen.  The
vertical and horizontal radio buttons will only allow enough buttons to go from one end of the
screen to the other end.  Any more buttons will generate this message.
Solution:  One of two courses of action may be taken.  The first is to reduce the size of the
object itself.  The second option is to reduce the number of buttons in the object.

Error J01_2:  Cannot add another button. To do so would exceed the panel size.
Reason:  The radio button object will not allow more buttons when the object is the same
height/width as the touch panel screen.
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Step Switch
Error J02_1:  Number of steps: Range is from 2 to 4.

Solution:  Enter a number between 2 and 4 or use the wheel next to the box.

Error J02_2:  Step Switch x  Tag is not Defined.  (x being the step number)
Reason:  The "Tag Name", in the "Step #1" tab, was empty when the "OK" button was selected.
Solution:  Click on a tag from the drop-down menu for the "Tag Name" box, or type in a valid tag
name in the "Tag Name" box, in the tab "Step #1".

Thumbwheel
Error J03_1:  Number of Wheels:  Range is from 1 to 5.

Solution:  Only enter a number between 1 and 5 into the "Number of Wheels" field, or use the
wheel to the right side of the entry field.  UNSIGNED DECIMAL format: 5 digits (wheels), HEX: 4
digits (wheels)

Recipe
Error J04_1:  At least one valid recipe tag should be defined.

Reason:  When creating a recipe button, if there are no tags entered under the "Recipe" tab, this
message will appear.
Solution:  Click on the "Recipe" tab and enter a tag in the first box.

Numeric Entry/Numeric Display
Error J05_1:  PLC Value 1 is greater than PLC Value 2.

Solution:  Enter a value for PLC Value 1 that is less than PLC Value 2.
Error J05_2:  Display Value 1 is greater than Display Value 2.

Solution:  Enter a value for Display Value 1 that is less than Display Value 2.

Meter
Error J06_1:  LowLow limit should be greater than Minimum value.
Error J06_2:  Low limit should be greater than LowLow limit.
Error J06_3:  LowLow limit is greater than High limit.
Error J06_4:  High limit is greater than HighHigh limit.
Error J06_5:  HighHigh limit is greater than Maximum value.

Reason: You will get above errors when the following rule is not met.
Minimum Value  <  Low Low Limit < Low Limit < High Limit < High High Limit <
Maximum Value
Solution: Change the values appropriately.
Note:  while changing the values of alarm limits, use the following rule of thumb:

• If you are changing the values towards higher values, start from HighHigh limit
and go backwards.

• If you are changing the values towards lower values, start from LowLow limit and
go upwards.

Bar Graph
Error J07_1:  Mid value is not in between Minimum and Maximum values.

Reason: You will get above errors when the limits (for alarm) are not within selected tag's data
range.
Solution: You need to modify the values so that the values are within appropriate range.
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PID Faceplate
Error J08_1:  Process Variable Tag and Set Point Tag must be of same Data Type.

Solution:  Ensure that the Process Variable tag and the Set Point Tag are of the same data type.
In other words, if you define a signed tag for Process Variable, define a signed tag for Set Point
tag, also. Always assign the same data tag type  to both the Process Variable and Set Point.

Error J08_2: Process value (Maximum) is less than Present value (Minimum).
Solution:  Ensure that Present value (Maximum) is greater than Present value (Minimum).

Error J08_3: Output value (Minimum) cannot be greater than Present value (Maximum).
Solution:  Ensure that Output value (Maximum) is greater than Output value (Minimum).

Line Graph
Error J10_1:  At least one valid Pen tag must be defined.

Reason:  When using a line graph, there must be a minimum of one tag (signed, unsigned, or
BCD) assigned to the Pen entries.
Solution:  Be sure to assign a minimum of one tag (signed, unsigned, or BCD) to the Pen.

Error J10_2:  All Pen tags must be of the same sign type.
Reason:  The program loader requires that all the Pen tags have the same sign type for each line
graph object.  If you assign tags with different sign types (signed 16/32 and unsigned 16/32, or
BCD 16/32 and signed 16/32) to the same line graph object, this message will appear.
Solution:  If you need a line graph that contains a signed tag and an unsigned tag, they will then
require multiple line graph objects (one for each individual sign type).

Error J10_3:  Pen tags and Range type must be of same sign type.
Reason:  When assigning tags to the Pen page, they all must be of the same tag type, and that
also has to agree with the Range type under the XY Axis tab.  If one is different from the other
and the "OK" button is selected, this message will appear.
Solution:  After assigning the Pen tags, (same sign type) go  to the XY Axis tab and select the
appropriate range type corresponding to the assigned Pen tags (or  select the range type before
assigning any tags to the Pen).  Either way, the Pen tags and the Range type must be  the same
before the "OK" button is selected.

Error J10_4:  Total number of line graphs must be between 0 and 255.
Reason:  You will not be able to create more than 255 line graphs in a single screen.

Dynamic Bitmap/Static Bitmap
Error J11_1:  Selected file is not a BMP file.

Solution:  Select a valid Windows BMP file.

Error J11_2:    No Bitmap file was selected. Please select a BMP File.
Solution:  One of three actions can be taken:

1) Select "Copy from Clipboard" to copy the file name chosen from the Symbol Factory.
2) Select "Import Bitmap…" to choose a bitmap from a file somewhere in your computer or off

the network to enter in the "File Name" box.

Error J11_3:  Select either ON or OFF bitmap.
Reason:  Dynamic bitmaps require at least one bitmap to be selected.
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Error J11_4:  Compressed BMP size exceeds the maximum size usable BMP size
Reason:  PowerPanels use a Run Length Encoding (RLE) technique to compress Bitmaps for
display and saving purposes. The maximum allowable size of a compressed BMP is 64K.  If the
selected BMP results more than 64K during compression, this error occurs.  Even if the bitmap
size is less than the panel's resolution, you may get this error.
Solution: You need to select a different BMP.  If you would like to use the same bitmap, you
need to reduce the complexity of the bitmap.  Although, there is no straight forward way to  tell
that a bitmap would result in less than 64K during compression, the following tips might be
useful:

1) Try to have the same color across the bitmap.  If you mix lot of color patches, that may
increase the compressed bitmap size.

2) Try to reduce the font usage in the bitmap.

Error J11_5:  Selected BMP files combined must not exceed 64K size.  Please select a
different BMP file.

Reason:  There are two BMP files for dynamic bitmap.  Both BMP files would be compressed
using RLE technique and combined length of compressed BMPs together should not exceed 64K
in size.  If it exceeds, you would get this error.
Solution: Select BMPs which do not exceed the 64K size limit.

Error J11_6: Height and Width out of range.  BMP’s height must be less than  ( h ). BMP’s
width must be less than  ( w ).

Reason:  10" and 8" panels support bitmaps no larger than 640 x 480 pixels.  Similarly, 6" panels
support a maximum bitmap size of 320x240 pixels. This error indicates that a bitmap exceeds the
maximum size.
Solution: Select a bitmap that fits within the above ranges.

Error J11_7:  Compressed BMP size exceeds the maximum usable BMP size; unable to
save ON bitmap.
Error J11_8:  Compressed BMP size exceeds the maximum usable BMP size; unable to
save OFF bitmap.
Error J11_9:  Compressed BMP size exceeds the maximum usable BMP size; unable to
save Static Bitmap.

Reason:  PowerPanel s use a Run Length Encoding (RLE) technique to compress Bitmaps for
display and saving purposes. The maximum allowable size of a compressed BMP is 64K.  If the
selected BMP results more than 64K during compression, this error occurs.  Even if the bitmap
size is less than the panel's resolution, you may get this error.
Solution: You need to select a different BMP.  If you would like to use the same bitmap, you
need to reduce the complexity of the bitmap.  Although, there is no straight forward way to  tell
that a bitmap would result in less than 64K during compression, the following tips might be
useful:

1) Try to have the same color across the bitmap.  If you mix lot of color patches, that may
increase the compressed bitmap size.

2) Try to reduce the font usage in the bitmap.

Error J11_10:  Error in extracting Bitmap for ON button.
Solution: Delete the bitmap object and recreate the object again.  If you still receive this error
message, close and then reopen the application and try again.

Error J11_11:  Decompression was not successful.
Reason:  The Project file is corrupted.
Solution:  If you get this error, you will have to recreate this project.
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Error J11_12:  Select Palette failed in Paint DOB.
Reason: Resource not available in the system to draw the bitmap.
Solution: Close other applications and try to insert the bitmap.  If it still does not work, restart the
system.

Miscellaneous
Error J12_1:  This field cannot be empty.

Solution:  Your cursor will be located  in the data entry field that requires data entry.  Enter an
appropriate value.

Communication Errors (Cxx_x)

Port Related Errors
Error C01_1:  Unable to open communication port.

Solution:   Select another COM port.

Error C01_2:  Communications port not found.
Reason:  No valid communication port is found on the computer.
Solution:  At least one valid serial communication port should be available for communication
between the panel and PC.

Error C01_3:  Communications port is being used by some other application. Access
denied.

Solution: Close the other application and try to communicate from PowerPanel  or, if you have
an extra serial port, connect the cable to that port and select that extra port for communication
from PowerPanel .

Write to Panel Related Errors
Error C02_1:  Selected panel does not match connected panel.  Write to panel is aborted.

Reason:  When writing to the panel, if the panel type selected on the screen "Step 1:  Project
Information" does not match the panel that the computer and PLC are physically connected to, the
program loader will not upload project.
Solution:  Exit the OFF-LINE Editor to the "Step 1:  Project Information" screen, and select the
appropriate panel type for the connected  panel.

Error C02_2: Unable to update PLC driver.
Reason:  You will receive this error message if communication is not working between the
programming software and the panel, or if the panel is still trying to communicate with the old
driver and you are attempting to update the driver.
Solution:  Restart the panel and try communicating with the panel.  If you still face this problem,
clear memory from panel (using Panel > Clear Memory) and update the PLC driver and then, save
your project. Ensure that you have the project saved to disk before you do clear memory.

Error C02_3:  PLC Attributes could not be written to the Panel.
Error C02_4: Tags could not be written to the Panel.
Error C02_5:  Error in sending Project attributes to panel.
Error C02_6: Error in sending screens to panel.
Error C02_7: Error in sending alarm database to panel.
Error C02_8: Error in sending message database to panel.
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Solution:  Check the connections between the panel and computer.  Restart the panel and try
communicating again.

Error C02_9: Objects are overlapping; project cannot be written to the panel.
Reason:  Objects are overlapping in one or more screens; you will not be able to save / write to
the panel.
Solution:  If you get this error, you will see an object highlighted in the screen.   The highlighted
object is overlapping another object.  Please  move the object so that it does not overlap another
object ,and send the project again.

Error C02_10: Uploading could not be completed.
Solution:  Check the connections between the panel and computer.  Restart the panel or resave
the project and try communicating again.

Error C02_11:  Out of Memory Error.
Reason:  Flash card is smaller than user RAM size.
Solution:  Please contact your panel vendor.

ONLINE Programming Communication Errors
Error C03_1:  Unable to delete screen from panel.

Reason:   If Screen > Delete Screen (on main menu bar) is selected while there is a disruption in
the communication between the panel and computer, this error message is produced.
Solution:  Check the COM  line,  power to panel, and COM port used for correct setting and
function.

Error C03_2:  Memory diagnosing failed.
Solution:  Check connections and COM port settings. Ensure the proper function and power
distribution of panel (no system faults).  If all checks out OK and you are still receiving this error
message, there maybe a physical problem with the panel's memory.

Error C03_3:  Errors in Warm Boot.
Reason:  Panel is not warm booting.
Solution:  This could be due to panel not active/communication is not there between PC to panel.
Please check the connection between panel to PC.  If the problem persists, restart the panel.

Error C03_4:  Unable to program User Flash.
Error C03_5:  Errors in Reading Flash card.

Reason:  If the flash card is not set properly / communication is not happening between the
panel and editor, you would get this error.
Solution: Check whether the flash card is fit properly in the slot / restart the panel / check the
cable for communication.

Error C03_6:  Unable to read PLC Attributes from Panel.
Error C03_7: Unable to delete screen <screen number> from the panel.
Error C03_8:  Unable to get Information from Panel.  Please check the connection
between panel and computer.
Error C03_9:  Unable to read System Attributes from panel.
Error C03_10:  Unable to read tags from the panel.

Solution:  Check the connection between panel and computer.  Restart the panel and try
communicating again.
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Error C03_11:  Testing RAM - failed
Solution: If you have a RAM Card installed in the panel, remove this RAM card and redo the test.
If the test passes, replace the RAM card with a new RAM card.  It the test fails, there is a
problem with the panel.  Please contact technical support.

Error C03_12: Testing Flash - failed
Solution:  Replace the Flash card.

Miscellaneous Errors (Mxx_x)

Error M01_1:  Error in memory allocation.
Reason:  You will get this error if PowerPanel  Editor is not able to allocate certain amount of
memory for doing some operations.
Solution:  close other applications and try.  If you still get this error, save the project and close
the application. Restart your computer and try again.

Error M02_2:  Unable to open the Project file (*.ezt).
Error M02_3:  Unable to open message database file (*.msd).
Error M02_4:  Unable to open alarm database  file (*.alr).
Error M02_5:  Unable to open PLC attributes file (*.atr).
Error M02_6:  Unable to open annotations file (*.ano).
Error M02_7:  Unable to open project options file (*.opt).

Solution:  You have renamed your project accidentally while project was open in PowerPanel .
Close this project and open it again.

Error M03_1:  Unable to create project file (*.ezt).
Error M03_2:  Unable to create PLC attributes file (*.atr).
Error M03_3:  Unable to create message database file (*.msd).
Error M03_4: Unable to create alarm database file (*.alr).
Error M03_5: Unable to create annotation file (*.ano).
Error M03_6:  Unable to create project options file (*.opt).
Error M03_7:  Unable to save PLC Attributes file (*.atr).
Error M04_1:  Unable to create temporary project file (*.ezt).
Error M04_2: Unable to create temporary annotations file (*.ano).
Error M04_3: Unable to create temporary PLC attributes file (*.atr).

Reason:  You might receive these error messages if you are running two instances of the
PowerPanel  Programming Software, opened a project in one and then gave the same project
name in another to be downloaded from panel.
Solution:  Give a valid project file name that is not open in any application.  If you still face the
problem, close all your applications and run only one instance of PowerPanel  and try again.

Error M05_1: Unable to unload.
Error M05_2: Unable to load.

Reason:  There is a .dll file in the directory that doesn’t belong. The program loader will report this
error.
Solution:  Remove the specified file, and reinstall the software.

Error M06_1:  Not a PowerPanel .
Solution:  Connect a PowerPanel  to the computer and try to communicate with the panel.
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Error M06_2:  File corrupted; number of bytes in the screen is zero.
Error M06_3:  Unable to rename the selected screen.
Error M06_4:  Problems in project checksum
Error M06_5:  Invalid screen checksum

Solution:  You need to recreate the project.  If  this problem persists, please report it to
technical support.

Error M06_6:  There are no PLC dlls available in this execution directory.
Reason:  If you have moved all the PLC dlls from the directory where PowerPanel .exe resides,
you will receive this error message.
Solution:  Reinstall the software

Error M06_7:  PLC Dll file being used by this project is not found.
Reason:  A PLC .dll file has been moved or deleted from the program directory.
Solution:  Reinstall the software.

Error M06_8:  Received checksum is not equal to calculated checksum.
Solution:  Reinstall software and try again.

Error M06_9:  No PLC has been selected.
Solution: Reinstall software and try again.

Error M07_1:  Invalid Screen Name.
Error M07_2:  Invalid screen ID , screen ID range is 1..999.

Reason:  Valid screen name's length is 1 to 40 characters.
Solution:  You have to specify a valid screen name. Do not include any special characters (\, /
,.,*,?,<,>,|,etc.) while naming your files.  First character should be alphanumeric.

Error M08_1:  Downloaded project is a protected project.  This cannot be edited/viewed in
the editor.”

Reason: Project is write protected.
Solution:  You will not be able to open this project for viewing / editing purpose.  Contact the
people from whom you got this project.

Error M09_1:  System out of memory to run Symbol Factory.”
Solution:  Restart your system

Error M09_2:  Invalid Symbol Factory.exe file.”
Solution:  Reinstall the software

Error M09_3:  Unable to find Symbol Factory application.”
Solution:  If you have moved symbols directory to some other place, please copy it back.
Otherwise, reinstall the software.
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Bitmap Errors (BMP_xx)

Error BMP_1:  Unable to display dynamic bitmap object
Error BMP_5:  Unable to display static bitmap object

Reason:  You will receive this message if there is a problem in displaying the bitmap data.
Solution:  Delete and then reinsert the bitmap object.

Error BMP_2:  Unable to read *.wmf file
Error BMP_3:  Unable to read *.emf file
Error BMP_4:  Unable to read meta file data from clipboard

Reason:  Unable to convert the .wmf/.emf file selected to .bmp.
Solution:  Check whether you are able to insert this bitmap in another application (e.g., Word).
If yes, restart the system and try again.

Error BMP_6:  Unable to calculate enhanced meta file dimension, \ntaking default 80Wx80H
Error BMP_7:  Unable to calculate meta file dimension, taking default 80Wx80H

Reason:  Editor is unable to calculate enclosing rectangle of the selected .wmf/.emf.

Error BMP_8:  Total compressed buffer size of on and off bitmaps must not \n exceed
64K; please reduce the size of object
Error BMP_9:  Compressed buffer size of bitmap must not \nexceed 64K; please reduce
the size of object

Solution:  Insert a different bitmap / try to reduce the complexity of this bitmap.

Error BMP_10:  Unable to calculate static bitmap size
Error BMP_12:  Unable to calculate dynamic bitmap size

Reason:  Editor is unable to calculate the bitmap size.
Solution:  Delete the object and try to reinsert the object.

Error BMP_11: Unable to read the project file
Solution:  You might get this message when attempting to download a project, or edit a project
online, that contains bitmaps.  If this happens, restart the system and try again.
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In this Appendix....

— Character List
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PPPPPooooowerPwerPwerPwerPwerPanel ASCII Characteranel ASCII Characteranel ASCII Characteranel ASCII Characteranel ASCII Charactersssss

Name Octal Dec Hex Description

SP 040 32 20 Space
! 041 33 21 Exclamation point
“ 042 34 22 Double quote
# 043 35 23 Pound sign
$ 044 36 24 Dollar sign
% 045 37 25 Percent sign
& 046 38 26 Ampersand
‘ 047 39 27 Apostrophe (single quote)
( 050 40 28 Left parenthesis
) 051 41 29 Right parenthesis
* 052 42 2A Asterisk
+ 053 43 2B Plus
, 054 44 2C Comma
- 055 45 2D Hyphen (minus)
. 056 46 2E Period (decimal point)/dot
/ 057 47 2F Slant (slash)
0 060 48 30 Zero
1 061 49 31 One
2 062 50 32 Two
3 063 51 33 Three
4 064 52 34 Four
5 065 53 35 Five
6 066 54 36 Six
7 067 55 37 Seven
8 070 56 38 Eight
9 071 57 39 Nine
: 072 58 3A Colon
; 073 59 3B Semicolon
< 074 60 3C Less than / Left angle bracket
= 075 61 3D Equals sign
> 076 62 3E Greater than / Right angle bracket
? 077 63 3F Question mark
@ 0100 64 40 “At” sign
A 0101 65 41 Uppercase A
B 0102 66 42 Uppercase B
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C 0103 67 43 Uppercase C
D 0104 68 44 Uppercase D
E 0105 69 45 Uppercase E
F 0106 70 46 Uppercase F
G 0107 71 47 Uppercase G
H 0110 72 48 Uppercase H
I 0111 73 49 Uppercase I
J 0112 74 4A Uppercase J
K 0113 75 4B Uppercase K
L 0114 76 4C Uppercase L
M 0115 77 4D Uppercase M
N 0116 78 4E Uppercase N
O 0117 79 4F Uppercase O
P 0120 80 50 Uppercase P
Q 0121 81 51 Uppercase Q
R 0122 82 52 Uppercase R
S 0123 83 53 Uppercase S
T 0124 84 54 Uppercase T
U 0125 85 55 Uppercase U
V 0126 86 56 Uppercase V
W 0127 87 57 Uppercase W
X 0130 88 58 Uppercase X
Y 0131 89 59 Uppercase Y
Z 0132 90 5A Uppercase Z
[ 0133 91 5B Left square bracket
\ 0134 92 5C Back slash
] 0135 93 5D Right square bracket
^ 0136 94 5E Caret
_ 0137 95 5F Underscore
‘ 0140 96 60 Back quote
a 0141 97 61 Lowercase a
b 0142 98 62 Lowercase b
c 0143 99 63 Lowercase c
d 0144 100 64 Lowercase d
e 0145 101 65 Lowercase e
f 0146 102 66 Lowercase f
g 0147 103 67 Lowercase g
h 0150 104 68 Lowercase h
i 0151 105 69 Lowercase i

Name Octal Dec Hex Description
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j 0152 106 6A Lowercase j
k 0153 107 6B Lowercase k
l 0154 108 6C Lowercase l
m 0155 109 6D Lowercase m
n 0156 110 6E Lowercase n
o 0157 111 6F Lowercase o
p 0160 112 70 Lowercase p
q 0161 113 71 Lowercase q
r 0162 114 72 Lowercase r
s 0163 115 73 Lowercase s
t 0164 116 74 Lowercase t
u 0165 117 75 Lowercase u
v 0166 118 76 Lowercase v
w 0167 119 77 Lowercase w
x 0170 120 78 Lowercase x
y 0171 121 79 Lowercase y
z 0172 122 7A Lowercase z
{ 0173 123 7B Left curly brace
| 0174 124 7C Vertical bar
} 0175 125 7D Right curly brace
~ 0176 126 7E Tilde

Name Octal Dec Hex Description
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IndexIndexIndexIndexIndex

SymbolsSymbolsSymbolsSymbolsSymbols

.EMF  127

.prp  13

.WMF  127
10" Color  3
16-bit  38
16-bit register  74
24 Volt Power Supply  3
32-bit  38
6" Color  3
6" Monochrome  3
8" Color  3

AAAAA

About PowerPanel  158
accumulator data  56
Activate  75
Activate Screen Saver  101

Label  101
Text  102

ACTUAL VALUE.  A-14
Actuator Types  41
Add New Alarm Dialog Box  140
Add New Message button  144
Add New Message Dialog Box  143
Add New Tag Details  41
Add/Edit Button

Tag Database  135
Address String  16, 41, 75

connecting panel to multiple PLCs  41, 135
empty field  A-8

Adjust Contrast  103
Digit Format  103
Label  103

Alarm
Bit  90
Database  140
Display Time (sec.)  146
History  152

Alarm Count button  A-12
Alarm Database  A-7, A-8
Alarm History  A-11

button  A-11, A-12
Details  A-14
screen  A-12

Alarm History Object  98

Details  98
Display Screen  98
Label  98
Text  99

Alarm List Size  146
Alarms Tab  81
algorithm  90
Align  119
alphanumeric  77

entry  6
keypad  76

Analog Clock  6, 78
analog gauge  80
application  26
Apply Changes Alarm #  141
Apply Changes Message #  144
Arc  127
ARROW keys  89
ASCII  135
ASCII Characters  75, 77, B-2
ASCII String  38
Auto Mode  90

BBBBB

backup  6
Bar Graph  83

Color  84
Bar Graph Object  83

Digital Display Tab  84
Format  84

numbers  84
Fractional Digits  84
Label  83
Tag Name  83

battery  151
BCD  38
Beeper On/Off  152
Bipolar  84
bit  38, 64, 74
Bitmap  6, 93, 127
bits  38
Boot Software  131
Browse  27, 29
Button Object  40

Actuator Types  41
Button Style  40
Label  40
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On/Off Text  41
Place Button  42
Tag Name  41

Button object  18
button states  40
buzzer  147
Bytes  35

CCCCC

cable  A-5
calendar  6
carriage return  138
Cascade  157
CAUTION

removing RAM or Flash card  154
Upgrade Firmware  155

CD ROM Drive  3
Change Screen Object  96

Go To Screen  96
Label  96
Style  96

changes  30
character string  135
Characters  B-2
Circle  126
Clear Alarm Count  152
Clear Alarm History  152
Clear Program  131
Clock  149
clock  6, 131
Clock Object  78

Analog Clock  78
Color  78
Label  78

Digital Clock  79
Date  79
Label  79
Options  79

Close Project  116
codes  43
color band  81
color palette  6, 40
COM port  156
Comma delimited  138, 142, 145
Comma delimited...  145
Comma-separated values  138, 142, 145
Communication Errors (Cxx_x)  A-25
Communications

cable  A-5
from Panel to Computer  A-5

communications between the PLC and panel  A-7

communications ports  6
configuring your first screen  28
Connecting Panel to Multiple PLCs, addressing

16, 41, 135
context sensitive onscreen help  4
Contrast  103
control logic  38
control output value  90
control sequence  38
controlled variable in the process  90
Copy  119
Copy from Clipboard  128
CSV file  138, 142, 145
Current Editing Language  120
Current Language Number  151
Current Screen  151
customize  160
Cut  119

DDDDD

data table  38
data tag  80
data type  80
data value range  80
Data values  38
databases  30
Decrease Clock by 1 hour  152
Default Language  147, 153
Default Tag Data Type  120
Delete  120
Delete Screen  122
Demo Button  18, 22
Demo Indicator Light  19, 22
Demo Numeric Display  17, 22
Demo Numeric Entry  16, 22
Demo Program  14
Demo Project  23
Demo Project 1  13, 21
Description (Screen)  124
description of process or condition  70
design  26
design changes  26
design screens  108
Design Your Screens  33
Details  44
DETAILS button  A-13
detect a PLC error  A-7
Diagnostics  133
Digital Clock  78
Digital Display  82, 84

Justification  84
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Digits  58, 67, 82, 84
Discrete  38
Display  131
Display Blank  A-6
Display Grid  123
Display Saver  101, 147
Display Screen  130
display tag character values  74
Divisions  84
Draw Horizontal/Vertical  126
Draw Menu  126
Draw Tool Bar  112
Driver Memory  131
Dynamic Bitmap  93
Dynamic Bitmap Object  93

Copy from Clipboard  95
Label  93
On Bitmap and Off Bitmap  94
Symbol Factory  95
Tag Name  94

Dynamic Text  74
Label  74
String Tag Name  75
Text Characteristics  75
Trigger Tag Name  75

EEEEE

Edit  120
Edit Alarm Details Dialog Box  141
edit an existing tag  136
Edit Menu  119
Edit Message Details Dialog Box  144
Edit Passwords  42
Edit Program OFF-LINE (Write to Panel Later)  27
Edit Program ON-LINE  30
Edit Tag Details  41
edit-compile-download  26
editing  28
Enable Beeper  147
ENTER PROJECT INFORMATION  31
ERROR CODE VALUE  A-7, A-9, A-12
Error Code Value  151, A-7
Error Codes  A-16
Error Messages  A-15

PowerPanel  A-15
PowerPanel Programming Software  A-16

Excel  138, 142, 145
Excel file  138, 142, 145
Exec  155
Exec Flash  131
Exec Software  131

EXISTING PROGRAM  35
Exit  118
Export Alarms  142
Export Messages  145
Export Scale Factor  129
Export Tags  138
external tags  38

FFFFF

F1 function key  4
FA-24PS  3
Faceplate  90
FAQs  A-2
features  6
Field expandable user RAM  6
File Menu  116
File Revision  156
Firmware  131, 155, 156

Revision  30, 31, 35
upgrade  6

Firmware Revision number  22
Flash  6, 132
Flash Memory  131
Flash to RAM  132
Floating Point  38
Fly-Over HELP  4
Fractional Digits  58, 67, 82, 85
frame  39
Free Memory  22, 131
Frequently Asked Questions  A-2

GGGGG

Go To Screen  96
Good Communication Toggle  151
graphic file

size  127
graphical data  5
Graphical trending  34
Grid Size  123
GROUP  43

HHHHH

handle  42
Hardware  131
HELP  4
Help

button  4
Menu  158
Topics  158
windows  4
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Highlight Internal Tags
Tag Database  134

Highlight Unused Tags
Tag Database  134

horizontal axis (X)  88
Horizontal Center  119

IIIII

I/O modules  38
IBM  3
IBM or compatible PC  3
icon  10
Import Bitmap  94
Import bitmaps  6
Increase Clock by 1 hour  152
Increment/Decrement Hour  100

Choose the function  100
Label  100
Text  100

Indicator Button Object  45
Actuator Types  46
Label  45
On/Off Text  46
Style  45
Tag Name  45

Indicator Light  64
Indicator Light Object  64

Label  64
On/Off Text  65
Style  64
Tag Name  64

Indicator Light object  19
industrial automation  160
Information (Panel)  130
inputs  38
Installation  9
installation screen  10
Installing the Software  9
internal Real-Time clock  100
internal tags  38
Introduction  3, 5

JJJJJ

no entries

KKKKK

Keypad  77
Data Type  57
Fractional Digits  58

Justification  58
keypad  6, 22, 56, 62

LLLLL

Label  40
ladder logic  38, 90
Language  104, 153
Languages  6, 41, 147
leading zeroes  43
LED  A-5
legend  87
Line  126
Line Graph  86
Line Graph Object  86

Axis/Tick Color  86
Background Color  86
Display Legend  87
formatting  88
Label  86
Language  87
Pen Tab

Legend  87
Tag Name  87

Pen tab  87
Sample per Chart  87
Sample Rate  86
Total # of Samples  87
XY Axis tab  88

lines
horizontal and vertical restraint  126

log the PLC error code  A-7
Lookup Text Object  72, 73, 143

Label  72
Message Database  72

MMMMM

magnifications
screen  125

Main Menu Bar  109
Main Programming Screen  108
Major Divisions  81, 84
Manual Mode  90
map file  32
mapped  38
mapping  38
mechanical switches  50
Memory  35
Memory (bytes)  131
Memory Card  A-6
Menu commands  116
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Message Database  72, 73, 143
messages  72
Meter  80
Meter Object  80

Alarms Tab  81
Digital Display Tab  82
Format  81

numbers  82
Fractional Digits  82
Justification  82
Label  80
Style  80
Tag Name  80

Meters  6
Microsoft Excel  139
Midpoint value  84
Miscellaneous Errors (Mxx_x)  A-27
mode  27, 31
Mode Bit  90
models  5
Momentary Off  40, 41, 46, 51
Momentary On  40, 41, 46, 51
monitor a bit  75
monitor and display a tag  83
monitor specific Tags  86
monochrome  6
mouse  3
mouse cursor  4
Multi-Language Support Feature  153

NNNNN

Navigation Tool Bar  33
ndicator light  45
needle  80
New Screen  121
Nonvolatile flash card  6
Notepad  138
Number of Steps  52
numeric  6
Numeric Display  17, 66
Numeric Display Object  66

Data Type  67
Digits  67
Display Values  68
Format  67
Fractional Digits  67
Justification  67
Label  66
PLC Values  68
Scaling Tab  68
Tag Name  66

Numeric Entry  16, 56
Numeric Entry Object  56

Display Value  59
Enter Range and Test Display  57
Label  56
PLC Values  59
Scaling Tab  59
Select the Format of the Keypad  57
Tag Name  56

OOOOO

Object Description  44
Object Errors (Jxx_x)  A-21
object icon  39
Object Name  44
Object Tool Bar  110
OBJECT TOOLBAR  39
Objects  39
Objects Menu  38
OFF-LINE  26
OK/Cancel/Help Buttons  41
ON-LINE  26
On/Off Text  41, 48
Onscreen HELP  4
onscreen prompts  9
Open Project  116
Open Screen  121
Option Board  131

Hardware Revision  131
Software Revision  131
Type  131

Output Variable  90
outputs  38

PPPPP

palette  6
Panel Error Messages  A-15
Panel Information  22
Panel Menu  130
Panel Name  131
Panel Revision  156
panel tags  38
Panel Time and Date  132
Panel to PLC  150
Panel to PLC Link  22, 35
Panel Tool Bar  112
Panel Type  14, 28, 30
GROUP  43
PASSWORD  43
Password  42
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Password PLC  43
Password Protect Object  42
Password Protection  6
Password/Tag  43
Passwords  42, 148
Paste  119
PC  3
PC Com Port (Connects to Panel)  28
PC Port  35
PC requirements  3
Pen  87
PID Faceplate Object  90

Alarm Bit  91
Label  90
Legend tab  92
Mode Bit  91
Output  91

Bar color  91
Bar ranges  91
Tag Name  91

Process Variable/Setpoint
Tag Name  91

PID Faceplates  6
PID loop tune face plates  34
Place Button  42
PLC  5, 38

addresses  6, 43
Attributes  32
Cable Part Numbers  8
data type  67
Driver  131
Driver Code Revision  131
Driver memory  131
Error  151
HELP  4
location  56
Manufacturer  131
memory locations  6
Model  131
register  56, 62, 75
registers  74
Type  30
Type and Protocol  28, 32

PLC Attributes  15
PLC Com Port settings  14
PLC Communication TIMEOUT  A-12
PLC Conversion Errors (Pxx_x)  A-17
PLC ERROR  A-10
PLC Error  A-8
PLC Error (Discrete)  A-8
PLC error code value  A-7
PLC ERROR CODE VALUEs  A-14

PLC Error Messages
log and display  A-7

PLC to Panel  152
PLC Type and Protocol  15
PLC-based control  38
PLCs Supported  7
plots  86
Point 1  59, 68
Point 2  59, 68
Popup Keypad  34, 58, 151
popup keypad  22
popup thumbwheel  62
Power Supply  A-5
Power-Up Screen  146
PowerPanel  5

Error Messages  A-15
Hardware User Manual  3
models  5
Programming Software  9

PowerPanel Error Messages  A-15
PowerPanel Programming Software  3
predefined programming objects  39
preprogrammed messages  72
Present Value  91
preset values  60
Print  118
Print Alarm Database  118
Print Message Database  118
Print Screens  118
Print Setup  118
Print Tag Database  118
Printer  6

Project Attributes  147
Process Variable (PV)  90
Process Variable/Set Point  91
programmable graphic operator interface  3
programmable graphics interface  5
Programming Cable Part Number  9
Programming Screen  114
Progress Bar  118
Project Attributes  146

Alarm Display Time (sec.)  146
Alarm List Size  146
Clock  149

Clock Source  150
Date Tags  149
Time Tags  150

Default Language  147
Display Saver  147
Enable Beeper  147
General  146
Language  153
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Panel to PLC  150
Current Language Number  151
Current Screen  151
Good Communication Toggle  151
Low Battery  151
PLC Error  151
PLC Error Code Value  151
Popup Keypad  151
Screen Buffer Overflow  151

Passwords  148
GROUP  148
PASSWORD  149
TAG  149

PLC to Panel  152
Beeper On/Off  152
Clear Alarm Count  152
Clear Alarm History  152
Decrease Clock by 1 hour  152
Increase Clock by 1 hour  152
Select Current Language  153
Switch to Screen Number  152
Trigger Screen Saver  153

Power-Up Screen  146
Printer  147

Baud Rate  147
Control RTS  148
Data Bits  147
Parity  147
Require CTS  148
Select RS485  148
Stop Bits  147

project attributes  30
Project Description  154
Project Information  27, 35, 117
Project Information Dialog box Errors (Ixx_x)  A-20
Project Location  31
Project Name  27, 29
Project Screens Explorer View window  159
Project Setup  26
Proportional Integral Derivative (PID)  90
Protect  42
Protection  42, 149
Protection Tab  42
Protocol  28

QQQQQ

quotation marks  138

RRRRR

Radio Button Object

Label  47
On/Off Text  48
Style  47
Tag Name  47

Radio Buttons  47
RAM  6, 35
RAM Memory  131
RAM to Flash  132
Range  57, 81
Range Check  59
Read Program from Panel and Edit OFF-LINE  28
read/write  38
Readings  88
Reboot  131
Recipe  60
Recipe Object  60, 61

Display Format  61
Label  60
Recipe Tab  61
Register Values  61
Text  60

Rectangle  126
redo  6, 119
Reference  116
Rename Screen  122
Requirements  3
resize a symbol  129
RESIZING AN OBJECT  17
REVIEW  31
Revisions  131
Right click  34
Right click menu

objects  159
programming screen  159
Project Screens Explorer View  159

Right Click Menus  159
RS-232C or RS-422A/485A PLC Interface Cable  3
RS-232C Programming Cable  3
RS-485  148

SSSSS

Sample Rate  86
Timed  86
Triggered  87

State  87
Tag Name  87

Save Project  30, 116
Save Project As Protected  117
Save Screen  30, 116
Saving Errors (Sxx_x)  A-21
Scaling  59, 68
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Screen Background Color  124
Screen Buffer Overflow  151
screen contrast  103
screen description  69
screen design features  34
Screen List  34
Screen Menu  121
Screen number  30
Screen Saver  101
screens  6, 157
Search  158
security  149
SELECT ACTION  27
Select All  119
Select Current Language  153
Select Language Object  104

Label  104
select the language  105
Text  105

Select PLC  154
Selector Switch  6, 50
separated by commas  138
serial port  3
Serial Printer support  6
Set Limit  82
Set Off  40, 41, 46, 51
Set On  40, 41, 46, 51
Set Panel Time  132
Set Point  91
Set Point (SP)  90
set points  57
Setup Menu  134
Setup.exe  9
Show 320x240 Rectangle  125
Show Ticks  81, 84
Show Touch Cells  125
Signed  38
Signed/Unsigned  38
Simulate Press  42
size a Bitmap

Static Bitmap  127
Sizing a Bitmap in Symbol Factory  129
sizing bitmaps

Static Bitmap  129
Slide Switch  6, 50
Snap to Grid  123
Software  3
Software Error Messages  A-16
Sort by Address

Tag Database  137
Sort by Data Type

Tag Database  137
Sort by Tag Name

Tag Database  137
sort the Tag Database  136
Start Editing Screen  27, 30
state  38
Static Bitmap  127, 129
Static Text Object  69

General tab  69
Language  69

Station Number  41
Status Bar  112
Step 1  13
Step 1 Project Information  13, 27
Step 2 Design Your Screens  33
Step 2 Design Your Screens.  15
Step 3 Write Your Program to Panel  21, 35
Step Switch  52
Step Switch Object  52

Label  52
Number of Steps  52
Simulate Press  53
Step #1 Tab  52
Style  52

Stretch to Fit  94
String Tag  75
Sub Divisions  81, 84
Switch Object  50

Actuator Types  51
Background Color  51
Label  50
On/Off Text  51
Style  50
Tag Name  50

Switch to Screen Number  152
Symbol Factory  95, 129, 160
Symbol Factory®  128, 160
Symbol Options  129
system clock  152
System Memory  131
System Objects  100

TTTTT

Tag  6, 38, 43
Tag #  135
Tag Cross Reference  137
Tag Data Type

set default  120
Tag Database  41, 134, 137

Data Type  135
Number of Characters  135
PLC Address  135
Sort list  136
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Tag Name  135
Tag Name  6, 41
Tag Related Errors (Txx_x)  A-18
Tags

Internal, tag database  134
tags

internal tag database  134
Technical Support  4
test  A-12
Test Flash  133
Test RAM  133
testing  131
Text  105
Text Entry  76
Text Entry Object

Label  76
String Characteristics  77
String Tag Name  76

Text Object  69
text strings  70
theoretical perfect value  90
Think-n-Do Map File,  32
Throw Switch  50
Thumbwheel  62
Thumbwheel Object  62

Format  63
Label  62
Number of Wheels  63
Tag Name  62

Thumbwheel Switch  6
Tile  157
Time and Date  79
Time/Date  132
Title Bar  108
To Excel...  138, 142, 145
Toggle  40, 41, 46, 51
toggle

between horizontal/vertical lines  126
Toggle Switch  6, 50
Toolbar  120
top slot  A-6
Touch cells  125, 131
touch objects  42
transfer  30
Transfer to Panel...  117
transparent object  69
Tri-State Switch  54
Tri-State Switch Object  54

Label  54
Style  54
Tag Names  54
Text  55

Trigger Screen Saver  153
Trigger Tag  75
Triggered Text Object  70

Format  71
Label  70
Language  70
Tag Name  70
Text - On and Off  70

Troubleshooting  A-5
Tutorial  11
Tutorial — Configure PLC  12
Tutorial — Create a Project  13

UUUUU

unauthorized users  42
Undo  6, 119
Unsigned  38
Update PLC Driver  132
Upgrade Firmware  155, 156
Use PC Port  118
user groups  6
User Memory  131
User Memory Flash  131
User Program  131
user program backup  6
user-defined  38
user-defined frame types  39

VVVVV

Value  88
Value Range Errors (Vxx_x)  A-16
Vector-based graphics  34
vertical axis (Y)  88
Vertical Center  119
VGA display  3
view

custom screen magnifications  125
View/Edit Attributes  154
View/Edit PLC Com Setup  28, 32
Visibility  44
Visibility Tag  44
Visibility/Details  44
Visibility/Details Tab  44
Visual Alarm Settings  81

WWWWW

Watchdog  151
What you need to get started  3
Windows 95/98/NT4.0/2000  3
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Windows Enhanced Metafile (.EMF)  127
Windows Menu  157
Windows Metafile (.WMF)  127
Windows-based architecture  26
wiring diagrams  4
word  38
Write Program to Panel  21, 35
WRITE to a Tag  40

XXXXX

X-Axis  88
XY Axis

Label  88
Major Divisions  88
Minor Divisions  88
Show Tick Numbers  88
Show Ticks  88
Show Vertical Grid  88
X-Axis Grid  88
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Y-Axis  88
Range  89

ZZZZZ

Zoom  125
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